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Global Release Notes
The release notes are specific to Ansys, Inc. Release 2026 R1 and arranged by application or product,
with the exception of:

• Advisories (p. xvii)

• Compatibility with Previous Releases (p. xix)

• Installation (p. xix)

• Licensing (p. xx)

• Documentation (p. xxii)

• Verification Manuals (p. xxii)

• Online Video Access (p. xxvii)

• Ansys Customer Site (p. xxvii)

In some cases, installation- and licensing-specific information is detailed within the documentation for
a given application or product.

Release notes in printable format (PDF) for this release can be downloaded using the button in the
ribbon at the top of the online help page.

Archived Release Notes

Archived release notes for releases prior to 2026 R1 can be found in the online version of 2025 R2 release
notes . Or via ansys.com> Customers> Customer Center> General Support> Download Center> Down-
loads> Product Documentation> Select Release> PDF packages> release.

1. Advisories

• Release 2026 R1 will be the final version of the Distributed Compute Gateway (DCG) application.
Support for DCG will end in 2027.

The functionality of DCG has been transitioned to Ansys HPC Platform Services — the next-generation
solution for HPC workflow management from Ansys. With support for both on-premises and cloud
computing environments, HPC Platform Services helps you manage the execution of simulations
while making use of your full range of computing assets.

For more information, see the Ansys HPC Platform Services page on the Ansys Help site or contact
Ansys Support.

• Ansys Viewer 2025 R1 was the final version of Ansys Viewer released by Ansys.

As of the Ansys 2025 R2 release, Ansys Viewer is no longer included in the Ansys Installation program,
and support for Ansys Viewer is no longer available.
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If you have been using Ansys Viewer for graphics visualization, Ansys encourages you to transition
to alternative tools or workflows. If you have any questions or need assistance, contact Ansys Support.

Note that this advisory is not referring to the Ansys Help viewer, which provides access to Ansys help
documentation for customers without internet access.

• Release 2025 R1 was the final version of the Ansys Additive desktop application, which includes the
Additive Print and Additive Science modules. No further updates or bug fixes are provided.

As of Ansys release 2025 R2, the Ansys Additive application was removed from the Ansys Installation
program, and support for it ended.

If you use the Ansys Additive application, we encourage you to transition to these alternative tools:

– The Mechanical application, for Additive Print functionality. Several types of geometry-based
AM simulations are available, including laser powder bed fusion (LPBF), directed energy depos-
ition (DED), sintering, and distortion compensation.

– PyAdditive, for Additive Science functionality. PyAdditive allows you to experiment with process
parameters for determining the best combination to use in laser powder bed fusion processes
of metal parts. See PyAdditive in the Additive Manufacturing Release Notes.

• Ansys Distributed Compute Services (DCS) 2024 R1 was the final version of DCS released by Ansys.
Support for DCS is no longer available.

The functionality of DCS has been transitioned to Ansys HPC Platform Services — the next-generation
solution for HPC workflow management from Ansys.

You should now be using HPC Platform Services instead of DCS. For more information, see the Ansys
HPC Platform Services page on the Ansys Help site or contact Ansys Support.

• Ansys release 2022 R2 (July 2022) was the last release to support native macOS for the Ansys EnSight
product.

• The Microsoft Defender Antivirus program in Windows Security, on Windows 10 and 11, will scan all
executables associated with the Fluent and Mechanical products and can cause some performance
issues. A workaround consists in adding an exception in Windows Defender for the impacted Ansys
executables. Note that such procedure shall be operated by authorized IT personnel with full knowledge
and understanding of risks.

• In addition to the incompatibilities noted within the release notes, known non-operational behavior,
errors and/or limitations at the time of release are documented in the Ansys Known Issues and Lim-
itations. See the Ansys customer site (p. xxvii) or online Help for information about the Ansys service
packs and any additional items not included in the Known Issues and Limitations document. First-
time users of the customer site must register to create a password.

• For a list of issues and limitations in previous releases that have been resolved in Release 2026 R1,
refer to the Resolved Issues and Limitations document on the Ansys Help site.

• Ansys Help (https://ansyshelp.ansys.com/) is not supported on the Internet Explorer browser.

• DesignXplorer is deprecated, Ansys recommends using optiSLang containers. The DesignXplorer license
(dsdxm license feature) enables comparable functionality for Correlation Analysis, Design of Experi-
ments, Response Surface Modeling, and Optimization.
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2. Compatibility with Previous Releases

Backwards Compatibility: Ansys 2026 R1 was tested to read and resume databases from the following
previous versions: 2024 R1, 2024 R2, 2025 R1, and 2025 R2. Note that some products are able to read
and resume databases from releases prior to 2023 R1. See the specific product sections below for more
information. For those products that cannot directly read an earlier database in 2026 R1 first resume it
in a supported version and then resume that database in 2026 R1.

Upward/Forward Compatibility: No previous release has the ability to read and resume a database
from a more recent release.

3. Installation

The following features are new or changed at Release 2026 R1. Review these items carefully.

• For this release, the Ansys installation program has added the following products:

– 3D Design

→ Headless Geometry Service (PyAnsysGeometry)

– AI Tools

→ Actionable Language Interface (ALI)

→ Embedding Model BGE-M3

– Connect

→ Behavior Execution Engine

→ System Architecture Modeler (SAM)

→ optiSLang Core Headless

→ optiSLang Core UI

– Electronics

→ Motor-CAD

→ PerceiveEM

– Embedded Software

→ Scade One

→ SCADE Rapid Prototyper

– Fluids

→ RBF Morph Fluids
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– Structures

→ RBF Morph Structures

• Need for PAC file, and its URL, are automatically detected from operating system settings.

4. Licensing

The following enhancements were made to Ansys, Inc. Licensing for Release 2026 R1:

Desktop:

• The Ansys License Manager has been updated to FlexNet Publisher client version 11.19.9.0.

• The Ansys License Manager has been updated to OpenSSL version: 3.5.4.

• The Ansys License Manager has been updated to Java version: 21.0.8.9.

• The Ansys License Manager has been updated to Tomcat version: 10.1.48.

• The Ansys License Manager has been updated to Curlt version: 8.16.0.

• Added support for IPv6 to Elastic Licensing.

• General security and performance improvements.

• The ANSYSLI_ prefix has been changed toANSYS_LICENSING_.

• UI Changes:

– The left-hand menu has been restructured.

– A single location to opt in or out of Ansys Product Improvement Program (APIP) for all applic-
ations.

– A Windows-specific proxy option removed on Linux.

Web:

• Web Licensing performance improvements:

– Faster license checkouts

– Expanded health checks and failover mechanisms

– Resiliency against third-party Cloud infrastructure and service issues

• Web Licensing Assignment improvements

– Automatic Assignment updates when entitlements expire

• Shared Web Denial reporting improvements
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– Transactions table now shows best Product match if customer does not have a product with the
requested feature(s)

– Related transactions are now grouped for easier interpretation

– Denials are now available in charts

• Added access to the following Products, Missions and Bundles:

– Missions AI+

– SNOPT optimizer for spacecraft trajectory design

– STK

→ Engine Deployment

→ Enterprise

→ Premium Air

→ Premium Space

→ Pro

→ RF Channel Modeler Enterprise

→ RF Channel Modeler Radar

→ Scheduler

→ Shield Plus

– Digital Missions Bundle

– Structures Explorer

– GRANTA Advanced Materials

– GRANTA MI

– GRANTA MI Editor

– GRANTA MI Viewer

– GRANTA Selector

Licensing Portal and ID Portal:

• Enhancements to the Licensing Portal include:

– Page header “breadcrumbs” now clearly indicate which page is active

– Convenient buttons to download table data, clear all filters, and reset the view
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• New option to remove existing Members before importing from a file (Available for both Users and
Groups)

5. Documentation

Ansys Help cannot be launched from Firefox on Linux in a DCV environment for the products CFX, En-
Sight, and Polyflow.

Ansys Help

Our product documentation is online, directly linked from within our applications. With online docu-
mentation, you have access to the best and latest content, updated as soon as it is available. You also
gain access to our help, tutorials, and videos in a single, convenient location, accessible from all your
Internet-connected devices. Note that, if you are accessing our help directly at https://ansyshelp.an-
sys.com/ by logging in with your Ansys Customer Portal user name (email) and password, the site does
not currently accept passwords that contain letters topped by umlaut marks.

If you do not have Internet access, or if you would like a local copy of the documentation on your system,
you can download an installable version of our product documentation from the Ansys Download
Center.

Your feedback is always appreciated as we continue to improve Ansys Help.

Ansys Help (https://ansyshelp.ansys.com/) is not supported on the Internet Explorer browser.

6. Verification Manuals

The Verification Manuals for the following products were updated for 2026 R1:

6.1.Workbench Verification Manual

6.2. Mechanical APDL Verification Manual

6.3. Ansys LS-DYNA Verification Manual

6.1. Workbench Verification Manual

6.1.1. New Workbench Test Cases

No test cases were added for 2026 R1.

6.1.2. Modified Workbench Test Cases

No test cases were modified for 2026 R1.

6.1.3. Removed Workbench Test Cases

No test cases were removed for 2026 R1.
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6.2. Mechanical APDL Verification Manual

6.2.1. New Mechanical APDL Test Cases

• VM324: Swelling Strain of a Block Under High Fluence Loading: A fluence is applied on a
block constrained in the vertical direction. This induces a swelling strain. The value of the swelling
strain is compared to Mechanical APDL results.

6.2.2. Modified Mechanical APDL Test Cases

• VM174: Bimetallic Beam Under Thermal Load: 4-Node Coupled Field Shell (SHELL229) added
to the test case.

• VM223: Electro-Thermal Microactuator Analysis: 4-Node Coupled Field Shell (SHELL229) added
to the test case.

6.2.3. Removed Mechanical APDL Test Cases

No test cases were removed for 2026 R1.

6.3. Ansys LS-DYNA Verification Manual

Updates for 2026 R1:

6.3.1. New LS-DYNA Test Cases

6.3.2. Modified LS-DYNA Test Cases

6.3.3. Removed LS-DYNA Test Cases

6.3.1. New LS-DYNA Test Cases

LS-DYNA Workbench Test Cases

No test cases were added for 2026 R1.

LS-DYNA Solver Test Cases

• VM-LSDYNA-SOLVE-038: Rectangular Plate with Circular Hole Subjected to Tensile Loading:
The simulation models a 3D rectangular plate with a central circular hole, a geometric irregularity,
subjected to linear static structural analysis to evaluate stress concentration effects.

• VM-LSDYNA-SOLVE-039: Buckling of a Uniform Rod: This test case models the elastic buckling
behavior of a uniform cantilever rod under axial compressive loading.

• VM-LSDYNA-SOLVE-040: Buckling of a Stepped Rod: This finite element (FE) simulation invest-
igates the elastic buckling behavior of a stepped cantilever rod subjected to two axial loads: a
tensile force and a compressive force.

• VM-LSDYNA-SOLVE-041: Buckling of a Curved Panel: This finite element (FE) simulation invest-
igates the elastic buckling behavior of a curved panel under a uniform radial pressure.
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• VM-LSDYNA-SOLVE-042: Modal Analysis of an Annular Plate: This test case models the free vi-
bration of an annular plate, subjected to a free-clamped condition. The objective is to validate
the first six natural frequencies of the structure.

• VM-LSDYNA-SOLVE-043: Fundamental Frequency of an Elliptical Plate: This test case simulates
the vibration of a clamped-edge elliptical plate to validate its fundamental natural frequency.

• VM-LSDYNA-SOLVE-044: Modal Analysis of a Rectangular Plate: This simulation models the vi-
bration of a rectangular plate with the two smaller edges subjected to a simply supported con-
dition and one of the other edges subjected to a clamped condition. The objective is to validate
the first six natural frequencies of the structure.

• VM-LSDYNA-SOLVE-045: Fundamental Frequency of a Square Plate with Opening: This simu-
lation investigates the vibration of a clamped squared plate with a central opening.

• VM-LSDYNA-SOLVE-046: Fundamental Frequency of a Slender Beam with Central Mass: This
test case models the vibration of a pinned-pinned slender bar with a concentrated mass at its
mid-length. The objective is to validate the fundamental natural frequency of the structure.

• VM-LSDYNA-SOLVE-047: Axial Natural Frequency of Hat Beams: This test case simulates the
vibration of a spring-mass system composed of two collinear hat bars. The objective is to validate
the axial natural frequency of the structure.

• VM-LSDYNA-SOLVE-048: Transverse Natural Frequencies of a Cantilever Tube: This test case
models the vibration of a cantilever tube.

• VM-LSDYNA-SOLVE-049: Natural Frequency of a Spring-Mass System: This test case models
models a spring-mass system comprised of an instrument set on a rubber mount. The objective
is to validate the system's natural frequency.

• VM-LSDYNA-SOLVE-050: Lateral Vibration of a Rectangular Plate: This test case models the
lateral vibration of a rectangular plate with one smaller edge subjected to a clamped condition.
The objective is to validate the structure's first natural frequency of lateral vibration.

• VM-LSDYNA-SOLVE-051: Natural Frequencies of a Circular Plate: This test case models the vi-
bration of a circular plate with its edge subjected to a clamped condition.

• VM-LSDYNA-SOLVE-052: Natural Frequencies of a Two-Mass-Spring System: This test case
models a system composed of two masses and three springs. The objective is to validate the two
normal modes and natural frequencies of the system.

• VM-LSDYNA-SOLVE-053: Seismic Response of a Mass-Spring System: This test case models a
vibrometer, consisting of a mass-spring system with base excitation.

• VM-LSDYNA-SOLVE-054: Seismic Response of a Mass-Spring-Damper System - Equivalent
Structural Damping: This test case models a mass-spring-damper system with a harmonic dis-
turbing force acting on the mass.

• VM-LSDYNA-SOLVE-055: Transient Response of a Mass-Spring-Damper System: This test case
models a mass-spring-damper system, which is displaced by a distance Δ when released. Four
damping ratios are tested. The objective is to validate the displacement profile of each system.
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• VM-LSDYNA-SOLVE-056: Transient Response of a Two-Mass-Spring System: This test case
models a system composed of two masses and two springs. Mass 1 is subjected to a pulse load
F. The objective is to validate the displacement profile of each mass.

• VM-LSDYNA-SOLVE-057: Pin-Ended Double Cross: In-Plane Vibration: This test case models
eight beams of the same length, evenly spaced, and connected at the center. All endpoints are
constrained in the x and y directions. The objective is to validate the frequency of predicted
modes.

• VM-LSDYNA-SOLVE-058: Buckling of a Bar with Hinged Ends (Beam Elements): This test case
models the elastic buckling of a long, uniform bar with hinged ends subjected to axial loading.
The objective is to validate the critical buckling load of the bar.

• VM-LSDYNA-SOLVE-059: Portal Frame Under Symmetric Loading: This test case models a
rectangular frame subjected to a uniform distributed load.

• VM-LSDYNA-SOLVE-060: Seismic Response of a Simply Supported Beam: This test case models
a simply-supported beam with both supports subjected to vertical motion. The objective is to
validate the natural frequency, the maximum deflection, and the maximum bending stress of
the beam.

• VM-LSDYNA-SOLVE-061: Transient Response of a Ball Impacting a Flexible Surface: This test
case models a rigid ball dropped onto a flexible surface. The objective is to validate the time,
displacement, velocity, and kinetic energy of the ball at the moment of the impact and the
maximum displacement.

• VM-LSDYNA-SOLVE-062: Cantilever with Off-Center Point Masses: A cantilever beam is situated
horizontally with two off-center lump masses. The beam is constrained in all DOFs at the left
end. Frequency vibration analysis is performed on the model.

• VM-LSDYNA-SOLVE-063: Cylindrical Vessel Under Internal Pressure: This test case models a
long cylindrical vessel with closed ends, subjected to an internal pressure. The 3D cylinder is
modeled as a 2D axisymmetric rectangle representing the cylindrical shell, and the objective is
to validate the circumferential stress of the vessel.

• VM-LSDYNA-SOLVE-064: Deep Simply-Supported Beam: This test case performs frequency vibra-
tion analysis on a simply-supported beam that is constrained in the x, y, z and Rx direction on
the left endpoint and in the y and z direction on the right endpoint.

LS-DYNA Fluids Test Cases

• VM-LSDYNA-FLUID-008: 2D Passive Scalar Transport in a Laminar Channel Flow: This test case
models the transport of a passive scalar (species) in a two-dimensional, incompressible, steady,
laminar flow inside a channel.

• VM-LSDYNA-FLUID-009: Womersley Flow: Pulsative Flow in a Rigid Cylindrical Tube: This test
case models the Womersley flow which consists of an oscillatory, fully developed laminar flow
of a Newtonian fluid in a rigid cylindrical tube driven by a time-periodic pressure gradient.

• VM-LSDYNA-FLUID-010: Conical Body Impact on a Water Free-Surface: This test case models
the impact of a conical body on a water free-surface. The objective is to validate the vertical hy-
drodynamic force profile over time.
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• VM-LSDYNA-SPH-001: 2D Laminar Couette Flow Simulation (SPH): The simulation uses SPH to
model classical Couette flow, representing a viscous, incompressible fluid confined between two
parallel plates.

LS-DYNA EMAG Test Cases

No test cases were added for 2026 R1.

LS-DYNA Benchmark Test Cases

No test cases were added for 2026 R1.

LS-DYNA Impact Test Cases

• VM-LSDYNA-IMPACT-001: Normal Collision of a Rubber Sphere with a Steel Plate: This test
case models the normal collision of a deformable rubber sphere with a rigid steel plate.

• VM-LSDYNA-IMPACT-002: Tensile Elastic Wave Analysis in a 3D Split-Hopkinson Pressure Bar:
This test case models the three-dimensional impact of a hollow cylinder (striker) on a flange
connected to a long bar (incident bar).

• VM-LSDYNA-IMPACT-003: Tensile Elastic Wave Analysis in a 2D Split-Hopinson Pressure Bar:
This test case models the two-dimensional impact of a hollow cylinder (striker) on a flange con-
nected to a long bar (incident bar).

• VM-LSDYNA-IMPACT-004: Compressive Elastic Wave Analysis in a 3D Split-Hopkinson Pressure
Bar: This test case models the three-dimensional impact between two long cylinders (a moving
striker and stationary incident bar).

• VM-LSDYNA-IMPACT-005: Compressive Elastic Wave Analysis in a 2D Split-Hopkinson Pressure
Bar: This test case models the two-dimensional impact between two long cylinders (a moving
striker and stationary incident bar).

LS-DYNA Dynamics Test Cases

• VM-LSDYNA-DYNAMICS-001: Uniform Precession of Gyroscope (Rigid Parts): This test case
calculates the precession angular speed of a gyroscope to validate the LS-DYNA dynamics calcu-
lations for spinning bodies, specifically rotational motion. All components are modeled as rigid
bodies.

• VM-LSDYNA-DYNAMICS-002: Uniform Precession of Gyroscope (Elastic Solid Disk): This test
case calculates the precession angular speed of a gyroscope (gyro) to validate the LS-DYNA dy-
namics calculations for spinning bodies, particularly rotational motion. All components, except
for the elastic disk (flywheel), are modeled as rigid bodies.

• VM-LSDYNA-DYNAMICS-003: Uniform Precession of Gyroscope (Elastic Shell Disk): This test
case calculates the precession angular speed of a gyroscope (gyro) to validate the LS-DYNA dy-
namics calculations for spinning bodies, particularly rotational motion. All components, except
for the elastic disk (flywheel), are modeled as rigid bodies.

6.3.2. Modified LS-DYNA Test Cases

No test cases have been modified for 2026 R1.
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6.3.3. Removed LS-DYNA Test Cases

No test cases have been removed for 2026 R1.

7. Online Video Access

To review an extensive library of How-To Videos that detail how to use Ansys product features, go to
the Ansys How-To Videos page at YouTube. Note that you can now also access the How-To videos from
the Ansys Help home page for your product.

8. Ansys Customer Site

If you have a password to the Ansys customer site ( www.ansys.com/customercommunity ), you can
view additional documentation information and late changes. The customer site is also your source for
Ansys, Inc. software downloads, service packs, product information (including example applications,
current and archived documentation, undocumented commands, input files, and product previews),
and online support.

All product documentation is available in printable format (PDF). You can also copy content from
within the files into a word-processing program.

Ansys customer site access points:

• Tutorials and input files 

To access tutorials and their input files, go to the tutorials area of the customer site.

• Documentation 

To access documentation files, go to the documentation area of the customer site.

• General information 

For general information about materials and services available to our customers, go to the main
page of the customer site.
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Ansys 3D Design Products

Release Notes

Release notes are available for the following Ansys 3D Design products:

Discovery (p. 3)

SpaceClaim (p. 25)

DesignModeler (p. 29)





Discovery Application Release Notes
Release 2026 R1 of the Discovery application contains the following.

1. Discovery Application Product Advisories

2. Discovery Application Enhancements Overview

3. Discovery Application Caveats and Known Issues

1. Discovery Application Product Advisories

Be aware of the advisories and product changes described here.

Installation and Licensing Advisories

• Operating System Support

– Support for Microsoft Windows 10 (all versions) has been dropped.

– Support for Microsoft Windows 11 version 22H2 has been dropped.

• The Discovery application's CUDA Toolkit version is now updated to 12.8 GA. Synopsys recommends
the latest drivers, with the minimum required driver version for minor version compatibility being
>=528.33.

• Discovery application 2025 R2 was the final version that included support for NVIDIA Kepler-based
and Maxwell-based graphics cards. Starting with Release 2026 R1, the application only supports Pascal-
based cards and later versions.

• In general, the Discovery application maintains support of cards for as long as NVIDIA drivers and
SDKs allow. For a list of NVIDIA cards no longer supported, see Installation Prerequisites.

Discovery Application Beta Features

For information about Beta features, see Discovery Application Beta Features Documentation in the Ansys
Help.

Also see Discovery Application Enhancements Overview (p. 3) for features that have been added or
enhanced.

2. Discovery Application Enhancements Overview

For product advisories and changes to the Discovery application features that existed in earlier releases,
see Discovery Application Product Advisories (p. 3).
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Areas where you will find new capabilities and enhancements in the application include:

2.1. Fluid Flow Simulation

2.2. Contacts and Interfaces

2.3.Transfer to the Icepak Application

2.4.Transfer to the Mechanical Application

2.5. Solution and Optimization

2.6. Modeling Tools

2.7. Query Editor

2.8. History Tracking

2.9. Materials

2.10. User Interface Enhancements

2.11. User Settings Summary

2.12. Results

2.13. Sample Models

2.14. Performance

2.15. Installation and Licensing

2.16. Ansys 3D Design Verification Manual

2.17. Ansys Discovery Technology Showcase: Example Problems

2.1. Fluid Flow Simulation

2.1.1. Compressible Flow

Compressible flow now supports a velocity inlet. In past releases, the application only supported
a mass flow or a pressure inlet.

2.1.2. Fluids Solver

Fluid flow simulations now support additional solver settings in Explore and Refine. From the
Simulation Options dropdown menu on the Simulation tab, under Additional Fluid Flow Options,
the default Fluids solver is set to Program Controlled. This setting allows the application to de-
termine the most appropriate pressure-based solver for the simulation. Choose SIMPLE (a segregated
algorithm) for steady-state incompressible simulations, or Coupled for steady-state and time-de-
pendent compressible flows, as well as flows with a strong swirling component.
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2.1.3. Capture Sharp Edges

The capture sharp edges option in Explore is enhanced with additional options for more flexibility
in capturing sharp edges on your model. From the Simulation Options dropdown menu in the
Simulation tab ribbon, under Additional Fluid Flow Options (Explore), the default setting for
Specify capture sharp edges is Program Controlled. This default option allows the application
to choose how to best capture sharp edges on your model. You can change the setting to capture
All sharp edges instead, and the application will attempt to capture all sharp edges in the mesh
leading to increased accuracy. However, choosing this setting can increase computation time and
decrease solution stability. Otherwise, choose None to avoid capturing sharp edges.
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2.1.4. Capture Thin Structures

Capture thin structures is a new fluids meshing option added to improve discretization of thin
regions and accurately represent mesh areas with thicknesses smaller than the local size. With this
feature, the application creates stretched (anisotropic) cells along thin directions, which can help
lower the cell count compared to isotropic refinement. If this option is not enabled, isotropic cells
are generated and very thin regions are merged or overlooked, possibly leading to a loss of detail.

2.1.5. Geometry Discretization Warnings

If the current fidelity level is insufficient when solving a fluid flow simulation in Explore, the applic-
ation generates a warning whenever the discretized body volume used by the solver differs by
more than 25% from the geometry body volume. Additionally, a warning is issued if the discretized
face area used by the solver differs by more than 25% from the geometry face area for all physics
conditions. These warnings ensure that included cutter bodies, where the solid region is not sup-
pressed, are effectively managed. Note that this is not applicable to excluded cutter bodies.

2.2. Contacts and Interfaces

2.2.1. Fluid-to-Fluid Interfaces and Virtual Walls

Under File Menu > Settings > Physics > Workflow Options, Show fluid-to-fluid interfaces is
now selected by default. Fluid interfaces for simulations with fluid-to-fluid interfaces will be visible
in the physics tree.

You can now specify a virtual wall between two fluid regions and choose whether to define the
virtual wall to be a perfect conductor or a perfect insulator.

Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.6

Discovery Application Release Notes



2.2.2. Thermal and Electric Conductance Definition

Contacting surfaces and fluid-solid interfaces now include additional methods for defining thermal
and electrical conductance. You can now choose from the following methods:

• Perfect conductor

• Perfect insulator

• User specified value for conductance

• Material and thickness-based conductance

• Thickness and conductivity-based conductance

7
Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.

Discovery Application Enhancements Overview



2.2.3. Electric Conditions and Joule Heating

Fluid-solid heat transfer simulations now support electric conditions and allow you to model Joule
heating, as well as enabling the free or forced convection simulation of busbars, fuses, conductors,
electronic traces, etc.

2.3. Transfer to the Icepak Application

2.3.1. Transfer Fluid, Thermal or Fluid-thermal conditions to Icepak application

Discovery application data can now be transferred to the Icepak application. If fluid, thermal, fluid-
thermal, or fluid-thermal with electric conduction conditions exist, the Icepak application will be
launched with .aedti files.
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2.4. Transfer to the Mechanical Application

2.4.1.Transfer Fluid-Solid (Conjugate) Heat Transfer Data to Mechanical Applic-
ation

You can now transfer fluid-solid (conjugate) heat transfer simulations from a completed Discovery
simulation to the Mechanical application using one of the following options:

• Structural only - transfers structural analysis data, including static pressure results at the
fluid-solid interface and solid body temperature results.

• Thermal only - transfers thermal analysis data, such as heat transfer coefficients and near-
wall temperature results at the fluid-solid interface, along with solid thermal or electric
thermal conditions.

• Linked Thermal Structural - transfers thermal analysis data, including heat transfer coefficients
and near-wall temperature results at the fluid-solid interface, as well as solid thermal or
electric thermal conditions. Structural analysis data, including static pressure at the fluid-
solid interface and a one-way transfer of solid body temperature from the thermal analysis,
is also included.

2.5. Solution and Optimization

2.5.1. Defined Variations Sampling Algorithm

When generating variations using the sampling algorithm, define the target number of variations
by entering a value. The target number entry box replaces the previous slider.

2.5.2. Sensitivity Analysis and Total Coefficient of Prognosis

When working with defined variations, the Sensitivity analysis investigates the influence of paramet-
erized inputs on outputs. The application displays the analysis results as a predictive approximation
quality and sensitivity matrix (Coefficient of Prognosis matrix) and visualizes the functional relation-
ship between two inputs and a selected output (response) as a 3D interactive response surface
plot. Together, the matrix and response surface plot assist you in deciding whether to continue
with the current approximation model or whether additional sampling data or inputs are needed
for improvement.

2.6. Modeling Tools

Note:

Many modeling tools are common between the Discovery and SpaceClaim applications,
although implementations may differ depending on product.
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2.6.1. Improvements to Modeling Documentation

Additional modeling documentation originally developed for the SpaceClaim application is now
available in the Discovery Documentation's Table of Contents. This change provides easier access
to detailed conceptual and reference information about modeling functionality.

You may notice anomalies in the modeling documentation when accessed from the Discovery ap-
plication. Improvements are ongoing.

2.6.2. Sketch Tool Improvements

The sketch tool includes the following:

• New automatic dimension support - Explicitly specifying a dimension while sketching will auto-
matically generate a dimension constraint.

• Spline knots now support dimension constraints.

• Improved display of dimensions and constraints.

2.6.3. Bend Tool

The Bend tool is now available in the Discovery application.

You can bend straight lines and edges to form an arc. You can also adjust the radius of arcs and
arced edges.

2.6.4. Combine Tool

The Combine tool now includes the following new options:

• The Combine tolerance option enables you to combine bodies which cannot normally be
combined with the Combine tool. Set an appropriate Combine tolerance in the tool to merge
or subtract bodies which cannot be merged otherwise or produce small slivers which will be
eliminated.

This was previously available as a beta feature.
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• The Transfer named selections option enables you to transfer named selections while merging
or subtracting bodies using the Combine tool.

2.6.5. Interference Tool

The Interference tolerance option enables you to detect and remove interference between bodies
that cannot normally be removed with the Interference tool. Set an appropriate Interference
tolerance in the tool to remove the interference between the bodies.

2.6.6. Suppression Tool

The Suppression tool enables you to suppress edges or vertices in your model.

• As an alternative method for cleaning up your model, you can mark edges or vertices as sup-
pressed so that they will not be considered in downstream applications such as the Mechanical
application. For example, you can suppress edges or vertices if they may result in problematic
mesh elements or extra refinement.

• The repair tools Split Edges, Extra Edges, and Small Faces include an additional option to
suppress topologies. Extra edges or vertices in the model can be marked as suppressed using
this option.

• While in the Suppression tool, the application highlights the suppressed edges or vertices to
indicate them in the display.

2.6.7. Detect Tool

Two new tools have been added to the Detect tool in the Prepare tab.

• The Fasteners tool detects and classifies parts as bolts, nuts, and washers. The fastener detection
method uses a machine-learning–trained heuristic approach.

• The Sliver faces tool detects faces within a specified angle range. It identifies sliver faces and
supports adding them to a primary selection or converting them into grouped or individual
named selections.

2.6.8. Edit Faceted Bodies

When editing faceted bodies using the Pull or Move tool, the Proportional option enables deform-
ation to be propagated proportionally to a region of the faceted mesh, rather than exclusively to
the selection.
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In contrast to the default transformation (extrusion without modifying connectivity or adding new
vertices), this option uses the selected regions and the specified angle range which may impact
meshing downstream.

2.7. Query Editor

The Query Editor enables you to create queries for obtaining a selection set which can be associated
with a named selection.

• Enter data in the Query Editor rows to define a selection set, then refine the selection by adding,
removing, or filtering entities from the selection.

• Update query-based selections when the scope changes or new bodies are added.

• Transfer the named selections downstream to flagship applications.

Note:

The Query Editor is not available when History tracking is active.

2.8. History Tracking

Enhancements to History Tracking include improvements to the sketch blocks, support for additional
tools, and improvements to the geometry parameterization workflow.

• The Sketch block has been streamlined for clarity.

• The Bend and Wrap tools are now supported.

• Geometry parameterization and modification with the Pull-Parameterization and Move-Parameter-
ization tools are now improved. The history blocks recorded for these operations are now distinct.
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2.9. Materials

Six new records have been added for the 2026 R1 release:

• Rubber, silicone (thermal interface material)

• Plastic, ABS+PC (15% stainless steel fiber, flame retarded)

• Plastic, ABS (15-20% stainless steel fiber)

• Plastic, PA66 (20% carbon fiber)

• Plastic, silicone molding compound (50-70% glass fiber)

• Plastic, bisphenol epoxy molding compound (mineral filler)

Additionally, some data values have been updated.

2.10. User Interface Enhancements

2.10.1. Default UI Themes

The Discovery application now includes enhanced versions of the classic Dark and Light UI themes.
These themes prioritize the visual acuity of the model and results, standardize color use, improve
contrast, and resolve past inconsistencies. You can return to the legacy themes by navigating to
General > User Interface > UI theme and choosing Revert to legacy theme colors. You can also
enable and disable the Solid background setting. When enabled, a solid color without any gradient
is applied to the graphics scene. Click the color picker to choose a different solid color from the
palette.

2.10.2. Beams Assignment

Beams Assignment now supports multiple functions, including Assign Beam and new features
Create Vertex Chain and Create Vertex Pair, which simplify the creation of beam geometry and
the application of beam profiles. You can assign standard or custom profiles to curves, generate
beam paths by chaining vertices, or create connecting curves between vertex pairs.

2.10.3. Extension Builder

The Extension Builder now supports shortcut assignments for custom actions. It enables faster
access to user-defined tools and commands, improving workflow efficiency.

2.10.4. Export to SimAI

Under File Menu > Save As, a new SimAI option has been added. This generates a zip containing
the .vtp, .vtu and .json files. The .json file contains all the numeric meta data for boundary conditions
and materials.
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2.10.5. Import Granta Cloud Materials

When you sign in to the cloud during a  session, you can now import Granta cloud materials. Click
Materials > Import from Granta Cloud Materials. The Granta Material Picker launches and enables
you to choose materials to add to your local Discovery library, which will then be available for
simulations.

2.10.6. Welcome Page

The Graphics performance mode setting appears on the Welcome splash screen for easier access.
Select from Auto-detect, Standard (best all-around) and Enhanced (high frame rates).

2.11. User Settings Summary

2.11.1. General

The Discovery application now includes enhanced versions of the classic Dark and Light UI themes.
These themes prioritize the visual acuity of the model and results, standardize color use, improve
contrast, and resolve past inconsistencies. You can return to the legacy themes by navigating to
General > User Interface > UI theme and choosing Revert to legacy theme colors. You can also
enable and disable the Solid background setting. When enabled, a solid color without any gradient
is applied to the graphics scene. Click the color picker to choose a different solid color from the
palette.

2.11.2. Licensing

You can now change the Discovery application's primary license level without needing to restart
the application. To do so, navigate to Settings > Licensing > Discovery license and choose the
desired level.

2.11.3. Physics

2.11.3.1. Fluids Solver

Under Settings > Physics > Solver Settings, the default selection is Program Controlled, which
allows the application to apply the most appropriate pressure-based solver for the simulation.
You can specify also SIMPLE (a segregated algorithm) or Coupled as the defaults.

Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.14

Discovery Application Release Notes



2.11.3.2. Capture Sharp Edges

Under Settings > Physics > Simulation Options Defaults (Explore), the default setting for
Capture sharp edges is Program Controlled. This setting allows the application to choose how
to best capture sharp edges on your model. You can change this default setting to instead capture
All sharp edges, which directs the application to attempt to capture all sharp edges in the mesh.
While this option can lead to increased accuracy, it can also increase computation time and de-
crease solution stability. You can avoid capturing sharp edges by choosing None.

2.11.3.3. Capture Thin Structures

Under Settings > Physics > Simulation Options Defaults (Explore), the Capture thin structures
option has been added to accurately represent mesh areas with thicknesses smaller than the
local size. With this feature, the application creates stretched (anisotropic) cells along thin direc-
tions, which can help lower the cell count compared to isotropic refinement. If this option is not
enabled, the application generates isotropic cells, and therefore may overlook or merge very thin
regions, possibly leading to a loss of detail.
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2.11.3.4. Fluid-to-Fluid Interfaces

Under Settings > Physics > Workflow Options, Show fluid-to-fluid interfaces is now selected
by default. Fluid interfaces for simulations with fluid-to-fluid interfaces will be visible in the
physics tree.

2.11.4. Results

2.11.4.1. Location Setting for Fluid Flow Monitors

Under Results > Monitor, you can specify the Monitor location for fluid simulations to be on
Individual faces or on Conditions and interfaces. The application calculates results on individual
faces only on the selected faces, while calculating results on conditions and interfaces only at
the location where the condition is applied.

2.11.4.2. Saved Scenes Remote Download Image Resolution

Under Results > Saved Scenes, you can Set image resolution for remote downloads. Available
resolutions include: Low (1280 x 720), Medium (1920 x 1080), High (2560 x 1440) and 4K (3840
x 2160).

2.11.4.3. Include Explore Results

Under Results > Full Results, you can include explore results to save Explore results to
the .dsco file. Loading a file that has results will bring the simulation automatically in the Com-
pleted state, therefore, it is no longer necessary to resolve the simulation to review the results.
The results will persist in the file, so the file sizes will be larger.

Select the Visual results quality (High, Medium or Low) and include results variables if you
want to save all or only the essential results.
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2.11.5. Advanced

When running on a multi-GPU hardware configuration, the new setting Compute GPU under Ad-
vanced > Advanced Options specifies which GPU to use for the solver and may result in improved
performance.

2.11.6. Cloud Services

Under Cloud Services > General, you can Synchronize data with cloud to maintain GL transmission
format binary file (GLB) synchronization between the local Discovery desktop application data and
the Discovery web companion application. Options include synching On save or not at all if set to
Off.

2.12. Results

2.12.1. Viscous and Pressure Force Monitors

New force monitors for fluid flow simulations now include Viscous Force and Pressure Force.
Additionally, the Force monitor is now named Total Force.
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2.12.2. Wall Yplus Monitors

Monitors now include a new wall Yplus monitor result. Yplus indicates whether the near-wall mesh
is adequately refined. The value should lie between 30 - 300.

2.12.3. Results Comparison Dashboard

Use the Results comparison dashboard when working with saved scenes to capture, download
and visually compare results.

2.12.4. Location Setting for Fluid Flow Monitors

Under Results > Monitor, you can specify the Monitor location for fluid simulations to be on
Individual faces or on Conditions and interfaces. The application calculates results on individual
faces only on the selected faces, while calculating results on conditions and interfaces only at the
location where the condition is applied.

2.12.5. Tabular Results

You can now view a tabular summary of Constraint Force Reaction, Constraint Moment Reaction,
and Maximum Part Temperature monitors. When viewing your results, you can export the data to
a comma-separated or tab-separated list, or you can copy the data to your clipboard as a tab-sep-
arated list.
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2.12.6. Structural Chart Results

Structural chart results are now available on curves and edges. You can select a chart location and
result variable, then define additional details such as Minimum or Maximum values, and in some
cases directional components. You can also reverse the starting point of the path that defines the
distance from the X axis to the other end of the curve.
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2.12.7. Filtered Seeding

Improved filtered seeding for streamlets and particles is now available for fluid flow simulations.
Previously, reducing the display range would also reduce the number of visible streamlets or
particles, making it harder to interpret results. With filtered seeding, particles and streamlets are
now seeded directly within the selected range, maintaining consistent counts and improving clarity.
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2.12.8. Particle Count

You can now control the particle count for fluid simulations, to aid you in more effectively visualizing
the flow.

2.13. Sample Models

The Discovery application now includes new sample models for structures, fluids, and fluid-solid heat
transfer.
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2.14. Performance

This release continues to address performance and responsiveness. You may notice performance im-
provements in all stages of the application, including:

• Better handling of long-running operations with progress indication, improved messaging and the
ability to cancel the operation

• Improved stability using enhanced graphics performance mode

• Increased reliability in opening projects using local fidelity

• Improved GPU control for the LiveGX solver when running on a multi-GPU hardware configuration

2.15. Installation and Licensing

2.15.1. Installer Enhancements

The installer provides the options to:

• Select the Headless Geometry Service (PyAnsysGeometry) option to install the Geometry
Service packet. For details, see https://geometry.docs.pyansys.com/version/stable/.

• Select from three CAD interface configuration options:

– Yes, automatically configure my interfaces

– Yes, I will manually make my selections

– No. Skip configuration. I will configure later
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2.15.2. License Preference Overrides

When you first install the Discovery application, and prior to launching it, you can use the DISCOV-
ERY_LICENSE_OVERRIDE system environment variable to override the default ordering of licenses.
The application reads this variable the first time it is launched and overwrites the system file that
specifies the default license order. Primary and alternate licenses are set accordingly. This enhance-
ment is especially helpful in organizations with mixed license pools, allowing them to dictate which
licenses to apply for a specific user.

2.15.3. On Demand License Level Change

You can now change the Discovery application's primary license level without needing to restart
the application. To do so, navigate to Settings > Licensing > Discovery license and choose the
desired level.

2.16. Ansys 3D Design Verification Manual

These verification cases have been added:

• THERM-007 Transient Heat Conduction in a Semi-Infinite Slab

• FLUID-009 Forced Convection Over a Flat Plate

• FLUID-010 Surface to Surface Radiative Heat Transfer Between Two Concentric Cylinders

• FLUID-011 Low Reynolds Number Flow in a Channel with Sudden Asymmetric Expansion

• FLUID-012 Separated Laminar Flow Over a Blunt Plate

• FLUID-013 Turbulent Flow in a 180° Pipe Bend

• FLUID-014 Laminar Flow in a Triangular Cavity

2.17. Ansys Discovery Technology Showcase: Example Problems

This example has been added:

• Mesh Independence Study of a Hip Stem Implant

3. Discovery Application Caveats and Known Issues

At the time of publication, caveats and known issues in Release 2026 R1 of the Discovery application
are listed below. Also refer to the Ansys, Inc. Known Issues and Limitations document.

• When importing a CREO file created with a version older than CREO 8.0, body names in the model
display with an expected ".prt" file type extension. Workaround: Resave the CREO file with a newer
CREO version. [788192]

• When solving random vibration remotely, 3D interactive results are unavailable. Workaround: There
is no workaround. [1372995]
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• The defined electrical conductance is missing when exporting a solid-heat transfer simulation with
Joule heating and contacts to the Workbench application. Workaround: Specify the electric conduct-
ance on the bonded contact in the Workbench application simulation. [1393453]
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SpaceClaim Release Notes
Release 2026 R1 of SpaceClaim contains the following.

1. SpaceClaim Product Advisories

2. SpaceClaim Changes Overview

3. SpaceClaim Caveats and Known Issues

1. SpaceClaim Product Advisories

SpaceClaim users should be aware of the advisories described here.

SpaceClaim Geometry Kernel

• The underlying geometry kernel for SpaceClaim changed from ACIS to Parasolid at Release 2025
R1.

• SpaceClaim Release 2024 R2 was the last version based on ACIS.

Installation

The SpaceClaim application was removed from the Ansys unified installers and the standalone Dis-
covery application installer at Release 2025 R1, but you can still install it using the methods described
in Installation (p. 25).

API Version Support

API version V232 has been deprecated at Release 2026 R1 and will be removed at Release 2027 R1.

If you have customized add-ins or scripts, make sure they are upgraded to the most current version.

2. SpaceClaim Changes Overview

The following changes have been made at Release 2026 R1:

2.1. Installation

2.2. Scripting

2.3. Import/Export Support

2.1. Installation

Although the SpaceClaim product is no longer included in either the Discovery product installation
or in the Ansys, Inc. Installation Launcher (Ansys unified installer), you may still install SpaceClaim
if needed. Use one of these methods to install SpaceClaim:
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Downloading the Installation Package From the Customer Portal

You can download the SpaceClaim installation package from the Ansys Download Center and
install it:

1. Sign in to your account. If you don't have an account, you are prompted to create one.

2. From the list of Downloads on the left, select Current Release.

3. Expand Add-On Packages and locate the SpaceClaim section. Click Full Package to begin
the download.

4. From the Windows File Explorer Downloads folder, extract the .zip file to a convenient location
on your computer.

5. In the folder of extracted files, double-click setup.exe and follow the prompts to install
SpaceClaim.

From the Command Line

When running the Ansys unified product installation from the command line, you can include
the -install_spaceclaim option to install SpaceClaim.

For example: setup.exe -install_spaceclaim

Obtaining SpaceClaim as a Component of Another Product

When you install Material Designer or Speos, SpaceClaim is also automatically installed and con-
figured.

2.2. Scripting

• The current Scripting version is v261.

• API version V232 has been deprecated at Release 2026 R1 and will be removed at Release 2027 R1.

If you have customized add-ins or scripts, make sure they are upgraded to the most current version.

2.3. Import/Export Support

• The legacy SpaceClaim *.scdoc files are imported using a translator. Opening these files may take
longer due to the geometry conversion.

• The saving of legacy SpaceClaim *.scdoc files is no longer supported. You can only save files in the
*.scdocx format.

3. SpaceClaim Caveats and Known Issues

At the time of publication, caveats and known issues in Release 2026 R1 of SpaceClaim include those
listed below. Also refer to the Ansys, Inc. Known Issues and Limitations document.

Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.26

SpaceClaim Release Notes



• For legacy SpaceClaim (ACIS-based *.scdoc) assemblies, you need to load the *.scdoc based root as-
sembly and save it with 25.x or later versions of SpaceClaim. This ensures that all the referenced
component or sub-assembly *.scdoc files are migrated to the newer *.scdocx format during save. The
original *.scdoc file is not modified, a copy in *.scdocx format is created. Changes to only component
or sub-assembly *.scdoc files do not update the root assembly references to the newer format files.
(1349954)
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DesignModeler Release Notes

1. DesignModeler Product Advisories

DesignModeler users should be aware of the advisories and product changes described here.

2. DesignModeler Enhancements

DesignModeler 2026 R1 has no new features or enhancements.

3. DesignModeler Caveats and Known Issues

At the time of publication, there are no caveats or known issues in Release 2026 R1 of DesignModeler.
Also refer to the Ansys, Inc. Known Issues and Limitations document.
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Ansys Structural Products

Licensing

At Release 2026 R1, Ansys Mechanical products have transitioned to the new Ansys Common Licensing
model. Additional license increments have been added. The previous bundled license increments that
enable multiple applications (for example, ansys, mech2, mech1) remain unchanged. For more inform-
ation, see Summary of New and Changed Features in the Ansys, Inc. License Management Guide.

Release notes are available for the following Ansys Structural products:

Mechanical Application (p. 33)

Mechanical APDL (p. 53)

Autodyn (p. 79)

Aqwa (p. 81)

ACP (p. 85)

Material Designer (p. 89)

Additive Suite (p. 91)

Sherlock (p. 99)

Forming (p. 109)

Motion (p. 119)

LS-DYNA (p. 121)





Mechanical Application Release Notes
This release of Ansys Mechanical™ contains all of the capabilities from previous releases plus many new
features and enhancements. Areas where you will find changes and new capabilities include the following:

1. Changes in Product Behavior

2. Documentation

3. Performance

4. Add-ons

5. Graphics

6. Geometry

7. External Model

8. Composites

9. Contact and Connections

10.Tables

11. Mesh

12. Additive Manufacturing Process Simulation

13. Analysis

14. Fracture

15. Substructure Analysis

16. Structural Optimization

17. Motion

18. Imported Loading Conditions

19. Solution

20. Explicit Dynamics

21. Results

22. Scripting

1. Changes in Product Behavior

Release 2026 R1 includes new features and enhancements that result in product behaviors that differ
from previous releases. Behavior changes include:

• Impedance Sheet Formulation for Acoustic Analysis. The formulation for the Impedance Sheet
definition has been refined to ensure greater physical consistency in acoustic simulations. See the
Mechanical APDL Release 2026 R1 Update Guide for more information.

• Electromechanical Coupling Coefficient. When you insert an Electromechanical Coupling Coefficient
probe in a coupled field simulation that includes Acoustics physics, the scoping of the probe now
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automatically selects the coupled field and structural bodies of the analysis/analyses. Previously, the
application automatically used the All Bodies option.

• Imported Body Temperature. When importing a body temperature load from a result file (*.rth)
that contains degenerated elements, and 1) the Mapped Data property is set to To Binary File and
2) the Weighting property is set to Shape Function, the elements are now classified according to
their original element type when the application maps the mesh. The mapping process uses element
type classification and shape function weighting algorithms to determine spatial interpolation and
node inside/outside criteria.

Previously, if you had a quadrilateral element with four nodes (1, 2, 3, and 4), and nodes 3 and 4 were
duplicates, the application reclassified the element as triangular. Now, the same element is treated
as a quadrilateral element, preserving its original type. This change affects interpolation calculations
and may result in different mapped target data compared to previous versions. See the Degenerated
Shape Elements section of the Mechanical APDL Element Reference for more information.

• Remote Point Application. Now, when you apply a Remote Point to a single surface node, the
Behavior property must be set to Rigid. Previously, you could set this property to either Deformable
or Rigid. See the Force-distributed Constraint Theory Background topic in the Surface-Based Constraints
section of the Mechanical APDL Contact Technology Guide for more information.

• Remote Points Property Setting When Grouping Loads Imported from Maxwell. When loads are
imported from Maxwell, the Grouping property is now set to To Binary File by default. As a result,
the Remote Points property is automatically set to Globally Available. The default setting for the
Grouping property is specified using the Grouping Default for Imported Remote Loads (Options
> Import > Imported Remote Loads) preference. Options for this preference include By Location,
To Binary (default), and No.

• Fracture Analysis. The following fracture-related behavioral changes have been made in the current
release:

– SMART Crack Growth: For the SMART Crack Growth feature:

→ You can now evaluate the Fracture Probes, Crack Extension, and Total Number of Cycles,
regardless of the setting of the Store Results At property (Analysis Settings > Output
Controls). In previous releases, these results were only supported when Store Results At
was set to All Time Points.

→ The default maximum number of restart files (*.xnnn) saved during a restart analysis that
includes SMART Crack Growth is now 99, matching the maximum for remeshing database
files (*.rdnn). Previously, the default maximum was 999 for restart files and 99 for
remeshing database files.

– Imported Body Temperature. Previously, during a fracture analysis, when you imported Body
Temperature loads (node-based loads) from External Model, and generated a crack mesh over
the imported mesh, the application removed scoping if the load was applied to the nodes
included in the crack mesh region. Now, the application preserves the scoping and properly
maps the load values onto the crack mesh generated on the imported base mesh.

– Imported Constraints and Named Selections. When you import Constraints or Named Selec-
tions from External Model into an analysis that includes analytical crack definitions, the applic-
ation now retains their scoping, as long as these objects are not included in the scoping of
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crack definitions. In previous releases, such scoping was automatically removed, even if the
imported objects were outside the crack mesh zone.

• Upstream Modal Calculation Improvements for Level-Set and Shape Optimization. For the Level-
Set and Shape Optimization methods of a Structural Optimization analysis, the application now
performs more accurate result calculations when Objective and Response Constraint objects are
specified for an upstream Modal analysis. This enhancement may result in different result values
compared to previous releases due to improved computational accuracy.

• Importing Geometry from Deformation Results. When you transfer deformed geometry from a
supported upstream system to a downstream system in Workbench, the application supports the
generated Mechanical APDL common database (*.cdb) files, used to transfer the geometry, in
COMPACT formats for the CMBLOCK and EBLOCK commands. See the Coded Database File Commands
section of the Mechanical APDL Programmer's Reference for more information about these commands.
Note that External Model system supports *.cdb files generated in COMPACT format.

• Velocity Result Import from Upstream Coupled Field Harmonic Analyses. Now, when you import
velocities from an upstream Coupled Field Harmonic analysis, the Source Bodies property of the
Imported Velocity object should be set to the bodies that include the velocity results. If the property
is set to the All option, the application returns an import failure.

Use the new option, All Available Result Nodes, for the Source Bodies property. This option auto-
matically selects only the bodies in the upstream system that contain result data, streamlining the
import process and improving mapping accuracy. This change prevents importing bodies that do
not contain result data and eliminates unnecessary processing operations, improving overall efficiency.

Note that you can also select the bodies that include the results using the following options of the
Source Bodies property:

– Manual: Manually select bodies based on Material ID.

– Named Selection: Select a Named Selections defined in the upstream system.

• Imported Velocity Mapping. To improve performance and reduce resource usage when mapping
Imported Velocity load data, the application now automatically sets the Weighting property to Tri-
angulation whenever the Mapping Control property is set to Program Controlled. Previously, the
application used Shape Function as the default setting for the Weighting property. Unlike Shape
Function, Triangulation uses point cloud-based mapping on nodal data. As a result, it avoids mapping
data from interior nodes, which reduces both mapping time and resource consumption.

• Linked Mode-Superposition (MSUP) Analyses. Now, when locally (In Process) solving an MSUP
Harmonic Response or an MSUP Transient Structural analysis linked to an upstream Modal analysis,
a new preference, Enforce Remote File Usage for Modal, eliminates the need to manually enable
the On Demand Expansion Option property. When you select the Enforce Remote File Usage for
Modal preference, the application automatically references prerequisite files using full paths (RESUME
and MODDIR). This reduces setup effort and prevents file duplication, even when On Demand Ex-
pansion Option property is set to No.

• Connections Group. When the Connection Type property is set to Contact, the Faces option of
the Group By property now merges multiple contacts which have the same scoping on the target
side and overlapping scoping on the contact side. In previous releases, the application would create
individual contacts. Furthermore, when the Face/Face property is set to Yes and you change the
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Group By property to Faces, the Face Overlap Tolerance is automatically set to 5%. Previously it
was set to 0 (Off).

• Connections Worksheet. The Connections worksheet now includes the following usability improve-
ments:

– Table Display and Sizing: Now, when you first generate worksheet content, the application
automatically sizes all table columns to fit to the current screen width.

– Default Filter Behavior: Previously, all property filters were active by default when generating
worksheet content. Now, properties with all values set to Program Controlled are by default,
not displayed.

– Resetting Columns: Now, when you select the Reset Columns option, the application auto-
matically hides columns with all properties values set to Program Controlled or Not Applicable
(N/A).

• Contact Region Constraint Type. The Program Controlled setting of the Constraint Type property
now uses Automatic Constraint Type for all contacts associated with bodies that have non-structural
physics. In previous releases, the application used Distributed, All Directions.

• Vector Display properties for Life and Damage Vector Results in the DesignLife Add-on can now
be modified from the Mechanical application toolbar.

• For Strain-Life analyses using the DesignLife Add-on, user-defined Materials Assignment parameters
are populated automatically using values from the Engineering Data, if available. Otherwise a set
of default values is used.

• The Initial Conditions object for the Mechanical Motion application has been updated so that it is
only applied once, not cumulatively, for geometries within a single part, regardless of how many
geometries are selected. If multiple Initial Conditions objects are defined for these geometries, only
the most recent is applied.

• Tooltips: New hover-over tooltips have been added for the Details pane properties of selected objects,
including Contact Region, among others

• Material Optimization Result Display. In the previous release, results generated using the Material
Optimization method were displayed with a transition region between optimized materials, which
limited the clarity of the output. This issue has been resolved in the current release. The results now
display distinct material regions as intended, improving interpretability and accuracy.

• Python Code objects now support copy, paste, and duplicate.

2. Documentation

The following documentation changes and/or enhancements were made for Release 2026 R1:

• Contact Documentation: The contact documentation has been enhanced and reorganized.
Definitions and specification-type information are now located in the Contact Region description
within the Mechanical Object Reference. Engineering context, workflow, guidelines, recommend-
ations, and troubleshooting tips are provided in the Contact section of the Mechanical User’s
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Guide. Additionally, new hover-over tooltips have been added to the Contact Region's properties
in the Details pane of the Mechanical application.

3. Performance

The following performance related enhancements were implemented for Release 2026 R1:

• Imported Load Mapping Performance Improvements.

– Processing Time Enhancements. Now, depending on the number of source and target nodes
and the number of time/frequency sets being mapped, the processing time required to import
and map load data to your model has been reduced by at least 10% and as much as 50%.
To accomplish this, the imported load must be specified with the following property settings:

→ Mapped Data = To Binary File.

→ Weighting = Triangulation or Distance-Based Average, or this property set to Shape
Function and Transfer Type = Volumetric.

Given these settings, the processing improvements occur automatically.

– Imported Velocity Mapping. In addition, to improve performance and reduce resource usage
when mapping Imported Velocity load data, the application now automatically sets the
Weighting property to Triangulation whenever the Mapping Control property is set to
Program Controlled. Previously, the application used Shape Function as the default setting
for the Weighting property. Unlike Shape Function, Triangulation uses point cloud-based
mapping on nodal data. As a result, it avoids mapping data from interior nodes, which reduces
both mapping time and resource consumption.

4. Add-ons

The following updates were made to the Mechanical add-ons for Release 2026 R1:

• The DesignLife add-on offers the following capabilities:

– A new Weld Line Creator worksheet allows you to generate weld definition files for use
with solid element models.

– The Walker Mean Stress Correction method is supported for Stress Life, Strain Life,
Shell Seam Weld, Solid Seam Weld and Safety Factor analyses.

– Temperature Selection Method is available for temperature loads in time domain Stress
Life and Strain Life analyses.

– For Stress and Strain analyses, the S-N and E-N Curves defined for the Multi-Curve ma-
terials are plotted together with the Modified S-N Curves and Modified E-N Curves
based on the application of surface correction factors.

– A Virtual Strain Gauge Graph post-processing object has been added to validate Virtual
Strain Gauge time series results.

– Damage and Rainflow Histogram Plot post-processing objects.
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– The Time Series Load Definition for Time Domain Loads includes support for Sinusoidal
loading.

– The View Time Series Plot option for a Time Series Load allows you to display the se-
lected time series file in a graph.

• The NVH Toolkit add-on now includes:

– The Number Of Paired Modes calculated for Result Optimization in the MAC Calculator.

– The Maximum Number of Sensors in the Sensor Definition for the Pre-Test Calculator
now also takes into account any manually-added sensors.

– The FRF Calculator offers Curve-Fitting Analysis and a corresponding Stabilization
Chart, displaying all associated information in graphical format.

– HDF5 file support for the MAC Calculator.

– Aggressive and Conservative Filtering Options for the MAC Calculator.

– Expanded Visualization Options for Mode Animation View. File 1 and File 2 mode shape
results can be superimposed and animated in a single graphical window.

– An option has been added to the FRF DOF Pairs Table to allow computation of the FRF.

– Modes Filtering Options are available in the MAC Frequency Worksheet.

• A new Fast Dynamic Response add-on has been created, including:

– The Fast PSD Response object, providing a spectrum response for a structural component
subject to random excitation.

– The Fast Frequency Response object, providing a frequency response for a structural
component subject to a harmonic load.

• Updates for the Additive Manufacturing add-ons are described in the Additive Manufacturing
Release Notes.

• A new Export To STAR add-on exports the results of an Ansys Mechanical analysis to files that
can be loaded into the Ansys Zemax OpticStudio application via the STAR Multiphysics Data
Loader. The exported files contain multiphysics datasets, including surface deformation, thermal
profiles, and stress files. Export to STAR formats and names these FEA datasets for easy import
into the Zemax OpticStudio software. This streamlines the export process and helps you to keep
track of the FEA datasets and the surface(s) where they are assigned in an optical design.

• A new Weld Process add-on manages welding process simulations and makes it easier to set up
welding models for Static Structural and Transient Thermal analyses. This add-on includes:

– A Weld Process object that lets you configure weld parameters, heat source model, and de-
position settings for your welding simulation.

– A Weld Setup object that lets you import and generate a welding sequence, which is displayed
in an editable worksheet. You can add multiple Weld Setup objects to simulate parallel welding
processes.
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– A Weld Penetration result object that shows how the welding process affects the temperature
profile around the weld regions. You can add multiple Weld Penetration result objects to
visualize temperature profiles for different weld regions.

5. Graphics

The following graphical display enhancements were made at Release 2026 R1:

• New Graphics Preferences. The application now includes the following new graphics-based
preferences (Options > Graphics):

– Use Mesh Manager for Mesh Display: This preference enables internal processing improve-
ments through refactored mesh display logic. While the changes are largely structural, they
enhance performance and responsiveness when displaying the model’s mesh. Specifically,
when you select the Show Mesh option, the underlying refactoring enables the application
to display and hide bodies significantly faster. Options include Yes (default) and No.

– Apply Body Translucency to Edges: When enabled, model edges appear transparent,
matching the translucency of the associated body/faces. This feature improves visibility of
annotations in complex models that contain many parts, making it easier to review and interpret
details. Options include Yes and No (default).

– Display All Element Normals in Standard Graphics Mode. This preference works only when
Display Element Normal for Mesh is enabled. For objects that do not use Accelerated
Graphics, such as the Connections object, displaying element normals can take extra time.
To improve performance, the preference automatically reduces the number of element normal
arrows shown. Enable this new option to display all element normal arrows. Note that for
models with a large number of elements, display performance may be slower. Options include
Yes and No (default).

– Graphics Display Progress Bar. The application displays a progress bar while computing the
graphics required to display complex meshes and results. Options include Yes (default) and
No.

6. Geometry

The following geometry enhancements were made at Release 2026 R1:

• Keep Fluid Cross Area on Update/Refresh. For a line body geometry, when you set the Model
Type property to Thermal Fluid, there is a new preference, Keep Fluid Cross Area on Update/Re-
fresh (Options > Geometry), that enables you to prevent the application from resetting the value
if you update the source geometry. Options include Yes and No (default).

• You can now add multiple Body Merge objects to a model. Individual Body Merge objects can
be nested within a larger Body Merge, making it easier to assemble complex parts.

When you add a Body Merge, the Mechanical application creates a Body Merges group in the
Model tree (if one is not already present), then adds a Body Merge object within the group. The
new Body Merge object is automatically assigned a number (#1 Body Merge, #2 Body Merge,
and so forth) in the order that it is created.
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7. External Model

The following External Model system enhancements were made at Release 2026 R1:

• External Model Browser. For the Windows operating system, the new External Model Browser
window enables you to view the processed and unprocessed keywords/commands for supported
file types imported into the Mechanical application using External Model options. The browser
displays a tree of supported keywords/commands and options that enable you to preview
properties or to add a keyword or command to the analysis through a command object.

• Imported MPC and Joint Connections. You can now import mesh-based Multi-Point Constraints
(MPCs) from Mechanical APDL common database (*.cdb) files using the External Model system.

• Imported Shell Thicknesses. You can now import variable shell thickness data for ABAQUS,
NASTRAN, LSDYNA, and Mechanical APDL common database files. The application supports
variable thickness on each corner node. Once imported, the Worksheet for the Shell Thicknesses
object provides options that display the thickness values for each node.

• New Pyramid Element Type Support. You can now import the following pyramid elements:

– ABAQUS: C3D5 (linear) and C3D13 (quadratic)

– NASTRAN: CPYRAM (with the option of being linear)

8. Composites

The following composite related enhancements were made at Release 2026 R1:

• Composite Sampling Point Tool. You can now scope the Composite Sampling Point Tool to
an ACP Solid Model. This enhancement lets you access results from the bottom to the top of
the laminate and visualize the through-thickness distribution of key data, including stacking se-
quence, strains, stresses, and failure indicators. Understanding this distribution is essential for
analyzing laminate behavior and optimizing composite designs.

• Imported Reinforcements. Mechanical now supports solid transfer with reinforcing plies from
Ansys Composite Prep™ (ACP) system. The application imports the reinforcing plies and adds
them under the Imported Reinforcements group object. A typical application is to model
complex layered composite structures such as engine fan blades or 3D printed structures.

9. Contact and Connections

The following contact and connection enhancements were made at Release 2026 R1:

Contact Enhancements

• Ramping Contact Stiffness. You can now control how contact stiffness is ramped during your
analysis using the new Ramp Stiffness By property of the Contact Region object. This property
enables you to specify ramping using the following options:

– Program Controlled: The solver decides how and when to ramp the contact stiffness.
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– Load Step: Stiffness is ramped during a designated load step.

– Time Range: Stiffness is ramped over a specified time interval.

• New Target Shell Face Option. Now, using the new option, Top and Bottom, of the Target
Shell Face property, you can model contact pairs on the top and the bottom of a shell/surface
body face using only one set of the target surface. This capability reduces the total number of
target elements while also improving the processing of large assembly models where the orient-
ations of underlying shell elements are not obvious or consistent.

• Constraint Type Enhancements. The Constraint Type property option, Mixed Assembly, now
supports solid-to-solid contact definitions.

Connections Enhancements

• Joint, Spring, and Beam Connections. When defined as a Remote Attachment, you can now
scope Joints, Springs, and Beam connections to one or more nodes.

• Automatically Merge Contacts. When using the Connections Group object with the Connection
Type property set to Contact and the Group By property set to Faces, the application now
automatically merges contacts wherever possible. This enhancement enables you to:

– Reduce over-constraint issues found with MPC formulation-based contacts, particularly
when multiple contacts share the same target faces or have overlapping scoping.

– Minimize the number of contacts created in the majority of the cases. For example, a PCB
model where a multiple contacts share a common target face. This also reduces the
overall computational time taken by the solver in most cases.

• Connections Worksheet. The Connections worksheet now includes a new context (right-click)
menu option: Fit to Screen Width. This feature automatically adjusts the widths of all table
columns to evenly fill the available space.

Additionally, when you select the existing Reset Columns option, the application now automat-
ically hides any column where all values are set to Program Controlled or Not Applicable (N/A).

10. Tables

For Release 2026 R1, the following table enhancements have been made:

• New independent and dependent variables are available in the Tables function to support Mechanical
APDL scripts that contain the *DIM command. These new variables include field variables and dimen-
sionless numeric data.

11. Mesh

For mesh related enhancements, see the Meshing release notes.

12. Additive Manufacturing Process Simulation

See Additive Manufacturing.
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13. Analysis

Release 2026 R1 includes the following analysis enhancements:

• Mode Superposition (MSUP) Transient Structural Analysis. You can now use the Load Application
feature to apply and scale base excitations or load vectors, generated by an upstream Modal analysis,
in a downstream MSUP Transient Structural analysis.

• Load Support for Modal Analyses: You can now specify the following loading conditions in a
Modal analysis:

– Standard Earth Gravity

– Pipe Pressure

– Bearing Load

– Line Pressure

– Imported Body Force Density

– Imported CFD Pressure

– Imported Pressure

These loads do not affect natural frequencies or mode shapes. However, you can use the load vector
data from these boundary conditions. Apply and scale them with the Load Application object for
downstream Mode Superposition (MSUP) Harmonic Response and/or MSUP Transient Structural
analyses.

• Apply Commands to Load Vectors Using a Commands (APDL) Object. During Modal or Substructure
Generation analyses, you can now use the Commands (APDL) object to apply command snippets to
specific load vectors using its new Load Vector Selection Mode property. The options of this property
enable you to apply the Commands (APDL) object to all load vectors or a specific load vector of the
analysis. Options include All (default) and By Number. This feature requires you to insert the command
object under the Environment object of the given analysis.

• Multistage Cyclic Symmetry. For stand-alone Static Structural analyses, the application’s multistage
cyclic symmetry capability now supports the following boundary condition and loading definitions:

– You can now apply Remote Force, Moment, and Remote Displacement boundary conditions
within multistage cyclic symmetry setups.

– A Rotational Velocity can be specified using a harmonic index value, as defined by the Stage
object.

• Analysis Settings > Step Controls. A new property, Maximum Iterations Per Substep, has been
added to the Step Controls category of the Analysis Settings object. For nonlinear static and transient
analyses, this property enables you to specify the maximum number of iterations the solver can
perform within each substep of a nonlinear analysis to reach equilibrium.

• Analysis Settings > Rotordynamics Controls. The Coriolis Effect property now supports the On,
Rotating Reference Frame setting for Harmonic Response, Modal, and Static Structural analyses.
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• Coupled Field Analyses. When coupling structural and thermoelectric conduction analyses, the ap-
plication now uses the SOLID225 element for lower order meshes. Previously, it used SOLID226, a
higher-order element, but dropped the mid-side nodes. This change ensures more appropriate element
selection for the analysis type.

14. Fracture

Release 2026 R1 includes the following Fracture analysis enhancements:

• For the SMART Crack Growth feature:

– Fracture Probes: You can now evaluate Fracture Probes, Crack Extension and the Total
Number of Cycles, regardless of the setting of the Store Results At property (Analysis
Settings > Output Controls). In previous releases, these results were only supported when
Store Results At was set to All Time Points.

– Restart Controls: A new property, Maximum Total Files to Save, has been added to the
Restart Controls category of the Analysis Settings object. This property defines the
maximum number of restart files that can be saved during a restart analysis. Use this
property to control the total number of restart files retained for future restarts of the
analysis. During a SMART Crack Growth restart analysis, the default maximum number
of saved files is 99 for both restart files (*.xnnn) and remeshing database files (*.rdnn).

• Imported Body Temperature. Previously, when you imported body temperature loads (node-
based loads) from External Model, and generated a crack mesh over the imported mesh, the
application removed scoping if the load was applied to the nodes included in the crack mesh
region. Now, the application updates the scoping and properly maps the load values onto the
crack mesh generated on the imported base mesh.

• Imported Boundary Conditions and Named Selections. When you generate a crack mesh on
an imported base mesh that includes imported Contacts, Constraints, Surface Loads, and Named
Selections from an external mesh model, the application now retains their scoping, as long as
the scoping of these objects is unaffected by the crack mesh generated locally. In previous re-
leases, such scoping was automatically removed, even if the imported objects were outside the
crack mesh zone.

15. Substructure Analysis

Release 2026 R1 includes the following Substructure Analysis enhancements:

• Generation Pass Enhancements. When defining a Condensed Part or performing a Substructure
Generation analysis:

– You can now control whether the Constraint Mode Data (CST) required for an Expansion Pass
is written to the Component Mode Synthesis (*.cms) file using the new Future Expansion
property. Omitting the Expansion pass related data significantly reduces the size of the .cms
file which is ideal for workflows where the expansion pass is not needed.

– The application does not generate the *.LN22 and the *.BCLV files during the Generation
pass except when the Keep Files For property of the Condensed Part object is set to MAPDL
Expansion.
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16. Structural Optimization

Release 2026 R1 includes the following Structural Optimization analysis enhancements:

• Cyclic Symmetry. The optimization process now includes Cyclic and Pre-Meshed Cyclic symmetry
types during shape derivative computations for the following optimization methods:

– Topology Optimization - Mixable Density

– Topology Optimization - Level Set Based

– Shape Optimization

This enhancement allows you to take advantage of the computational efficiency offered by
symmetry-based analysis, reducing model size and solution time while maintaining accuracy.

• Millability Manufacturing Constraint. A new Manufacturing Constraint is available: Millability.
Use this manufacturing constraint to design optimized structures that you can manufacture using
four-axis milling.

• User Defined Criteria for Materials Optimization. For the Materials Optimization method,
you can now specify user-defined criteria:

– On geometry using the Measures object.

– In an upstream Static Structural analysis using the Primary Criterion and Composite Cri-
terion objects.

You can then specify this criterion in the Objective and Response Constraint objects.

• Member Size Manufacturing Constraint. The application now supports the Maximum Size
and Gap Size properties of the Member Size manufacturing constraint when using the Topology
Optimization – Mixable Density method.

• Materials Optimization Results. For the Materials Optimization method, the result type depends
on the selected formulation. For this method, when you use the specify multiple materials as
Full (Filling Method), the application automatically creates a Topology Multi-Density result.
When you specify Lattice, the application automatically creates a Lattice Density result.

17. Motion

The following enhancements were made to the Motion application at Release 2026 R1:

• The Motion application now offers System Coupling with the Maxwell application, using a Motor
EM Force object that supports both 2D and 3D designs. You can also specify the Maxwell application
version to ensure solution consistency in Magnetic Field analysis.

• Co-simulation between the Motion and Maxwell applications is also now supported, using the
Magnetic object to define the groups of bodies that require magnetostatic analysis.

• Output Controls have been updated to allow transfer of coordinate systems to the Motion standalone
preprocessor, and enable or disable recording of EHD Bearing and Motor EM Force results.
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• The Joint Load Properties object now supports Point on Curve (PTCV) joints. PTCV joints also now
support velocity and acceleration for sliding motion.

• A new Export Motion Files dialog has been added to allow selective export of DFS, SSC and DFSXML
files, as well as reference and post graphic files.

• The Drivetrain Toolkit includes a Contact Damping Ratio property for Bearing objects, Gear Con-
figuration for Planetary Gearsets without sun and ring gears, a range of Tolerance options for Ex-
ternal Gearsets, a Tooth Pressure property for the Drivetrain Assembler, and a Gear Summary of
the latest Gear Set specification including an Export button to save this as an HTML file.

• The Links Toolkit now supports the use of Multibody Parts, includes a Synchronize Stiffness option
for the Links Assembler to avoid errors due to the modification of the stiffness behavior during
analysis, and an Engage option to provide manual control of the wrapping method for the Path
object. Dummy contacts that are generated internally before cloning and are now no longer displayed
in the Links Assembler tree.

For changes to the Motion solver, see the Motion Standalone Release Notes.

18. Imported Loading Conditions

The following imported loading condition enhancements were made at Release 2026 R1:

• Imported Load Mapping Improvements.

– Processing Time Enhancements. Now, depending on the number of source and target
nodes and the number of time/frequency sets being mapped, the processing time required
to import and map load data to your model has been reduced by at least 10% and as
much as 50%. To accomplish this, the imported load must be specified with the following
property settings:

→ Mapped Data = To Binary File.

→ Weighting = Triangulation or Distance-Based Average, or this property set to
Shape Function and Transfer Type = Volumetric.

Given these settings, the processing improvements occur automatically.

– Imported Velocity Mapping. In addition, to improve performance and reduce resource
usage when mapping Imported Velocity load data, the application now automatically sets
the Weighting property to Triangulation whenever the Mapping Control property is
set to Program Controlled. Previously, the application used Shape Function as the default
setting for the Weighting property. Unlike Shape Function, Triangulation uses point
cloud-based mapping on nodal data. As a result, it avoids mapping data from interior
nodes, which reduces both mapping time and resource consumption.

– Progress During Load Import and Mapping. Also, when you are using the To Binary
File option of the Mapped Data property to import a load, the application now displays
a progress bar that indicates the current frequency or time set being interpolated, along
with the total number of sets to process.

– Parallel Processing for Binary File-Based Imported Loads. To improve the data mapping
process on Linux, you can now set the maximum number of cores using the Workbench
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Maximum Number of Cores preference (Tools > Options > Mechanical). By default, the
application uses all cores. This capability requires the following settings:

→ Mapped Data = To Binary File

→ Weighting = Shape Function

→ Transfer Type = Volumetric

• Specifying Source Bodies for Imported Loads. For Imported Velocity and Imported Body
Temperature loads, when Mapped Data = To Binary File, the Source Bodies property now in-
cludes a new drop-down option: All Available Result Nodes. This option automatically identifies
and selects all bodies in the upstream system that contains result data. This enhancement elim-
inates the need to manually define Named Selections when the upstream result is filtered, sim-
plifying setup and improving data mapping efficiency.

• Imported Heat Generation from Maxwell. You can now import Imported Heat Generation
loading conditions from the Maxwell application to a downstream Coupled Field Static or Coupled
Field Transient analysis.

• Imported Body Temperature. When importing data for an Imported Body Temperature load
with Mapped Data set to To Binary File, the application now updates only the modified Scale
or Offset values (as adjusted in the Data View window). It no longer remaps all load data. This
targeted update significantly reduces mapping time for Scale or Offset changes, especially when
working with moderate to large source datasets.

• Importing Body Temperature Using External Data. For Static Structural and Transient Struc-
tural analyses, you can use External Data to import temperature results in H5DPF file format and
define an Imported Body Temperature load. This file type is created using ANSYS Data Processing
Framework (DPF) and is based on the Hierarchical Data Format version 5 (*.h5).

• Grouping Loads Imported from Maxwell. Now, when importing remote loads from the Maxwell
application, use the Grouping Default for Imported Remote Loads (Options > Import > Im-
ported Remote Loads) preference to change the default setting for how the application groups
the load data using the Grouping property. Options for this preference include By Location, To
Binary (default), and No.

19. Solution

Release 2026 R1 includes the following solution enhancements:

• Ansys HPC Platform Services (HPS) Improvements for Structural Optimization

Mechanical now supports direct referencing of result and database files from upstream analyses
when performing Structural Optimization with HPS Solve.

– When solving with HPS, Mechanical no longer downloads and reuploads result (*.rst)
and database (*.db) files from upstream analyses to downstream Structural Optimization
systems.

– These files are referenced directly on the server, reducing costly file I/O operations.
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– After the Structural Optimization solution completes, the *.rst file no longer must be
downloaded for post-processing. Mechanical accesses it directly.

Display File Download Rate While Downloading Results

In addition, when downloading files from HPS, Mechanical now displays:

– The current file download rate.

– Individual file sizes.

– The total amount downloaded during the operation.

This visibility helps you better understand transfer performance and progress when working with
large result files.

• Resource Prediction. This feature:

– Now incorporates hardware performance characteristics from the HPC Platform Services
(HPS) queue, when available, to provide more accurate estimates for solution times and
memory usage.

– Has been enhanced to display a prompt recommending the use of the GPU acceleration
capability in order to improve performance.

• New Mixed Solver Type for Structural Analyses. A new solver type, Mixed, is now available
for Static Structural and Transient Structural analyses. This option combines the strengths of
both the sparse and PCG solvers, offering improved speed and memory efficiency without
compromising accuracy. See the EQSLV command in the Mechanical APDL Command Reference
for more information.

• Solution Statistics. When you choose to use GPU acceleration, the Solution Statistics worksheet
(Solution Information > Solution Output) now provides new GPU related information in the
HPC Metrics section of the worksheet, such as the selected card and whether GPU acceleration
was beneficial for the solution.

20. Explicit Dynamics

The Workbench application provides multiple systems that enable explicit solutions:

• Explicit Dynamics

• LS-DYNA

The enhancements for these systems for Release 2026 R1 are described below.

Explicit Dynamics

The following updates were made at Release 2026 R1:

• Ansys HPC Platform Services (HPS). HPS can now be used with the Explicit Dynamics system
as an alternative to the Remote Simulation Manager (RSM) for creating and managing jobs.
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LS-DYNA

For LS-DYNA systems, note the following enhancements for Release 2026 R1:

• 1D ALE Analysis Support. You can now run a 1D ALE analysis for a system that has 2D behavior.
Line body properties can be set using the Section object, which then writes the *SECTION_ALE1D
card to the input file.

• 2D Postprocessing by Material. You can now plot results based on an S-ALE material for a 2D
analysis in the LS-DYNA system.

• ALE Mesh Motion Object. The new ALE Mesh Motion object can be used to apply motion to
an underlying mesh of bodies that have an S-ALE Domain Reference Frame.

• Bushing Joint and General Joint Support. The LS-DYNA system now supports the use of
Bushing Jointsand General Joints for modeling.

• Custom Time Step Size Object. The new Custom Time Step Size object allows you to define a
time-step curve using tabular data, specifying how the time-step size changes over time. This
data can then be applied to step controls in the Analysis Settings.

• Cylindrical Coordinate System for Displacement. You can now use a cylindrical coordinate
system on a set of nodes to restrain the degrees of freedom (radial, tangential and axial).

• D3dlrf Support. To assess if dynamic relaxation was successful, the LS-DYNA system now supports
*DATABASE_BINARY_D3DRLF to postprocess the dynamic relaxation result file.

• Deformable to Rigid Switch Type. The Switch Type in a Deformable to Rigid object, defines
how the deformable to rigid switch is performed. It can be set to Manual, where the transform-
ation takes place at the start of a simulation, or it can be Automatic, where the switch is triggered
at a specified time during the calculation.

• Editable Multiple RPMs Analysis Properties. A Multiple RPMs analysis can be changed from
having read-only RPM properties to editable RPM properties.

• Eroding Contact Program Controlled Values. When the contact Type is set to Eroding for a
Contact Properties object, the Eroding Controls (Symmetry Plane Option, Erosion Interior
Node Option and Solid Elements Treatment) are now set to 1 in the solver when Program
Controlled is selected. This means faces with normal boundary constraints (such as segments of
brick elements on a symmetry plane) are not included, storage is allocated so that eroding contact
can occur, and solid element faces are included if they are on the boundary of the material
subset.

• Full Support of Python Commands. The Get Solve Commands option is now available as a
Target Callback in the Python Code object for the LS-DYNA system, providing the same support
as in Mechanical.

• Importing Rigid Bodies. LS-DYNA rigid bodies can be imported through External Model. Once
imported, they are defined as rigid bodies with full meshes in Mechanical.

• Importing Contacts. LS-DYNA contacts that are imported through External Model are now
scoped to bodies instead of element faces.
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• Internal Heat Generation Support for Thermal Workflows. The LS-DYNA system supports the
Internal Heat Generation thermal loading condition and can be applied using the
*LOAD_HEAT_GENERATION keyword.

• Kelvin Support. If a Metric system is selected for the Solver Unit System under the Analysis
Settings, you can set the Solver Temperature Units (For Metric Systems) to either Celsius (C)
or Kelvin (K).

• Keyword Snippet Improvements. When typing keywords in a Keyword Snippet (LS-DYNA) object,
there is now a drop-down list suggests supported keywords based on your input. After the
keyword has been entered, the Commands worksheet automatically populates with the keyword's
parameters and default values. Additionally, you can now use the *DEFINE_CURVE keyword in
a Keyword Snippet (LS-DYNA) object.

• Linux Support. The LS-DYNA External Model can now be used on Linux operating systems.

• Material Support. The material models *MAT_TABULATED_JOHNSON_COOK and *MAT_SPOTWELD
are now supported in the LS-DYNA system.

• Multibody Parts Support. You can now create multibody parts that consist of both rigid and
flexible parts.

• Pressure Result for ALE Tracer. You can now view the pressure (p) result generated by an ALE
Tracer object.

• Python Command Support. Get Solve Commands is now available as a Target Callback option
in the Python Code object, meaning the LS-DYNA system now provides the same options as
Mechanical.

• RAND_I in User Defined Results. The electric current of a Randles circuit (RAND_I), is now
available as a user defined result.

• Radiation Support for Thermal Workflows. The LS-DYNA system supports the Radiation thermal
loading condition and can be applied using the *BOUNDARY_RADIATION keyword.

• Remote Point Scoping In the Velocity boundary condition, you can now scope to any pre-
defined remote points that have a Rigid Behavior.

• Results Scaling. In the Result ribbon, the Deformation Scale Factor is now set to 1.0 (True
Scale) by default. This means the deformed shape displayed during post-processing is shown at
its true physical scale, which corresponds exactly to the calculation without any exaggeration
or reduction.

• S-ALE Volume Filling for Shell Bodies. Shell bodies can be filled with a material by setting the
Reference Frame to S-ALE Fill and assigning a material.

• Trim Operations for Mesh Workflow. S-ALE Mesh Workflows now provide Trim options to shape
the ALE mesh to be used in the simulation so that it closely mirrors the geometry.

21. Results

Release 2026 R1 includes the following result enhancements:
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• Result Data Caching. For Modal and MSUP Harmonic Response analyses, when the On Demand
Expansion Option property (Analysis Settings > Options) is set to Yes, all result types now in-
clude a new property: Save Auxiliary Results. When enabled, this property automatically caches
result data in memory. This caching significantly improves result retrieval and display performance
when switching between objects. The performance improvement is maintained even after you
close and reopen a solved analysis.

• Line Chart. For LS-DYNA analyses, new features and capabilities are available for the Line Chart
feature, including:

– Charting X Axis Source Data. The new X Axis property enables you to choose a dataset
to plot on the x-axis and the remaining datasets are reconstructed to map to this newly
specified axis.

– Updating the Chart Source Data. A new Update option is now available for when you
modify source objects. When selected, the application deletes the datasets of the source
object(s) and re-imports the revised data, ensuring the chart reflects the most current
information.

– New Source Data Types: Line charts now support the loading conditions Acceleration,
Force, and Pressure as source data objects.

– Editing Labels. You can now directly edit the content of a chart label.

– A new Chart tab is now available in the Chart Options window. This tab enables you to
customize the chart's display using the following options:

→ Title: Enter a title to display at the top of the chart.

→ Font Size: Select the font size for the chart title.

→ Legend: Toggle the legend on or off.

→ Position: Define the position of the legend. By default, this property is set to
Program Controlled, which positions the legend in the most ideal location based
on the data presented in the chart.

Many of these new features offer associated APIs. See the Working with Line Charts section of
the Mechanical Scripting Guide for more information.

• Calculating Midside Node Results. For the supported solid element types, use the new Options
dialog preference, Compute Midside Node Values Based on Averaged Corners (Options >
Results > Default), to specify how the application calculates midside node results. For averaged
results, set the preference to:

– Yes (default) to first calculate the averaged corner node values and then the midside
node result using the calculated averaged corner node values.

– No to calculate midside node values using unaveraged corner node values.

• Moment Reaction Probe. There is a new preference, Moment Probe Summation Point Offset
By Displacements (Options > Results), which affects the calculation of the moment arm of a
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Moment Reaction probe. With this preference enabled, the application moves the Summation
point for the probe to match the closest deformed node. Options include Yes and No (default).

• Far-field Results on Adapted Meshes. You can now compute Far-field results in Harmonic
Acoustics analyses when using an adapted mesh generated through the Mesh Morphing feature.

• Displaying Only the Body with Maximum Result Value. A new context menu option, Show
Body With Max Result, is now available for all evaluated result objects. When selected, the ap-
plication automatically displays only the body that includes the maximum value, as determined
by the location of the Maximum Occurs On property value, for the specified result.

22. Scripting

Release 2026 R1 includes the following enhancements to scripting in the Mechanical application:

• CPython Support. The Mechanical scripting function now supports CPython (Python 3.x) in ad-
dition to IronPython (Python 2.x). You can select either CPython or IronPython as the Python
engine in the Mechanical Scripting Window, the Button Editor, Python Code objects, and Python
Results objects. In addition, you can specify the Python engine for Mechanical ACT extensions
and for running a script when you launch the Mechanical application from the command line.

You can set the default Python engine via File > Options > UI Options > Scripting. This applies
to new scripts, buttons, and Python objects, plus scripts that you run from external files via Run
Macro. For backwards compatibility with existing scripts, the Python engine defaults to IronPython.

For more information about using CPython in Mechanical scripts, see the Scripting in Mechanical
Guide. For a discussion of the differences between IronPython and CPython, see Migrating from
IronPython to CPython.
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Mechanical APDL Release Notes
Release 2026 R1 of the Mechanical APDL™ application offers most of the capabilities from prior releases
plus many new features and enhancements. Areas where you will find updates and new capabilities
include the following:

• Structural (p. 53)

• Multiphysics (p. 60)

• Solvers (p. 63)

• High-Performance Computing (p. 64)

• Other Enhancements (p. 65)

• Commands (p. 66)

• Elements (p. 68)

• Documentation (p. 70)

• Technology Showcase: Example Problems (p. 70)

For more information about this release, see the Update Guide (p. 71) section of this document and
the Global Release Notes.

1. Structural

Release 2026 R1 includes new features and enhancements for the following structural analysis disciplines:

1.1. Contact

1.2. Elements and Nonlinear Technology

1.3. Material and Fracture Modeling

1.4. Linear Dynamics

1.1. Contact

Release 2026 R1 includes the following new features and enhancements for analyses involving contact.

1.1.1. Enhancement of GCGEN and GCDEF commands for better performance and reliability

1.1.2. Moment Convergence Check for Pilot nodes for Structures with No Other Rotational DOFs

1.1.3. Automatic Merging of Overlapping Multi-point Constraint (MPC) Contact Pairs

1.1.4. New Command Stabilizes Nonlinear Solutions

1.1.5. CNTGEN and SFGEN Commands Now Support Nodal Components
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1.1.6. Performance Improvements for Multiple Spot Welds

1.1.7. 2D-3D Bonded MPC Contact for Solid Assemblies Supports Thermal and Structure-thermal Coupling

1.1.8. DMP Performance Improvement of MPC CONTA175 Element

1.1.9. Improved Convergence when Simulating Assemblies that Include Gasket Elements

1.1.1. Enhancement of GCGEN and GCDEF commands for better performance
and reliability

The general contact pre-process commands, GCGEN and GCDEF, have been enhanced to offer
improved accuracy and reduced operation speed. Improvements target the main functions of these
commands: generating the general contact surface, assigning contact properties, and listing or
detailing the properties. These enhancements lead to faster pre-processing times and more reliable
contact definitions, particularly useful when working with large assembly models.

1.1.2. Moment Convergence Check for Pilot nodes for Structures with No Other
Rotational DOFs

Moment convergence is now checked at the pilot node of TARGE170 when target elements have
rotational degrees of freedom (DOFs). Previously, this check at the pilot nodes was ignored if there
were no structural elements with rotational DOFs in the model. This improvement improves accuracy.

1.1.3. Automatic Merging of Overlapping Multi-point Constraint (MPC) Contact
Pairs

The new CNCHECK, MERGE,,,,MPC pre-processing command addresses the issue of overconstraint
in MPC bonded contact by automatically merging all possible overlapping contact pairs. Key benefits
are improved convergence behavior and a reduction in solution time and memory usage. This new
functionality is especially useful for large, complex models with many interconnected parts using
MPC bonded contact definitions.

1.1.4. New Command Stabilizes Nonlinear Solutions

If a nonlinear analysis fails in the very first iteration due to pivoting errors (usually for under-con-
strained problems), use the new WKSP command to improve stability and convergence. The WKSP
command automatically adds weak springs (COMBIN14 elements) at the nodes and DOFs exhibiting
near-zero pivots and reattempts the solution.

1.1.5. CNTGEN and SFGEN Commands Now Support Nodal Components

The CNTGEN (contact generation) and SFCGEN (surface generation) commands have been updated
to support nodal components in addition to the previously supported EFACE (element face) com-
ponents. Nodal components are supported for both the 2D and 3D contact elements to setup
contact and MPC (multi-point constraint) surface constraints.

If nodal components are provided for the contact and target surfaces, issuing CNTGEN generates
contact and target elements based on the dimensionality of the underlying mesh elements:

For 2D Plane Elements: CONTA172 contact elements and TARGE169 target elements.
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For 3D Solid/Shell, Gasket, and Interface Elements: CONTA174 contact elements and
TARGE170 target elements.

The SFCGEN command now creates MPC surface-based constraints over the surfaces formed by
the nodal components based on the user-defined contact element type (ICTY).

For 2D Plane Elements: CONTA172 contact elements with pilot nodes meshed by TARGE169
target nodes (TSHAPE,PILO).

For 3D Solid/Shell, Gasket, and Interface Elements: CONTA174 contact elements associ-
ated with a pilot node meshed by TARGE170 (TSHAPE,PILO).

1.1.6. Performance Improvements for Multiple Spot Welds

Overall performance has been improved for the generation of multiple spot welds with node-to-
surface configuration. Modeling large assemblies for the automotive industry requires generating
several layered spot welds at multiple locations. Issuing several spot weld generation (SWGEN)
commands to simulate this process can be computationally expensive.

To reduce spot weld generation time of large assemblies, memory optimization and the definition
of element attributes like real constants, are now done once at SWGEN,START. The program auto-
matically assigns the next available real constant for subsequent spot welds, speeding up the
overall process.

1.1.7. 2D-3D Bonded MPC Contact for Solid Assemblies Supports Thermal and
Structure-thermal Coupling

The 2D-to-3D bonded multi-point constratint (MPC) contact feature for solid assemblies now supports
thermal and coupled structural-thermal analyses. You can combine multiphysics 2D elements
(PLANE222, PLANE223, PLANE292, PLANE293) elements with 3D elements (SOLID278, SOLID279,
SOLID226, SOLID227) to simulate heat transfer and deformation due to temperature change across
their bonded contact interfaces. For more information, see Modeling a 2D/2.5D-3D Solid Assembly
in the Contact Technology Guide.

1.1.8. DMP Performance Improvement of MPC CONTA175 Element

To boost the performance of large-scale distributed-memory parallel (DMP) contact models, the
solver now separates the underlying elements of CONTA175 into different processing domains.
Previously the CONTA175 elements and their underlying elements were grouped into the same
DMP domain. This change activates when the CONTA175 elements do not need underlying element
information (KEYOPT(5) = 0, KEYOPT(11) = 0, KEYOPT(4) = 0 or 3, target element TARGE170 KEYOPT(7)
is not equal to 0, and the contact pair does not include geometry correction). This performance
improvement results in a lower load balance ratio and better scalability for high-core DMP models
involving contact.

1.1.9. Improved Convergence when Simulating Assemblies that Include Gasket
Elements

The initial contact stiffness for the contact element on top of a gasket element has been updated
to improve convergence behavior for nonlinear structural analysis.
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1.2. Elements and Nonlinear Technology

Release 2026 R1 includes the following enhancements to elements and nonlinear technology used
in structural analyses:

1.2.1. Contact-based Displacement Increment Control

1.2.2. Updates to Smart Stop Criterion

1.2.3. Gasket Element Improvement

1.2.4. Direct Element Embedding Enhancement

1.2.5. General Axisymmetric Element Enhancements

1.2.6. Updates to 3D Structural Shell Elements

1.2.7. Extended support for Nonlocal Damage Formulation

1.2.8. New Standard Variant for Void Creation in Generalized Remeshing for Adaptive Nonlinear Damage
(GRAND)

1.2.9. Automatic Identification and Removal of Orphaned Element Patches in Nonlinear Adaptivity

1.2.10. Support for Arruda-Boyce, Bergstrom-Boyce and TNM Material Models in Nonlinear Adaptivity

1.2.1. Contact-based Displacement Increment Control

You can now control the displacement increment based on the pinball region of open contact
pairs. Issue CUTCONTROL, DSPLIMIT, CONT to limit the substep incremental displacement to a
factor times the minimum pinball radius of all open contact pairs. This helps prevent missing the
contact when a displacement increment causes a contact pair to transition from no-contact to far-
field. See the CUTCONTROL command description for details.

1.2.2. Updates to Smart Stop Criterion

An optional stop tolerance (STOP_TOL) argument is available for the NLHIST command's smart
stop feature. The STOP_VALUE, STOP_COND and STOP_TOL arguments automatically tailor a
nonlinear solution to stop when the value of a tracked variable reaches the specified range, using
bisection followed by time increment prediction.

1.2.3. Gasket Element Improvement

A new algorithm is used for updating the user-defined thickness of 3D gasket elements (INTER194
and INTER195) with the thin-solid option (KEYOPT(2) = 2 or 3) in geometric non-linear analyses
(NLGEOM ,ON). The new algorithm improves the non-linear solution robustness and the accuracy
of element results.

1.2.4. Direct Element Embedding Enhancement

The SHELL229 coupled-field shell elements are now supported as embedded elements, and 3D
coupled-field solid elements (SOLID225, SOLID226 and SOLID227) are now supported as base ele-
ments in the direct-embedding workflow. For more information, see Direct-Embedding Workflow.

Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.56

Mechanical APDL



1.2.5. General Axisymmetric Element Enhancements

The general axisymmetric elements SOLID272 and SOLID273 now support the mono harmonic option
(KEYOPT(2) = 1 and MODE) in linear perturbation modal analyses, enabling the analysis of higher-
frequency modes. Furthermore, by changing the MODE number, multiple load steps are supported
in subsequent modal analyses. The out-of-plane contact behavior for SOLID272 and SOLID273
(KEYOPT(2) = 1) is supported using a 3D contact pair: CONTA175 and TARGE170.

1.2.6. Updates to 3D Structural Shell Elements

The 3D structural shell elements (SHELL181 and SHELL281) now support selected solution output
locations using the EMSEL command. This feature provides flexibility in selecting output locations.

1.2.7. Extended support for Nonlocal Damage Formulation

PLANE183 now supports the nonlocal damage formulation. SOLID186 and SOLID187 elements have
been updated to support nonlocal damage when using the mixed u–p formulation. These enhance-
ments enable use of generalized fatigue damage (implicit gradient regularization) to better capture
the distributed nature of damage in real materials by averaging variables over a finite neighborhood
using a characteristic length scale. This leads to more objective and reliable simulation results and
improved convergence stability. Also, results no longer spuriously depend on mesh size, especially
when material softening or strain localization occurs.

1.2.8. New Standard Variant for Void Creation in Generalized Remeshing for
Adaptive Nonlinear Damage (GRAND)

Multiple voids per substep can be created based on a criterion selection, and these voids are non-
overlapping. The damaged element with the maximum error indicator value is selected as the ele-
ment for single void insertion, using the NLADAPTIVE,,,REMMAT command with VAL3 = 1. For the
multiple voids per substep approach, you can include loaded boundary elements by issuing the
NLMESH,VBND command with VAL1 = 1. With this new variant, you can now create more than
one void per substep based on the criterion value and all damaged elements are considered for
void creation.

1.2.9. Automatic Identification and Removal of Orphaned Element Patches in
Nonlinear Adaptivity

Automatic detection and deletion of orphaned element patches after the element removal process
(NLADAPTIVE,,,REMELM) are now supported using the NLMESH command with Control = ISLD.
This leads to a more stable solution process and convergence when many elements are deleted.

1.2.10. Support for Arruda-Boyce, Bergstrom-Boyce and TNM Material Models
in Nonlinear Adaptivity

The Arruda-Boyce, Bergstrom-Boyce and the TNM material models are now supported in a nonlinear
adaptivity analysis and rezoning analysis. For more information, see Nonlinear Mesh Adaptivity
Requirements and Limitations and Rezoning Requirements and Limitations.
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1.3. Material and Fracture Modeling

Release 2026 R1 includes the following enhancements to material modeling and fracture analysis
technology used in structural analyses:

1.3.1. Finite-strain Material Models Enhancement

1.3.2. Material Curve-Fitting Enhancements

1.3.3. Support for Anisothermal Derivatives in Thermal Analyses

1.3.4. Damage Cap Enhancements

1.3.5. Improved UserCreep Handling in the Extended Drucker-Prager Cap Creep Model

1.3.6. Advanced Grain-Growth Model for Sintering

1.3.7. New Sintering Stress Evolution Models

1.3.8. Conversion of Initial Stress to Crack-surface Traction in Multiple Loadsteps

1.3.9. Enhancement of SIF (Stress-Intensity Factors) Calculation

1.3.10. SMART Support with Substructuring

1.3.11. New Fracture Benchmark Problem

1.3.12. Support of Mixed Element Types in SMART Crack-Growth Analysis

Some material properties are not available via the material property menus of the GUI. For a list of
such material properties, see GUI-Inaccessible Material Properties.

1.3.1. Finite-strain Material Models Enhancement

Finite-strain material models now support swelling effects that can act independently of or in
combination with thermal deformation. The total deformation gradient is multiplicatively split into
mechanical, thermal, and swelling parts, with stresses driven by the mechanical component.

1.3.2. Material Curve-Fitting Enhancements

AI-based automatic initialization of material parameters is now supported for more plasticity models,
including both rate-independent and rate-dependent plasticity. For more details, see Plasticity
Models in Step 4. Initialize the Coefficients.

You can now fix selected coefficients prior to automatic initialization, so that only unfixed coefficients
are initialized. This feature is supported for hyperelasticity and plasticity.

You can also now use automatic fitting in hyperelasticity to generate material parameters directly
from experimental data, skipping the curve fitting process. This is done with the TBFT command.
For details, refer to Automatic Fitting.

1.3.3. Support for Anisothermal Derivatives in Thermal Analyses

The program can now optionally consider anisothermal derivative terms in stiffness and damping
matrices for temperature dependent material properties in a thermal analysis with and without
nonlocal damage. This can help with convergence when material parameters are strongly temper-
ature dependent.
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1.3.4. Damage Cap Enhancements

A damage cap can now optionally be applied to restrict further damage evolution beyond a specified
limit for Regularized Generalized Damage and Ductile Damage. This can prevent elements from
reaching unrealistically low stiffness values, which could lead to convergence difficulties.

1.3.5. Improved UserCreep Handling in the Extended Drucker-Prager Cap Creep
Model

The extended Drucker-Prager Cap Creep model can now be used with custom creep models
(TB,CREEP,,,,100) implemented using the UserCreep subroutine. You can now use the get_ElmData
subroutine with the ‘ECCR’ option in UserCreep to identify if the creep model for the compaction
cap region or the shear region is requested.

1.3.6. Advanced Grain-Growth Model for Sintering

A new general power law model for grain-growth kinetics is now available, enabling more accurate
simulation of normal grain growth during sintering. Unlike the previous parabolic model, this ap-
proach supports variable growth exponents, making it suitable for diverse materials such as
ceramics and metals used in powder metallurgy.

1.3.7. New Sintering Stress Evolution Models

Three new stress evolution models are available for accurate modeling of sintering stress. This en-
hancement builds upon existing stress calculation by adjusting the calculated stress. The new
models are based on work by McMeeking & Kuhn, Ashby, and Shinagawa.

1.3.8. Conversion of Initial Stress to Crack-surface Traction in Multiple Loadsteps

For SMART crack-growth analysis, you can now change the mesh-independent initial-stress data at
any loadstep for conversion to an equivalent crack-surface traction load. The existing data must be
cleared from the solution database before reading the new data. By default, the initial-stress data
specified at the first loadstep is carried over to subsequent loadsteps.

When this load method is used with crack-initiation, the traction load is applied only after the crack
begins to form and its surfaces become available for load application.

1.3.9. Enhancement of SIF (Stress-Intensity Factors) Calculation

The fracture parameter SIF calculation can now provide accurate results for both 2D problems
(PLANE182 and PLANE183) and 3D problems (SOLID185 and SOLID186) undergoing large deflection
and/or rotation.

1.3.10. SMART Support with Substructuring

When a model includes any superelement (MATRIX50), SMART crack growth can now be analyzed
in the nonsuperelement mesh. The superelement must not be in the crack growth remeshing region.
The superelement should be connected to the nonsuperelements via shared nodes or constraint
equations (CE or CEINTF) or contact surface elements (CONTA174).
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1.3.11. New Fracture Benchmark Problem

The following benchmark problem has been added at this release:

• Center-Crack Specimen Subjected to Residual Stress in the Fracture Analysis Guide

1.3.12. Support of Mixed Element Types in SMART Crack-Growth Analysis

SMART crack-growth analysis now supports tetrahedral-to-hexahedral models. This feature now allows
you to use SOLID185 and SOLID186 elements mixed with SOLID187 elements. SOLID185 and SOL-
ID186 elements can be in wedge, hex, or pyramid shapes. After crack growth occurs, the remeshing
domain mainly consists of SOLID187 elements. If a high-order element is connected to a low-order
element, the remesher will use a special connection by dropping the mid-side nodes in the element.

1.4. Linear Dynamics

Release 2026 R1 includes the following enhancements for structural analyses involving linear dynamics:

1.4.1. Enhanced Restart Capability for Harmonic Balance Method Analysis

1.4.2. Multistage Cyclic Symmetry Supports Transient Thermal Analysis

1.4.3. Joints with Cyclic Symmetry Linear Perturbation Harmonic Analyses

1.4.1. Enhanced Restart Capability for Harmonic Balance Method Analysis

In previous versions, restarting a Harmonic Balance Method (HBM) analysis required manually ex-
tracting the initial guess from a results file (.rst) using a custom macro. This approach often led
to discontinuities in the generated results files and added complexity to the workflow.

You can now restart an HBM analysis using the standard command ANTYPE,HARMIC,RESTART,
which includes the option to select the desired substep. The results files are rewritten to maintain
solution continuity in the selected frequency range. For details, see Restarting an HBM Analysis in
the Harmonic Balance Method Analysis Guide.

1.4.2. Multistage Cyclic Symmetry Supports Transient Thermal Analysis

Transient (ANTYPE, TRANS) thermal multistage cyclic symmetry analysis is now supported in addition
to the already supported multistage steady-state (ANTYPE, STATIC) thermal analyses. Models sup-
ported for these analyses have only temperature degrees of freedom (DOFs) active during the
solution. See Multistage Thermal Analysis in the Multistage Cyclic Symmetry Analysis Guide.

1.4.3. Joints with Cyclic Symmetry Linear Perturbation Harmonic Analyses

Cyclic symmetry linear perturbation harmonic analysis now supports the use of MPC184 joint ele-
ments in the model.

2. Multiphysics

Release 2026 R1 includes the following enhancements for analyses involving multiphysics environments:

2.1. Acoustics
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2.2.Thermal

2.3. Coupled-Field

2.1. Acoustics

The following enhancements for acoustic analysis are available in this release:

2.1.1. Aerodynamic Source Terms (Lighthill’s Analogy) in the Wave Equation

2.1.2. Perfectly Matched Layer (PML) for Axially Symmetric Elements in Transient Analysis

2.1.3. Logarithmic absorption function option for Perfectly Matched Layer (PML) and Irregular Perfectly
Matched Layer (IPML) acoustic elements

2.1.1. Aerodynamic Source Terms (Lighthill’s Analogy) in the Wave Equation

Aerodynamic sources defined in terms of the divergence of Lighthill’s tensor are now supported
for 3D acoustic fluid elements (FLUID30, FLUID220, and FLUID221) and 2D acoustic fluid elements
(FLUID243 and FLUID244) in harmonic acoustic analyses. With this new feature, you can use flow
sources obtained from Computational Fluid Dynamics (CFD) simulations to compute broadband
noise generated by turbulent flows. For details, see Lighthill’s Analogy for a Co-rotating Vortex Pair
and Aerodynamic Source (Divergence of Lighthill’s Tensor) in the Acoustic Analysis Guide.

2.1.2. Perfectly Matched Layer (PML) for Axially Symmetric Elements in Transient
Analysis

The 2D acoustic fluid elements, FLUID243 and FLUID244, now support the axisymmetric PML option
for transient acoustic simulations.

2.1.3. Logarithmic absorption function option for Perfectly Matched Layer (PML)
and Irregular Perfectly Matched Layer (IPML) acoustic elements

A new logarithmic absorption function option is available for acoustic PML and IPML elements. This
option enhances wave attenuation and minimizes reflections, particularly when the available radiation
space is limited. Compared to conventional polynomial absorption profiles, the logarithmic function
provides smoother impedance matching and improved accuracy in harmonic acoustic analyses. For
details, see the PMLOPT command description and Absorption function for IPML and PML in the
Theory Reference.

2.2. Thermal

The following enhancements for thermal analysis are available in this release:

2.2.1. New NMISC Values for Performing Energy Balance

2.2.2.View Factor Sums for Radiation Surface Facets

2.2.1. New NMISC Values for Performing Energy Balance

New element NMISC quantities have been added to the current technology thermal elements
(PLANE292, PLANE293, SOLID278, SOLID279, SOLID291, and SHELL294). Use them to easily perform
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an energy balance in postprocessing of a transient or steady-state thermal analysis. See element
descriptions for details.

2.2.2. View Factor Sums for Radiation Surface Facets

When using the radiosity solver for thermal radiation problems, the view factor sum for each surface
facet (SURF251 or SURF252) is now available (NMISC,11) to help you identify which radiation surfaces
are dominant and how they affect others. See the element descriptions for details.

2.3. Coupled-Field

The following enhancements are available for analyses involving coupled-field elements:

2.3.1. Expanded Capability of User-Programmable Features

2.3.2. SHELL229 Supports Structural-thermal and Structural-thermoelectric Analyses

2.3.3. Extended Support for Nonlocal Damage Formulation

2.3.1. Expanded Capability of User-Programmable Features

Newly supported analyses: User-programmable features (UPFs) for coupled-field elements
(PLANE222, PLANE223, SOLID225, SOLID226, and SOLID227) support more analyses, including
structural-thermal, thermal-electric, structural-thermal-electric, and piezoelectric. You can now cus-
tomize material models, loads, constitutive equations, element matrices, and element results in the
above analyses.

New Customizable Quantities: The scope of customizable quantities has been extended to include
diffusion strain, dielectric permittivity, electric flux density, complex stiffness and mass matrices,
complex load vector, and state variables shared with UserMat and UserMatTh subroutines.

Additional utility functions: New utility functions have been added to conveniently access nodal
and element results during element customization. Examples include velocities, accelerations,
complex displacements, element principal and equivalent strains and stresses, as well as strain and
stress intensity.

2.3.2. SHELL229 Supports Structural-thermal and Structural-thermoelectric
Analyses

SHELL229 is a current-technology shell element with coupled-field capabilities that previously
supported thermo-electric analysis. It now supports structural-thermal and structural-thermoelectric
analyses as well. The element has up to 8 degrees of freedom at each node, including temperature
and voltage in membrane format, as well as 3D translation and rotation for structural analysis. See
VM174 and VM223 in the Ansys Mechanical APDL Verification Manual.

2.3.3. Extended Support for Nonlocal Damage Formulation

Nonlocal damage formulation is now enabled for PLANE223 for structural–thermal, structural–diffu-
sion, and structural–thermal–diffusion analyses. SOLID226 and SOLID227 elements have been updated
to support nonlocal damage when using the mixed u-P formulation (KEYOPT(11) = 1). These en-
hancements enable use of generalized fatigue damage (implicit gradient regularization) to better
capture the distributed nature of damage in real materials by averaging variables over a finite
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neighborhood using a characteristic length scale. This leads to more objective and reliable simulation
results and improved convergence stability. Also, results no longer spuriously depend on mesh size,
especially when material softening or strain localization occurs.

3. Solvers

Release 2026 R1 includes the following improvements to the solution process:

3.1. Resource Prediction Feature

3.2. PCG Block Lanczos Eigensolver

3.3. PCG Solver Enhancements

3.1. Resource Prediction Feature

The new PREA command introduces resource prediction, a feature that estimates computational re-
source requirements before solving. This helps identify the optimal hardware environment for simu-
lations.

By analyzing the current load step, analysis type, solver type, and core count, PREA provides estimates
for:

• Solution elapsed time

• Total memory usage

• Total disk space usage

• GPU recommendation

These predictions support distributed-memory parallel (DMP) solutions and assist with performance
and resource allocation. While predictions offer valuable guidance, they do not guarantee solution
success or solver convergence.

3.2. PCG Block Lanczos Eigensolver

The preconditioned conjugate gradient (PCG) Block Lanczos eigensolver is now officially released.

This eigensolver is a variant of the Block Lanczos method designed for large symmetric eigenvalue
problems in modal analyses. It uses the same automated shift strategy as the standard Block Lanczos
method but adds PCG iterative solver technology alongside the existing sparse direct solver.

To use this eigensolver, combine the Block Lanczos method (MODOPT,LANB) with the PCG solver
(EQSLV,PCG). This combination automatically activates the new eigensolver, which improves perform-
ance and memory efficiency.

For more information, see the MODOPT and EQSLV commands.

3.3. PCG Solver Enhancements

The PCG solver requires less memory than in previous releases to solve models when:
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• Running on higher core counts (more than 64 cores).

• Constraint equations and/or coupling equations exist in the model.

4. High-Performance Computing

Release 2026 R1 includes the following improvements to high-performance computing (HPC):

4.1. Distributed-Memory Parallel Processing Enhancements

4.2. GPU Acceleration Feature: New Support and Updates

4.3. Recommended Devices for the GPU Accelerator: New and Updated GPUs

4.1. Distributed-Memory Parallel Processing Enhancements

Enhancements include:

• The default support for message passing interface (MPI) software has been updated to Intel
MPI 2021.16.1 for both Linux and Windows. Previously, the default was Intel MPI 2021.14.2.

• When using AMD processors, the default support for message passing interface (MPI) software
has been updated to Open MPI 4.1.8. Previously, the default was Open MPI 4.0.5.

4.2. GPU Acceleration Feature: New Support and Updates

New Support

• Windows now supports ROCm libraries version 6.4.2.

Updates

• For Linux, the ROCm libraries have been updated to 7.0.2. The previous release used version 6.3.3.

• For Windows and Linux, the CUDA libraries have been updated to 13.0.2. The previous release used
version 12.8.

• The recommended GPU cards table now includes detailed specifications on performance metrics,
memory size, and bandwidth.

Performance Improvements

• The performance of the PCG solver has improved with GPU acceleration, as the Mechanical APDL
application now dynamically offloads as many equation solver calculations as possible onto the
GPU. This enables the solver iterations to run entirely on the GPU with minimal CPU communication.

For more information on GPU cards and their updates, see Requirements for the GPU Accelerator in
the Mechanical APDL Application (Linux) and Requirements for the GPU Accelerator in the Mechanical
APDL Application in the Ansys, Inc. Installation Guides (Windows).

4.3. Recommended Devices for the GPU Accelerator: New and Updated GPUs

New Feature
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• The Mechanical APDL application now supports GPU acceleration on Windows for AMD GPUs.

Added Cards

The following cards have been tested and added to the list of recommended GPU devices for the
GPU accelerator:

• Windows:

– AMD Radeon AI PRO R9700

– AMD Ryzen AI Max+ PRO 395

– AMD Ryzen AI Max+ 395

– AMD Radeon PRO W7900

– NVIDIA GeForce RTX 5090

– NVIDIA GeForce RTX 5080

– NVIDIA GeForce RTX 5070 Ti

• Linux:

– AMD Instinct MI355X

– NVIDIA GeForce RTX 5090

– NVIDIA GeForce RTX 5080

– NVIDIA GeForce RTX 5070 Ti

For the complete list of recommended GPU accelerators, see Requirements for the GPU Accelerator
in the Mechanical APDL Application (Windows) and Requirements for the GPU Accelerator in the
Mechanical APDL Application in the Ansys, Inc. Installation Guides (Linux).

5. Other Enhancements

The following other enhancements have been added:

5.1. Compiler Update for User-Programmable Features on Linux Systems

5.2. New Coded Database File Command

5.3. Modified Coded Database File Command

5.4. Expanded Element Face Component Creation Options

5.1. Compiler Update for User-Programmable Features on Linux Systems

The supported GNU GCC compiler for user-programmable features has been updated to version
12.3.0. The previous release used version 8.2.0.

For more information, see Compiler Requirements for Linux Systems in the Ansys, Inc. Installation
Guides and Compiling and Linking UPFs on Linux Systems in the Programmer's Reference.
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5.2. New Coded Database File Command

The following new coded database (CDB) file command is available:

• NSMBLOCK – Defines data for the non-structural mass of elements computed by the NSMASS
command.

5.3. Modified Coded Database File Command

The following CDB file command has been enhanced or otherwise modified:

• /BLOCK – Signals the start and end of block input. The previous Control option has been replaced
by two parameters—Parm1 and Parm2—to support more efficient handling of element blocks.

5.4. Expanded Element Face Component Creation Options

You can now construct element face (EFACE) components using:

• Named element (ELEM) components defined with the CM, CMBLOCK, or EBLOCK (with the
APPCM agrument) commands.

• Assemblies of ELEM components, including up to three levels of nested assemblies.

When using component names or assemblies to create EFACE components, compact notation is not
supported.

6. Commands

This section describes changes to commands at Release 2026 R1:

6.1. New Commands

6.2. Modified Commands

6.3. Undocumented Commands

Some commands are inaccessible from menus and are available via the command-input field or batch-
file input only. The documentation for each command indicates menu path information, if available.

6.1. New Commands

The following commands are new for this release.

• FGRAD – Directs the solver to include the effects of field-dependent gradients in the solution.

• PREA – Activates resource prediction for supported analysis and solver types.

• WKSP – Automatically adds weak springs at the nodes of degrees of freedom with small or near-
zero pivots during solution.
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6.2. Modified Commands

The following commands have been enhanced or otherwise modified:

• AMENV – Specifies the build-environment thermal boundary conditions in an additive manufacturing
(AM) analysis. New options (RADOPT, EMIS, and SBC) enable you to define radiation boundary
conditions in a powder bed fusion (PBF) simulation.

• BF – Defines a nodal body-force load. A new DIVT label type enables the use of the divergence of
Lighthill’s tensor as a body-force excitation source.

• CNCHECK – Provides and/or adjusts the initial status of contact pairs. Use the new label MPC for
InterType when Option = MERGE (CNCHECK,MERGE,,,,MPC) to merge MPC bonded contact
pairs that share the same nodes or elements.

• CUTCONTROL – Controls time-step cutback during a nonlinear solution. Use the new label CONT
for Value to limit the substep incremental displacement based on the minimum pinball radius of
all open contact pairs and help ensure accurate contact detection.

• EMSEL – Specifies conditions for selecting reinforcing members or shell layers. The pre-processing
and post-processing commands (PLESOL, PLNSOL, PRESOL, PRNSOL, ETABLE and EPLOT) now
support selected layered results for shell sections and elements (SHELL181 and SHELL281).

• *GET – Retrieves a value and stores it as a scalar parameter or part of an array parameter. Use the
new preprocessing data type output (IT1NUM = BSTF when Entity = SHEL) to retrieve the bending
stiffness scale factor.

• MONITOR – Controls contents of variable fields in the nonlinear solution monitor file. An additional
field has been inserted between variable fields 1 (VARIAB 1) and 2 (VARIAB 2) to report current
memory usage (in GB) at each converged substep. For more information, see Change in Format of
Nonlinear Solution Monitor File (.mntr) (p. 74).

• NLADAPTIVE – Defines the criteria under which the mesh is refined or modified during a nonlinear
solution. For Option = ESTN and Option = PSTN:

– VAL3 is now used as a flag for variant of void creation.

– VAL6 is now unused.

• NLHIST – Specify results items to track during solution. Smart stop criterion now includes an op-
tional stop tolerance (STOP_TOL) that automatically stops the solution when a tracked variable is
within the specified percentage tolerance of the desired value (STOP_VALUE). STOP_TOL defaults
to 0.025 (2.5%).

• NLMESH – Controls remeshing in nonlinear adaptivity. Use the new Control option, VBND, to
include or exclude loaded boundary elements for void creation in multiple voids per substep variant
(NLADAPTIVE,,,REMMAT). The new Control option, ISLD, allows you to remove all orphaned
elements or element patches (islands) after an element removal operation (NLADAPTIVE,,,REMELM).

• PMLOPT – Defines perfectly matched layers (PMLs) or irregular perfectly matched layers (IPML). A
Logarithmic absorption function is now supported in addition to the polynomial one. To select the
logarithmic function, which is recommended for analyses with a radiation space that is less than
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one wavelength, specify the new NF option for WOptXm, WOptXp, WOptYm, WOptYp, WOptZm,
WOptZp as desired on the PMLOPT command.

• PIVCHECK – Controls the behavior of an analysis when a negative or zero equation solver pivot
value is encountered. The existing Key = AUTO option now prints the list of pivot values along
with their corresponding degrees of freedom, in addition to the error or warning message.

• SECMODIF – Modifies section properties based on the keyword. You can now modify the properties
of shell, beam, pipe, link, and reinforcing sections. Selected layer modification is also supported for
shell sections using the EMSEL command.

• SOLVE – Starts a solution. A new option, SOLVE,ELFORM,,REFORM, has been added to trigger
multiple load steps in linear perturbation modal analysis using SOLID272 and SOLID273.

• TB – Activates a data table for linear and nonlinear material properties or special element input.

– Poisson’s ratio for automatic fitting is now supported using TB,EXPE with TBOPT = POIS.

– Damage cap for regularized generalized damage approach is now supported using TB,CDM
with TBOPT = DCAP.

– The inelastic dissipation rate fraction and latent heat coefficients are now supported using
TB,THERM with TBOPT = DISS and TBOPT = LATH, respectively.

• TBFT – Performs material curve-fitting operations. Use the new option, Oper = AFIT, to automatically
read and fit experimental data from TB,EXPE and save material model to the TB command format.
Use the new option, Oper = AFPAR, to enable or disable diagnostics during the automatic fitting
process.

6.3. Undocumented Commands

No commands have been undocumented this release.

For information about commands that have been undocumented in prior releases, see the archived
release notes for Mechanical APDL.

7. Elements

This section describes changes to elements at Release 2026 R1:

7.1. New Elements

7.2. Modified Elements

7.3. Undocumented Elements

Some elements are not available from within the GUI. For a list of those elements, see GUI-Inaccessible
Elements.

7.1. New Elements

There are no new elements this release.
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7.2. Modified Elements

The following elements have been enhanced:

• PLANE222, PLANE223, SOLID225, SOLID226, SOLID227 - these elements now support user-program-
mable features (KEYOPT(12) = 1) with structural-thermal, thermal-electric, structural-thermoelectric,
and piezoelectric analyses.

• INTER194 and INTER195 – In combination with a user-defined thickness (KEYOPT(7) = 1) and the
thin-solid option (KEYOPT(2) = 2 or 3), a new algorithm is used for updating the user-defined
thickness in geometric nonlinear analyses (NLGEOM ,ON). The new algorithm improves the non-
linear solution robustness and the accuracy of element results.

• SHELL229 – This current-technology shell element with coupled-field capabilities now supports
structural-thermal and structural-thermoelectric analyses.

• SOLID272 and SOLID273 (KEYOPT(2) = 1 and MODE) – The mono harmonic option is now supported
in linear perturbation modal analyses.

– Subsequent modal analyses now support the MODE command, enabling the analysis of
higher-frequency modes within a linear perturbation modal analysis.

– Multiple load steps with MODE number changes are now supported in subsequent modal
analyses.

– Expanded 3D plots of mode shapes are now supported using KEYOPT(3) = 1 and /ESHAPE,1.

• SOLID272 and SOLID273 (KEYOPT(2) = 1) – The out-of-plane contact behavior is now supported
using a 3D contact pair: CONTA175 and TARGE170.

• SURF159 – This general axisymmetric surface element now supports the mono harmonic option of
SOLID272 and SOLID273 (KEYOPT(2) = 1) using the MODE command.

• SURF251 and SURF252 – These radiosity surface elements now output the view factor sum via
NMISC,11. You can use the view factor sum for each surface facet to identify the dominant radiation
surfaces and evaluate how they affect others.

• PLANE292, PLANE293, SOLID278, SOLID279, SOLID291, SHELL294 – New element quantities (NMISC)
useful for performing an energy balance at each substep are available. They provide the element
quantity of each term in the energy balance equation. For each converged substep in /POST1, you
can read these element quantities using the ETABLE command and sum them via the SSUM
command to give the overall contributions for all elements in the model.

• PLANE183, PLANE223 – These elements now support the use of generalized fatigue damage (implicit
gradient regularization), which better captures the distributed nature of damage in real materials.
This leads to the following key benefits: objective and reliable results, mesh insensitivity (especially
when material softening or strain localization occurs), and improved convergence stability.

• SOLID186, SOLID187, SOLID226, SOLID227 – These elements now support the use of generalized
fatigue damage (implicit gradient regularization) when using the mixed u-P formulation (KEYOPT(11)
= 1). The use of generalized damage can better capture the distributed nature of damage in real
materials.
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• SOLID186 – This element type now supports single-value results. For more information, see Solution
Output in the Element Reference.

7.3. Undocumented Elements

No elements have been undocumented this release.

For information about elements that have been undocumented in prior releases, see the archived
release notes for Mechanical APDL.

8. Documentation

Ansys continues to refine the Mechanical APDL documentation set. To that end, the following notable
changes and enhancements to the documentation have occurred:

8.1. Cyclic Symmetry Documentation Examples

The cyclic symmetry example problems were updated to improve readability and ease of use (see
Example Cyclic Symmetry Analyses in the Cyclic Symmetry Analysis Guide).

8.2. Updates for Programmers

Routines and functions documented in the Programmer's Reference have been updated to reflect the
current source code. To see specific changes in a file, Ansys recommends opening both the old and
current files (using a text editor that displays line numbers), then comparing the two to determine
which lines have changed. You can copy the updated files to your system by performing a custom
installation of the product.

8.3. Feature Archive

Legacy features, commands, elements, and theory information continue to move to the Feature Archive.
While Ansys intends to support legacy capabilities for the immediate future, some may be undocu-
mented in future releases. Consider moving to their recommended replacements. For information
about especially notable features that have been archived, see Features Removed or Archived (p. 77)
in the Update Guide section of this document.

9. Technology Showcase: Example Problems

The analyses presented in the Technology Showcase: Example Problems demonstrate the extraordinarily
broad simulation capabilities of Ansys Mechanical APDL. The real-world problems highlight the features
and effectiveness of Mechanical APDL by presenting a series of analyses from a variety of engineering
disciplines.

The problems are more substantive and complex than examples found in the standard documentation
set. The documentation thoroughly examines the physics involved with each problem and the consid-
erations necessary for translating problems into numerical models. Approximation issues, accuracy
considerations, and recommended practices are discussed. For more information, see What You Need
to Know.
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There are no new example problems this release.

Many of the Mechanical APDL Technology Showcase problems can also be performed entirely within
the Mechanical Application. For more information, see the Mechanical Technology Showcase: Example
Problems in the Mechanical Technology Showcase: Example Problems.

10. Mechanical APDL Release 2026 R1 Update Guide

This section contains information about feature enhancements that can affect program behavior or
analysis results in ways that you may not expect. Also covered are known incompatibilities, notable issues
and defects that have been resolved, and information about replacement capabilities for features that
have been removed.

The following topics offer supplemental 2026 R1 product-update information presented by the Mech-
anical APDL development and testing teams:

10.1. Backward Compatibility

10.2. Feature Updates Causing Result or Behavior Changes

10.3. Known Incompatibilities

10.4. Known Issues

10.5. Resolved Issues and Defects

10.6. Features Removed or Archived

If you are upgrading across several releases, you may find it helpful to consult the Update Guide sections
of the archived release notes for Mechanical APDL.

For information about past, present, and future operating system support, see the Platform Support
section of the Ansys Website.

10.1. Backward Compatibility

Mechanical APDL Release 2026 R1 can read database files from all prior Mechanical APDL releases.
Due to ongoing product improvements and defect resolutions, however, results obtained from old
databases running in new releases may differ somewhat from those obtained previously.

10.2. Feature Updates Causing Result or Behavior Changes

The following Mechanical APDL feature updates in Release 2026 R1 are known to produce program
behaviors or analysis results that differ from those of the prior release:

10.2.1. Change in .ldhi Files

10.2.2. Changes in Automatic Hybrid Parallel

10.2.3. Change in Internal Multipoint Constraint (MPC) Reporting in .ldhi and .cnd Files

10.2.4. Moment Convergence Check at Pilot Node of Target Elements with Rotational DOFs

10.2.5. Harmonic Balance Method Uses Sparse Solver by Default

10.2.6. Output Displays Elapsed Time

10.2.7. Change in Format of Nonlinear Solution Monitor File (.mntr)

10.2.8. Restart Mechanism Improves Conjugate Gradient (CG) Solver Robustness
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10.2.9. Change in Preconditioned Conjugate Gradient (PCG) Lanczos Eigensolver

10.2.10. Output behavior of mapdl.run in a *PYTHON block

10.2.11. Change in Impedance Sheet Formulation for Acoustic Analysis

10.2.12. Change in Default for Ansys Product Improvement Program (APIP)

10.2.13. Change in Behavior Due to Backstress Scaling in the Chaboche Model for Non-Isothermal Loading

10.2.1. Change in .ldhi Files

The Mechanical APDL application no longer writes duplicated tabular load data across load steps
to *.ldhi files when the data remains unchanged. This reduces file size and improves efficiency.
During restarts, the application reads the necessary data from the *.rdb file, ensuring continuity
without requiring repeated table entries. In previous releases, duplicated tables were written to
*.ldhi files in every load step.

10.2.2. Changes in Automatic Hybrid Parallel

The automatic hybrid parallel feature, also known as auto-hybrid, now prevents hardware oversub-
scription on large clusters that previously degraded performance. The following behavior changes
are included:

Single-node runs at low core counts

Auto-hybrid now applies threads only to large domains when reducing core counts (for example,
-np 12 becomes -np 4 with 8 threads). This change may alter the solution printout compared
to previous releases. Previously, threads were distributed evenly across all domains, regardless of
size.

Multi-node runs

Auto-hybrid activates only when all compute nodes have the same number of CPU cores (homo-
geneous configuration). Therefore, the number of domains and threads determined by auto-hybrid
parallel heuristics may differ from previous releases. This change helps prevent hardware oversub-
scription and associated performance decline.

Oversubscription protection

A final configuration check now runs before execution. If oversubscription is detected, the program
issues a fatal error and stops the run. To proceed, rerun the solution with the -nt 1 command-
line argument, which disables the auto-hybrid feature. Previously, no such check existed, and
oversubscription could lead to poor performance or instability.

Restart and downstream analysis behavior

When restarting or continuing an analysis, auto-hybrid restores the previous configuration of pro-
cesses and threads. If a downstream analysis launches with more processes than the upstream
analysis, auto-hybrid reduces the number of active processes to match the upstream configuration.

For example:

• Upstream modal analysis runs with -np 4.
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• Downstream harmonic analysis launches with -np 8.

In previous releases, the harmonic analysis would reduce to -np 2 -nt 2. In Release 2026 R1,
the harmonic analysis reduces to -np 2 and does not activate additional threads (-nt 1).

Recommendation: Launch downstream analyses with the same or fewer processes than the upstream
analysis to avoid unexpected reductions.

10.2.3. Change in Internal Multipoint Constraint (MPC) Reporting in .ldhi and
.cnd Files

MPC (KEYOPT(2) = 2) bonded (KEYOPT(12) =5 or 6) contact excluding initial geometrical penetration
or gap and offset (KEYOPT(9) = 1) no longer reports PENE, GAP, and SLIDE in the element nodal
solution, *.ldhi and *.cnd files.

10.2.4. Moment Convergence Check at Pilot Node of Target Elements with Rota-
tional DOFs

Moment convergence is now checked at the pilot node of TARGE170 when target elements have
rotational degrees of freedom (DOFs), improving accuracy. Previously, this check at the pilot nodes
was ignored if there were no structural elements with rotational DOFs in the model.

10.2.5. Harmonic Balance Method Uses Sparse Solver by Default

The sparse solver is now used by default in harmonic balance method (HBM) analyses. This change
is expected to improve overall performance, particularly for systems with many degrees of freedom.
While the solver may introduce slight numerical differences in results, these are generally negligible
and should not affect the accuracy or reliability of the analysis.

10.2.6. Output Displays Elapsed Time

Output messages now report the elapsed time (wall clock time) since the start of the program,
instead of CPU time. This change provides a more accurate and relevant measure of total runtime.
It accounts for all delays, including those outside CPU execution, and avoids confusion caused by
thread-level CPU time aggregation.

Example output:

***** ROUTINE COMPLETED *****  ELAPSED TIME =        3.461 
*** NOTE ***                   ELAPSED TIME =       12.982   TIME= 08:00:00 
*** WARNING ***                ELAPSED TIME =       11.432   TIME= 09:00:00
*** WARNING ***                ELAPSED TIME =       65.347   TIME= 10:00:00

In previous releases, the output used the label CP to indicate CPU time. It measured only the time
the processor spent executing instructions, excluding time spent on I/O operations, network delays,
GPU acceleration, and other non-CPU activities. Additionally, in shared memory parallel (SMP) mode,
CPU time was summed across all threads and cores. This could result in misleadingly high values,
making it appear that certain simulation steps took longer than they did.
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10.2.7. Change in Format of Nonlinear Solution Monitor File (.mntr)

The nonlinear solution monitor file (*.mntr) now includes an additional field between variable
fields 1 (VARIAB 1) and 2 (VARIAB 2). This new field reports current memory usage (in GB) at
each converged substep, enabling better tracking of memory consumption during nonlinear ana-
lysis.

In previous releases, the *.mntr file contained variable fields 1 through 4. With this change, fields
2 through 4 have shifted to become variable fields 3 through 5.

For more information, see MONITOR.

10.2.8. Restart Mechanism Improves Conjugate Gradient (CG) Solver Robustness

This release introduces a restart mechanism for all CG drivers to improve solver reliability. The en-
hancement may improve solutions for models that previously converged slowly (below 1.0E-6) or
failed to converge. Some test cases may show a slight increase in iteration counts due to the addi-
tional cycle.

When the restart mechanism is triggered, the solver performs an extra cycle of iterations. This
second cycle starts from the most accurate solution found in the first cycle. Both cycles use the
same maximum number of iterations.

Additional behavior changes includes:

• For linear systems with low condition number estimates and relaxed solver tolerances, the
CG algorithm locally reduces the maximum number of iterations per cycle.

• During the first cycle, if the solution diverges or approaches within three orders of magnitude
of the requested tolerance, the solver aborts the cycle and starts a new one.

In previous releases, when the solver reached the maximum number of iterations without meeting
the tolerance, it would error out without completing the solution.

For more information, see Conjugate Gradient (CG) Solvers in the Basic Analysis Guide.

10.2.9. Change in Preconditioned Conjugate Gradient (PCG) Lanczos Eigensolver

The PCG Lanczos eigensolver now uses a single stopping criterion for its internal conjugate gradient
(CG) solvers. This criterion is based on the exact norm of the error and is expected to improve result
accuracy. Some test cases might show a slight increase in the number of iterations.

In previous releases, internal CG solvers used multiple stopping criteria and stopped iterating when
any one was met. Some of these criteria relied on approximate error norms.

for more information, see Conjugate Gradient (CG) Solvers in the Theory Reference.

10.2.10. Output behavior of mapdl.run in a *PYTHON block

Within a *PYTHON block, issuing mapdl.run(...), no longer displays output by default. Instead,
it returns a string that can be printed by issuing print(mapdl.run(...)). To restore the pre-
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vious behavior of automatically printing all output, set the environment variable MAPDL_PY-
THON_WRITE_OUTPUT.

10.2.11. Change in Impedance Sheet Formulation for Acoustic Analysis

The updated impedance sheet formulation provides physically consistent behavior for low, matched,
and high impedance values. When the sheet impedance is much lower than the characteristic im-
pedance of the fluid ( ), the surface behaves as a soft or limp sheet, allowing pressure re-
lease. When the sheet impedance equals the characteristic impedance of the fluid ( ), the
sheet behaves as an almost perfectly transparent interface, producing negligible reflection and al-
lowing the acoustic field to propagate as if no internal surface exists. When the sheet impedance
is much larger than the fluid characteristic impedance ( ), the sheet behaves as a rigid
interface, strongly restricting normal velocity and introducing significant reflection. For details, see
Impedance Sheet Approximation in the Theory Reference and Impedance Sheet in the Acoustic
Analysis Guide.

10.2.12. Change in Default for Ansys Product Improvement Program (APIP)

The Ansys Product Improvement Program (APIP) now automatically enrolls participants. In previous
releases, enrollment was off by default and required manual opt-in. You can opt out at any time
by following the steps described here: The Ansys Product Improvement Program in the Operations
Guide.

10.2.13. Change in Behavior Due to Backstress Scaling in the Chaboche Model
for Non-Isothermal Loading

For non-isothermal loading, the backstress is now scaled differently. It uses only material parameter
C in the nonlinear kinematic hardening model, resulting in changes to stress and strain behavior.
In previous releases, non-physical results were observed, such as negative values for plastic work
per volume.

10.3. Known Incompatibilities

The following incompatibilities with prior releases are known to exist at Release 2026 R1:

• The force-distributed surface constraint cannot be applied to a single surface node. Instead,
use a rigid surface constraint.

• For the exponential pressure-penetration relationship (KEYOPT(6) = 3 on contact elements),
calculation of the default value of real constant PZER has been revised to make it more robust
and accurate.

10.4. Known Issues

The following issues are known to exist at Release 2026 R1:

• Linear Perturbation Analysis Limitation – The total tangent stiffness matrix obtained from a
Linear Perturbation basis analysis may include stress stiffness and load stiffness contributions
(geometric stiffness). If the geometric stiffness contribution is significant, then the total tangent
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stiffness matrix, when used in a Linear Perturbation downstream analysis, may produce reaction
forces not satisfying the equilibrium with the external forces.

• Importing ACIS and CATIA Files – Check models carefully after importing from ACIS and CATIA
as the third party libraries supporting these commands have changed.

• GPU Acceleration Hangs on AMD Cards with Small Models – When running certain small models
with the GPU accelerator enabled on AMD cards, specifically using three or more processes, the
program may run very slowly and appear to hang.

Workaround: To avoid this issue, create the following environment variable:

GPU_MAX_HW_QUEUES=2

• On Windows, CRTL+C May Not Terminate All Related Child Processes – Using CRTL+C to ter-
minate a distributed-memory parallel processing (-dis) run on Windows may leave child processes
running.

Workaround: To guarantee a complete shutdown, use the /EXIT command. If you must use CRTL+C,
you may need to manually remove remaining child processes using Windows task manager.

• Downstream Analysis Using Frequency Domain Decomposition May Crash After Hybrid Parallel
Use – A downstream analysis that uses frequency domain decomposition may crash if the upstream
analysis was run with hybrid parallel enabled. For example, if the upstream analysis runs with -np
4 -nt 2 and the downstream analysis runs with -np 8, the downstream analysis may crash
when the hybrid parallel configuration is restored.

Workaround: To avoid the downstream crash, use one of the following methods:

– Match the upstream parallel configuration: Launch the downstream analysis with the
same number of processes (-np) and threads (-nt) used in the upstream analysis. Use this
method when the upstream analysis explicitly used hybrid parallel.

– Disable hybrid parallel: Launch the downstream analysis with -nt 1 to disable hybrid
parallel. Use this method when the upstream analysis omitted -nt and automatic hybrid
parallel was applied.

• Possible Stress Calculation Failures in Nonlinear Adaptivity Analyses with TNM and Bergstrom-
Boyce (BB) Material Models – Certain shear-dominant high deformation scenarios with the TNM
or BB material models in a nonlinear adaptivity analysis can cause stress calculation failures after
remeshing.

For issues discovered following publication of this document, see Mechanical APDL in the Ansys Known
Issues and Limitations.

10.5. Resolved Issues and Defects

The following notable issues and defects for Mechanical APDL have been resolved at Release 2026
R1:
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Resolution DescriptionID

The automatic hybrid parallel feature no longer oversubscribes hardware on large
clusters starting in Service Pack 2025 R2 SP02. This resolves the performance

1167416

decline observed in the previous release. For more information, see Changes in
Automatic Hybrid Parallel (p. 72).

Automatic initialization in curve fitting for hyperelastic models with Prony series
viscoelasticity no longer requires prior installation of the latest Anysys Material
Lab (AML) Python module.

The issue that caused crashes on SUSE Linux Enterprise Server 15 machines has
been resolved.

1188443

The performance decline that occurred when running AMD processors on Linux
in Release 2025 R2 has been fixed.

1312569

The issue that caused crashes in DMP mode with Intel MPI and NVIDIA GPUs on
Linux when running more than 50 number of processes has been fixed.

1370069

10.6. Features Removed or Archived

If a legacy Mechanical APDL feature has been removed at Release 2026 R1, this section provides in-
formation about the Mechanical APDL replacement feature, its functional equivalent in another Ansys
product, or another workaround.

Legacy features that have been archived also appear here. While archived features remain available
for use, technical enhancement is unlikely to occur, and better alternatives are available and recom-
mended in most cases.

10.6.1. Undocumented Real Constant and Keyoption for Contact Elements

For the contact elements, CONTA172, CONTA174, CONTA175, CONTA177, the following has been
undocumented:

• The real constant ICONT (initial contact closure)

• KEYOPT(5)=4 (auto ICONT)

Instead, use the real constant CNOF and CNCHECK, ADJUST.

10.6.2. Connection Commands

The following connection commands used to import early versions of CATIA (V4 and earlier) or ACIS
files into Mechanical APDL have been archived and are considered obsolete. Instead, use one of
the other products like the Mechanical application or Discovery or use one of the CAD/CAE packages
supported in Mechanical APDL (see Introduction to the Connection Functionality in the Connection
User's Guide).

~CATIAIN - Transfers a CATIA v4 or earlier model into the Mechanical APDL program.

~SATIN - Transfers a .sat file into the Mechanical APDL program.
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Autodyn Release Notes
The Ansys Autodyn product encompasses all of the following explicit solvers: FE (Lagrange), Euler, FCT,
ALE, and SPH, and various means to couple them together. All are integrated into the Autodyn Com-
ponent system, while the FE (Lagrange) and Euler—including Euler-Lagrange coupling—are also integ-
rated into the Explicit Dynamics Analysis system.

1. New Features and Enhancements

1. New Features and Enhancements

The following enhancements were made for Ansys Release 2026 R1:

• Compiler Update for User-Programmable Features on Linux Systems. The supported GNU
GCC compiler for user-programmable features has been updated to version 12.3.0. For more in-
formation, see Compiler Requirements for Linux Systems in the Ansys, Inc. Installation Guides and
Compilers Required to Work with User Subroutines.
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Aqwa Release Notes
This release of the Aqwa related products contains all capabilities from previous releases. The following
enhancements are available in release 2026 R1. Refer to the product-specific documentation for full
details of the new features.

1. Aqwa Solver Modules

2. Aqwa Graphical Supervisor (AGS)

3. Hydrodynamic Analysis Systems

1. Aqwa Solver Modules

The following new features provide extended capabilities in the Aqwa solver modules:

• Drum Winch for Nonlinear Polynomial Cables. You can define a drum winch on a nonlinear poly-
nomial cable using the DW10, DWAL, LNDW or NLDW data records.

• Increased Limit for Number of Elements. The 64-bit version of Aqwa can accept up to 60,000 ele-
ments, of which 30,000 can be diffracting.

• Maneuvering Force/Moment for Aqwa-Drift. You can now use the MNVR run-time option for all
time response analysis types to request calculation of low frequency maneuvering loads.

• Mean Drift Force Coefficient Correction. The mean wave drift coefficient now includes current in-
teraction and viscous effects in accordance with DNV guidance (DNVGL-OS-E301, Position mooring).

• Radiation Force with Hot Start. When running a hot start analysis, the motion response at the time
steps prior to the hot start time are used in the convolution integral for the radiation force calculation.

• Ship Position/Course Control. You can define horizontal motion PID controllers in an Aqwa solver
time domain analysis. This can be used to retain the travelling course or maintain a horizontal position
of a structure.

• Warped Elements Check. The solver checks that nodes of a diffraction quadrilateral panel are in a
flat plane.

2. Aqwa Graphical Supervisor (AGS)

There are no new features in the Aqwa Graphical Supervisor.

3. Hydrodynamic Analysis Systems

The following new features provide extended capabilities in the Hydrodynamic systems in Workbench:
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• Automatic Creation of Internal Lid Elements. Internal lid elements are automatically generated
for the analysis by default. This is controlled by the Generate Internal Lid option.

• Display of Disc Normal Vector. When a Disc element is defined, the unit normal vector is shown
in the Details panel.

• Drum Winch for Nonlinear Polynomial Cables. You can define a Cable Winch on a nonlinear
polynomial cable.

• Dynamic Control Object. You can use the new Dynamic Control object to control the motion
of a structure, allowing it to move along a specified course or toward a given position or heading.

• Failure Time of Intermediate Buoy or Clump Weight. In the Connection Failure object, you
can set the Failure Time of an intermediate buoy or clump weight in a Time Domain Hydro-
dynamic Response analysis by selecting the required Catenary Joint for the Failing Connection
property.

• Froude Number Warning for Forward Speed. When a Forward Speed is defined in the Hydro-
dynamic Diffraction analysis, a warning message occurs when the estimated Froude number
exceeds 0.3.

• Increased Limit for Number of Elements. The 64-bit version of Aqwa can now accept up to
60,000 elements, of which 30,000 can be diffracting.

• Maneuvering Force/Moment for Time Domain Hydrodynamic Response Including Drift. You
can now use the Include Maneuvering Force analysis setting for all time response analysis types
to request calculation of low frequency maneuvering loads. See the MNVR solver input.

• Multiple MCOL File Generation. The MCOL Hydrodynamic Database analysis setting allows
you to generate multiple hydrodynamic databases based on varying structure positions and
orientations by using the template run script file, WorkbenchScript.py, included in the
standard Windows installation of Aqwa.

• Parametric studies with pressure mapping. Ansys optiSLang provides a powerful simulation
workflow environment for parameter sensitivity analysis, optimization, and robustness evaluation.
For parametric studies involving pressure mapping from a Hydrodynamic system to a Static
Structural analysis, optiSLang can perform some additional background steps that are required
in the design point update process. optiSLang also delivers more detailed post-processing in
parametric response and sensitivity.

• Pretension Value Definition for Fenders and Cables. A pretension value can be defined for
fenders and all cable types. When the cable pretension value is set directly, the related Unstreched
Length or Length value automatically updates. The cable pretension property is Initial Tension
for Linear Elastic, Nonlinear Polynomial, and Nonlinear Steel Wire cables, and Cable Pretension
for Nonlinear Catenary cables. For fenders, an Initial Elastic Force can be defined. Similarly, if this
value is set directly, the fender Size value automatically updates.

• Structure Center of Gravity for Starting Conditions. The Hydrodynamic Response Starting
Conditions object now allows the Reference Point to be set to Structure Center of Gravity.

• Upgrade to OpenFAST 4.0.0. The version of AeroDyn and InflowWind included in the Ansys
installation has been upgraded from OpenFAST version 3.0.0 to 4.0.0. For more information, refer
to OpenFAST User Documentation, OpenFAST release notes and API changes between versions.
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It is important to consider the configuration differences when preparing AeroDyn input files and
InflowWind input files for 4.0.0.

• Watch Zone Improvement. The Aqwa editor, where the defined Watch Zones are rendered,
and the window that displays the Binding Selection and Statistic Results are now synchronized.
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Ansys Composite Prep (ACP) Release Notes
This release of the Ansys Composite Prep™ (ACP) layered composite modeling and preprocessing software
contains all capabilities from previous releases. The following sections present the new features, en-
hancements, and known limitations for the ACP application in Release 2026 R1.

1. New Features and Enhancements

2. Known Limitations

1. New Features and Enhancements

The ACP application includes new features and enhancements at Release 2026 R1 in the following areas:

1.1. Interface to the Ansys LS-DYNA™ Application

1.2. Solid Composite Model with Reinforcing Elements

1.3. Performance Improvements

1.4. Split Modeling Ply into Production Materials

1.5. End of Support for .acp Serialization Format

1.6. Sampling Point for Solid Models

1.7. Improved Search Widget

1.8. Ansys Composite Cure Simulation (ACCS) Updates

1.9.Two Examples of Solid Modeling with Reinforcing Elements

1.1. Interface to the Ansys LS-DYNA™ Application

ACP now includes a refactored LS-DYNA interface based on the Envyo application. This update provides:

• Expanded Functionality: Support for a wider range of material, part, and element keywords, as
well as additional modeling approaches.

• Improved Workflows: Export shell and solid models for further processing in the LS-PrePost applic-
ation.

• Direct Model Conversion: Convert ACP models to LS-DYNA input files using the Envyo application.
For more information, see Workflows in the Envyo User's Guide.

You can use this interface when ACP runs within the Ansys Workbench™ software or as a standalone
application. For details, see LS-DYNA in the ACP User's Guide.
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1.2. Solid Composite Model with Reinforcing Elements

You can now use reinforcing element technology to model layered composite solid models in the
Workbench software. This capability supports passing the configured solid model and reinforcing
plies from ACP to the Ansys Mechanical™ application for structural or thermal analysis.

The enhancement also enables modeling of layered composites with tetrahedral solid meshes. Previ-
ously, solids required layered brick (hex) elements. For more information, see Layup Mapping Objects
in the ACP User's Guide.

1.3. Performance Improvements

ACP includes several performance improvements, especially for large models:

• Model loading is about 4x faster than previous releases.

• Model updates are about 2x more efficient.

• Solid model processing is about 20% faster, and refreshing a model is more efficient.

1.4. Split Modeling Ply into Production Materials

You can now split a modeling ply with a sublaminate into its production materials. This enhancement
simplifies layup refinement workflows, which often start with the same stack of plies for the entire
structure and then refine it step by step. The initial step can be accomplished using sublaminates,
but previously, inserting local patches required manually splitting those sublaminates into separate
plies.

1.5. End of Support for .acp Serialization Format

The legacy .acp serialization format is no longer supported. The .acph5 format, introduced in Release
2019 R1 (19.3), replaces .acp and is required for compatibility with current and future releases.

How to upgrade older projects

To upgrade projects created with ACP 19.2 or earlier:

• Use any version of Workbench software between 2019 R1 and 2025 R2.

• Open and close all ACP setup and results components, then save the project.

Removed functionality

Export and import of composite definitions to .acp files is removed. For individual ACP objects, use
the serialize() method to obtain Python code for creating the object. To duplicate multiple
interdependent objects or copy them between models, use the PyACP recursive_copy() function.

For details, see linkShare and Copy Composite Definitions Between Models in the ACP User's Guide.
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1.6. Sampling Point for Solid Models

The Composite Sampling Point tool in the Mechanical application can now scope to an ACP solid
model. This tool provides access to results from the bottom to the top of the laminate. Visualizing
through-the-thickness distribution of stacking sequence, strains, stresses, and failures helps you un-
derstand laminate behavior and optimize designs.

For more information, see Composite Sampling Point Tool in the Mechanical User's Guide.

1.7. Improved Search Widget

The ACP object tree search widget now supports seamless object selection from a filtered tree. This
improvement makes the UI faster and simplifies handling large models with many named selections.

1.8. Ansys Composite Cure Simulation (ACCS) Updates

Updates include:

• Improved support for multiple curing cycles and steps, including better import of the initial
degree of cure into ACCS.

• Added support for porosity in the resin transfer molding (RTM) solver.

• Improved inlet definition in RTM workflows.

• Added a Post Fill Phase for the RTM solver.

For more information, see Ansys Composite Cure Simulation Documentation.

1.9. Two Examples of Solid Modeling with Reinforcing Elements

The following two examples are now available:

• T-Joint Example: Demonstrates the standard workflow for building a layered 3D composite structure
using reinforcing elements.

• Fan-Blade Example: Demonstrates how reinforcing elements integrate with Imported Plies that
originate from CAD surfaces rather than reference surfaces.

2. Known Limitations

General ACP application and release-specific limitations can be found in Known Limitations in the ACP
User's Guide.
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Material Designer Release Notes
This release of the Ansys Material Designer™ material homogenization software contains all capabilities
from the previous release. The following sections present the notes for the Ansys Material Designer
application's 2026 R1 release.

1. Notes

Material Designer Installation

To install the Material Designer application, you must select the Material Designer checkbox in the in-
stallation. The Material Designer product will no longer automatically be installed with the Mechanical
Products.

Alternatively, you can use the -matdesigner flag in the silent installer. For more information, refer
to the Ansys, Inc. Installation Guides.

2. Known Limitations

General Material Designer application and release-specific limitations can be found in Known Limitations
in the Material Designer User's Guide.
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Additive Manufacturing
Additive Suite products include new features and enhancements at Release 2026 R1 in the following
areas:

1. PBF Process Simulations

2. DED Process Simulations

3. Sintering Process Simulations

4. Distortion Compensation

5. Changes in Product Behavior

6. AM-Related Mechanical APDL Commands

7. PyAdditive

1. PBF Process Simulations

Enhancements for powder bed fusion (PBF) simulations in the Ansys Mechanical™ application include
the following:

• Calibration improvements:

– Quick Calibration – Cutoff height options: The Quick Calibration feature now offers
more flexibility when specifying support cutoff height for the cantilever geometry. Choose
a cutoff height between 0 - 8 mm (in 1 mm increments) from the base plate. Previously,
the cutoff height was predefined and fixed at 3 to 4 mm.

– Quick Calibration – Import CSV file: Save time on setup! You can now directly import
a CSV file containing location-specific distortion measurements. This means you can process
your setup data in a spreadsheet beforehand for easy import into the calibration wizard.

– Full Simulation Calibration – Anisotropic calibration: Anisotropic calibrations are now
supported when performing full simulation calibrations.

• Electron Beam Melting: You can now simulate an Electron Beam Melting (EBM) process, also
known as Electron Beam Powder Bed Fusion (E-PBF). While both E-PBF and L-PBF involve fusing
powdered material layer by layer to build parts, they differ significantly in their mechanisms and
applications. To accommodate an EBM simulation, the following enhancements have been added
to the PBF simulation capability in the Mechanical application:

– Build sequence: New Build Sequence options allow you to define distinct heating steps
in an EBM process, for different preheats, for example. You can also define location spe-
cific process parameters, allowing different portions of the part to have different process
parameters for the same layer. The heating method can be temperature or power. Build
sequence options are controlled in Build Settings.
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– Build environment: You can now account for heat losses from radiation, which is the
dominant heat transfer mechanism in a vacuum. With radiation effects enabled, a surface
boundary condition is applied to the top of a newly laid layer (build step) and the top of
the build (cooldown step). Specify an Emissivity value between 0 (no radiation) and 1
(perfect blackbody emitter) to define the surface's ability to emit radiation. Radiation can
be specified in the PBF Setup Wizard or in Build Settings.

– Multiple materials: Simulations are no longer restricted to using a single material for the
build (part and supports). You can now model PBF simulations with multiple materials.
For a Thermal-Structural AM simulation, the melting temperature for each part geometry
must be defined in Engineering Data. A Representative Material option will be displayed
in AM Process when multiple material assignments on the part geometries are detected.
Choose the material that is most representative of the model as a whole, specifically for
thermal properties.

→ Predefined Support structures can now be assigned a different material than the
part geometry they are supporting.

→ For STL and Generated Supports, the material will be the same as the part they
are scoped to.

– Modeling of powder (Beta): For voxel meshes, you can generate powder padding around
the part and extend the powder below the part to the base plate.

The updates to the underlying AMBUILD Mechanical APDL command made at the last release
enable these EBM enhancements in the Mechanical application at this release.

• Multi-step heat treatment: The PBF Setup Wizard now supports complex, multi-stage thermal
cycles, moving beyond the standard single ramp-and-hold sequence. This allows for high-fidelity
simulation of sophisticated industrial heat treatment schedules.

– Advanced Cycle Configuration: A new Multiple (Use Table) option enables the definition
via a table of intricate cycles with various heating ramps, soak times, and cooling rates.

– Granular Solver Control: New Time Stepping controls allow for manual substep adjust-
ments to ensure accuracy during critical thermal transitions.

– Automated Workflow: The wizard intelligently detects and preloads existing convection
loads into the table, seamlessly transitioning between simple and multi-step configurations.

• HPC Platform Services (HPS) for AM simulations: You can now leverage Ansys HPC Platform
Services (HPS) to accelerate Additive Manufacturing simulations. Inherent Strain and Thermal-
Structural simulations with heat treatment steps can be solved on HPC Platform Services. This
feature requires that you set up a Solve Process Queue for the required HPC server details.

• UI changes: You'll notice in the UI that items are renamed to be PBF rather than LPBF as a subtle
reminder that electron beam simulations are now possible, and not just laser beam simulations.
For example, the LPBF Setup Wizard is now the PBF Setup Wizard, the LPBF Hotspot result item
is now the PBF Hotspot, and so on.

Additionally, the AM-specific result items are now consolidated under two new buttons in the
PBF Process ribbon, as follows:
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Thermal PBF Results

Hotspot

Hotspot Time Correction (Beta)

Heat Flux (Beta)

Structural PBF Results

Recoater Interference

High Strain

Shrinkline (Beta)

• Visualize cutoff direction: An arrow has been added in the graphics window to indicate the
direction of base/support cutoff when directional cutoff is chosen (Analysis Settings, Base Removal
Type = Directional).

• Visualize knockdown factors for voxel mesh (Beta): You can now visualize knockdown factors
when using the Voxelizer option in the Cartesian mesh method. The option is available under
Display Type > View (Beta) on the AM Process object when the Cartesian Mesh Method has the
`Mesh Using Voxelization` set to True or if an STL Support is present in the Tree. This is similar
to the capability that is already in place for visualizing knockdown factors for STL Supports.

• Visualize conformal mesh (Beta): A new visualization tool is now available for viewing AM
simulation results on a conformal body instead of voxel mesh elements. After completing the
AM process simulation, select the desired result object under Solution and click Evaluate. Once
evaluation is complete, click the Visualize Conformal Mesh (Beta) button on the PBF Process
ribbon.

• PBF Heat Flux result (Beta): For AM thermal-structural simulations, a new Heat Flux (Beta)
result item allows you to evaluate the maximum heat flux for each element at the conclusion of
every layer’s deposition step. You can toggle between Total Heat Flux and Directional Heat Flux.
Choose between contour plots for gradient visualization or vector plots for flow direction. Visu-
alize data from either the first cooldown step or the last cooldown step.

The Heat Flux (Beta) result can be added to a Thermal AM Analysis System and requires the
"Calculate Thermal Flux” output control to be on. If adding the result before the solve, this will
be done automatically.

• PBF Shrinkline result (Beta): A new shrinkline result allows you to pinpoint areas where one
or more layers are contracting more than the surrounding material—this localized contraction
is commonly referred to as a shrinkline.

2. DED Process Simulations

Enhancements for directed energy deposition (DED) simulations include the following:
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Additive DED Add-in in the Discovery™ Application

Introduced at the last release, Discovery's Additive DED add-in allows you to generate geometry models
directly from a tool path file, such as G-code. This Path to Part method offers more accurate views of
print characteristics, like deposition volume and geometric feature details, compared to using nominal
CAD designs. More functionality has been added to the add-in at this release:

• Import CLS file format (Beta): You can now import a file in a Cutter Location Source (CLS) format.
Specify the Paint Index used for deposition.

• Multiple machine types supported: You can now specify either a Three-axis or Multi-axis machine
in the Path tool. Inputs for Multi-axis machine include X-axis Rotation, Y-axis Rotation, Z-axis Rotation,
Rotation Sequence, and Tool Direction.

• Export material orientation from tool path file: You can now easily export material orientation
data directly from the G-code/CLS file into the Mechanical application. This new function exports the
Euler angles at every path point into a .CSV file. In the Mechanical application, this data is used to
define local coordinate systems, which are necessary for applying realistic anisotropic (direction-de-
pendent) material properties to your simulated part. The Interpolation Distance input is available to
automatically generate interpolated points, achieving a finer resolution of local coordinate systems
than the defined path points provide.

• Visualization of tool path orientation: A new object called Tool Path is added to the tree upon
import of your G-code or CLS file (Beta). This object stores the complete tool path and the specific
orientation of the printer head at every position. Beyond viewing path curves, you can now visualize
the deposition direction at any point—a critical feature for accurately interpreting how the bead
profile is applied throughout the build.

• New bead profiles added: When using the Path to Part tool, in addition to the standard Circular
bead cross section, you can now specify a Rectangular or an Elliptical bead profile.

• Scripting supported: You can now use Discovery's Script Editor to automate the workflow steps
when using the Additive DED add-in. Record the steps in the workflow, adjust parameters as desired
in the Script Editor, and replay the script any time. This technique allows you to customize the bead
profile beyond the provided profiles (Circular, Rectangular, or Elliptical). Simply change the coordinates
in the profile line of code in the script.

DED Process Add-on in the Mechanical Application

• Multi-material deposition: You can now simulate deposition of multiple materials by simply defining
distinct bodies and assigning the desired materials.

• Hotspot result item: A new Hotspot result item has been added for calculating residual hotspots in
the DED process. The hotspot shows the maximum temperature in each depositioned cluster of ele-
ments immediately before the next cluster is activated.

3. Sintering Process Simulations

Enhancements for sintering simulations using the Sintering Process Add-on include the following:

Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.94

Additive Manufacturing



• Location-dependent green density improvements: We've added the ability to specify variable
density in the Sinter Material object using tabular entry, simplifying the process of importing
experimental green density data for sintering simulations.

This feature is available in the Sintering Process Add-On by choosing Sinter Material > Initial
State Data = Tabular under Definition.

• Alumina material model: A new Alumina material model is now available, allowing you to
model one of the most versatile and widely used technical ceramic materials due to its excep-
tional combination of mechanical, thermal, and electrical properties. The material model uses
the newly added Ashby modifier for sinter stress and the newly added Pore Pinning modifier for

grain-growth kinetics with 4th power for grain size.

• Advanced grain-growth model: A new general power law model for grain-growth kinetics is
now available, enabling more accurate simulation of normal grain growth during sintering. Unlike
the previous parabolic model, this approach supports variable growth exponents, making it
suitable for diverse materials such as ceramics and metals used in powder metallurgy.

The feature is available by choosing Sinter Material > Model = Advanced under Grain-Growth
Kinetics.

• New sintering stress evolution models: Three new stress evolution models are available for
accurate modeling of sintering stress. This enhancement builds upon existing stress calculation
by adjusting the calculated stress. The new models are based on work by McMeeking & Kuhn,
Ashby, and Shinagawa.

Choose an option on Sinter Material > Stress Modifier under Sintering Stress.

4. Distortion Compensation

The Distortion Compensation Add-on is a tool for correcting distortions caused by the manufacturing
process. Enhancements include:

• Option to combine STL files when exporting compensated STL files: A new option, Combine
Bodies (Yes/No) merges the exported distortion-compensated STL files into a single file. This is
particularly useful for DED simulations containing multiple cluster bodies. When a Single Com-
pensation object is scoped to all clusters, it uses the refaceting settings to generate a single,
unified STL file consisting of all merged clusters.

5. Changes in Product Behavior

Release 2026 R1 of the Mechanical application includes AM-related enhancements that cause product
behavior to differ from earlier releases, as explained below:

Powder Bed Fusion (PBF)

• The previous limitation of a single build material has been removed. PBF simulations now support
multiple materials defined via different bodies.
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Directed Energy Deposition (DED)

• In this release of the Additive DED Add-in in the Discovery™ Application, the G-code tool under Import
has been renamed to Path to reflect support for an additional import format: CLS (Beta).

• In this release of the Mechanical application, a boundary condition check has been added for add-
ons during the solve step for each system/environment.

To pass this check, DED simulations now require a "DED_Loads" placeholder command snippet in
both the Transient Thermal and Static Structural systems. These command snippets are automatically
inserted by the AM Process for DED object, including when reopening a previously solved archived
project from an earlier release.

Note: After importing an archived project, the simulation state may display a yellow lightning bolt,
indicating it is in an obsolete state. However, the results are still valid and can be retrieved.

• The previous limitation of a single deposition material has been removed. DED simulations now
support multiple materials defined via different bodies.

• The requirement to use a Cartesian mesh for multi-axis simulations has been removed. You can now
utilize a wider range of element types—including Hexahedral (Hex) and Tetrahedral (Tet)—to better
represent complex geometries and organic shapes in multi-axis DED workflows.

• The DEDClusterOutput.json file generated during DED clustering has been updated to start
with an index of 1. This replaces the previous 0-indexed format to provide better consistency across
the simulation workflow.

Sintering

• With the addition of the ability to specify variable density in the Sinter Material object using tabular
entry:

– Node-based INISTATE mapping is used. Subsequent mappings are limited to node-based al-
gorithm.

– The UF01 field variable is reserved by the Sinter Material object for specifying mass density.

6. AM-Related Mechanical APDL Commands

Changes to the AM-related Mechanical APDL commands include the following:

• AMENV – Specifies the build-environment thermal boundary conditions in an additive manufac-
turing (AM) analysis. Use the new RADOPT, EMIS, and SBC options to define radiation boundary
conditions in a PBF simulation. Radiation is important when simulating an EBM process. When
radiation is enabled, heat losses from radiation are applied to the top of a newly laid layer during
the build and cooldown process steps.

7. PyAdditive

PyAdditive is a Python client library for the Ansys Additive server. The Ansys Additive server is distributed
with the Additive option of the Structures package in the Ansys unified installation.
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Use PyAdditive to run single bead, porosity, 2D microstructure, 3D microstructure (Beta), and thermal
history simulations, as well as custom material tuning. An Ansys Additive Suite license is required to
run the simulations and tune materials. End-to-end examples show how you can use PyAdditve. You
can download these examples as Python files or Jupyter notebooks and run them locally. For more in-
formation, see the PyAdditive documentation.

New in PyAdditive

Newly released functionality for PyAdditive that is included in the 2026 R1 Ansys Additive server include:

• Ring mode (Beta): A new ring mode (ring-shaped) beam profile option has been added to the
laser modeling capabilities. This feature uses a mathematical representation to simulate how
various donut-type laser intensity distributions influence melt-pool behavior in additive manu-
facturing.

The ring mode includes seven indices (0–6) that adjust the relative intensities of the primary
and secondary laser peaks. Index 0 closely aligns with the traditional Gaussian distribution. As
the index increases, the primary peak intensity decreases while the secondary peak becomes
more dominant, resulting in progressively stronger ring-shaped profiles.

Ring mode beam shapes are commonly used to generate wider melt pools, increasing productivity
during bulk build regions. They can also help mitigate keyhole porosity in certain materials, such
as AlSi10Mg.

• Laser defocusing heat source model (Beta): We’ve introduced a new Laser Defocusing Heat
Source Model (Beta) that allows you to simulate how heat is distributed when a laser beam is
intentionally offset from its focal point. This model is useful for processes such as welding, cutting,
additive manufacturing, and surface treatments where broader, lower-intensity heat input is
desired.

In this initial release, the model supports positive defocus only, meaning the laser’s focal point
is positioned above the material surface. This creates a wider, shallower laser spot, enabling you
to evaluate conditions where reduced energy density and gentler heating are important.

Defocusing affects energy density, melt pool geometry, thermal gradients, and cooling rates.
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Sherlock
Introduction

This document provides a summary of all new features, product enhancements, limitations, and bug
fixes in the 2026 R1 release of the Ansys Sherlock™ electronics reliability prediction software.

1. Known Issues

2. New Features

3. Resolved Issues and Limitations

4. Scheduled Updates

5. General Enhancements

6. API Updates

7. Bug Fixes

8.Third Party Dependency Changes

1. Known Issues

There are no known issues for Sherlock 2026 R1.

2. New Features

You can now import and convert thermal signal data into a Thermal Event of a given Life Phase. The
Life Cycle Viewer and the Report feature have been updated to include charts and tables which visualize
the imported thermal signal data. See Import Thermal Signal (Rainflow Cycle Counting) in Sherlock
User's Guide. Currently, the 4D chart feature is not supported on Linux

3. Resolved Issues and Limitations

For Sherlock release 2026 R1, the following issue has been resolved: When exporting a blocked CDB
model from the Sherlock application with solder balls modeled as shells and beams, the solder balls
were missing from the exported CDB file. The CDB export feature now works correctly.

4. Scheduled Updates

The DFMEA feature will be sunset in the next release, 2027 R1, of the Sherlock application.

5. General Enhancements

Links:
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5.1. Scoring Updates

5.2. Updates to Sherlock Component Models

5.3. Updates to Sherlock Analysis Modules

5.4. Solder Updates

5.5. Updates to Ansys Workbench/Mechanical Application Integration

5.6. GUI Updates

5.7. Performance Improvements

5.8. Other Enhancements

5.1. Scoring Updates

The color-coded scoring system has changed for the following analysis modules: Solder Joint Fatigue,
PTH Fatigue, Semiconductor Wearout, Harmonic Vibe, and Random Vibe:

• The numeric score has been removed from the analysis results.

• The color-coding system used in the results is now based on the probability of failure ratio which
you can configure in Main Menu >Settings > Score.

Caution:

Because the color-coding system used in the results is now based on probability of failure,
the color applied to components may differ from earlier versions of the Sherlock applic-
ation.

• The overall numeric score has been removed from the Results Summary and reports. The numeric
score per analysis module has also been removed from reports.

See the chapter Color-Coded Scoring System in the Sherlock User's Guide for a complete explanation
of the new scoring system.

5.2. Updates to Sherlock Component Models

Leaded Model:

• The Lead Height property no longer applies to parts with stub leads.

• A new package property called Package Compliance Factor is now used in the combined stiffness
calculation for all leads. See Package Compliance Factor in the Sherlock User's Guide. To enable
editing the Package Compliance Factor field in the Part Editor, go to Settings > Advanced >
Part List > Package Compliance Factor in the Sherlock application.

• The combined stiffness calculation has been updated for lead layouts that are quad, rectangular,
or circular.

• A shear spring model is now used for calculating the stiffness of stub leads.
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• In the Package Data Base, the data for stub lead packages has been updated for the following
types: SON, USON, SOD, OTHER, SOT, TO, and SM.

BTC/IMS Packages:

• The Sherlock application now detects the IMS routing pattern from top and bottom copper layers
for BTC packages. This is used to guess the Design Factor part property. Detection happens auto-
matically when component layers are updated or a top or bottom copper layer is processed. See
BTC Packages in the Sherlock User's Guide.

• The detection of BTC package type based on the ECAD package name has been enhanced.

BGA and CGAs

• The BGA and CGA solder models have been updated: The reduced shear modulus is adjusted to
account for the distance to neutral point (DNP). Also, the corner overmold material is adjusted to
account for the DNP.

• The detailed BGA package model option is no longer beta. It is now a standard feature and can be
enabled in Settings > Meshing. See Detailed Package Modeling (Thermal Mech Life Prediction for
BGAs) in Sherlock User's Guide.

CC and LCCCs

• Previously, the chip component (CC) and leadless chip carrier component (LCCC) models were
producing identical results because they used the same critical length formulation. To improve
model accuracy and better reflect physical behavior, the Sherlock application now uses a revised
shear stress formulation and an updated definition of critical length.

The Sherlock Part Library

• The Sherlock 2026 R1 Part Library update contains 2,236,857 parts.

5.3. Updates to Sherlock Analysis Modules

• The option to use contact elements in place of constraint equations for FEA models is no longer
beta. It is now a now a standard feature which you can enable in Settings > FEA.

• You can now calculate Time-to-Fail results at any PoF (probability of failure) for the following ana-
lyses: PTH, Component Failure Mechanism, Harmonic Vibe, Random Vibe, Mechanical Shock, ICT
Analysis, Solder Fatigue, and Thermal Mech. The probability percentage value can be adjusted in
the Advanced Settings dialog. In the Sherlock User's Guide, see the entry Life Metric At (%) under
Advanced Settings > General.

• An improved Stackup Calculator has been added. For new and imported stackups, you can enable
this feature in the Advanced Settings dialog. When enabled, new calculations are used for the
CTExy and the Exy for conductive layers and the CTExy for the stackup.

• Solder Fatigue analyses for BGAs and CGAs are now executed successfully even if a part's Ball
Modeling property is set to NONE.
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5.4. Solder Updates

• The secant modulus for eutectic SnPb solder has been recalibrated using Anand's viscoplastic
model, replacing the previous material representation to improve accuracy under thermomechan-
ical loading.

• Solder materials SAC 302 and SenjuM758 have been added.

5.5. Updates to Ansys Workbench/Mechanical Application Integration

• A new Sherlock native extension—an app accessible from within the Ansys Mechanical applica-
tion—integrates some of the Sherlock pre-processing capabilities directly into Mechanical. This
enables you to perform select Sherlock functions without leaving the Mechanical environment. See
the Sherlock User's Guide, The Sherlock Native App in Ansys Mechanical.

The following enhancements were added to support the new app:

– The Sherlock application now has the ability to hide the GUI at startup.

– New APIs (p. 104) have been added to toggle specific parts of the GUI.

• Additional notifications have been added to the gRPC bi-directional streaming between the Work-
bench and Sherlock applications. Sherlock notifies Workbench when:

– A Modeling Region is added or deleted.

– The Edit Properties dialog is used to change any properties of a Mechanical Part, Modeling Region,
Potting Region, Cutout, or Mount Point.

– A Mechanical Part, Modeling Region, Potting Region, Cutout, or Mount Point is moved, rotated,
scaled, copied or merged.

– A new CCA is created from a Modeling Region.

• When importing FEA results from the Ansys Mechanical application, you can now import pre-stressed
static structural analysis results with large deflection enabled. See Analysis Properties: Imported
Data Source in the Sherlock User's Guide.

• Added a materials XML used when exporting isometric materials of an FEA model or a Trace Rein-
forcement model to Workbench. Previously, the data was exported by using a Workbench API in
the WBJN files.

• You can now export orthotropic PCB properties when exporting WBJN files. See Set PCB Modeling
Settings in the Sherlock User's Guide.

5.6. GUI Updates

• The Thermal Mech Analysis Properties dialog now cleanly displays a large number of Thermal
Events.

• A Recently Used Files selector has been added to the Import Stackup dialog.
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• In the Parts List Validation Properties window, there are no longer preset selections under AVL
Options.

• The Sherlock Project Tree now supports informational images. When you add an image file to a
project, the Sherlock application now associates it as an info image by default.

5.7. Performance Improvements

• Performance has been improved when importing GDSII files.

• The beta option Polygon Merge Performance has been integrated into the base program. This im-
proves performance when polygons are merged during Trace Model Generation.

• The GUI is now more responsive when analysis results are cleared as a result of Life Events being
changed.

5.8. Other Enhancements

• Logo images have been updated for reports.

• When importing an IPC-2581 archive, a warning appears if the archive does not implement the
FULL or USERDEF function mode as noted in the IPC-2581 Import Tutorial in the Sherlock User's
Guide.

• The Use Part Body Weight option is no longer an Advanced Setting. It is now a Part Property. To
use the part body weight to compute material density, you must enable Use Part Body Weight
for each part in the Part Editor.

• When laminates not found in the Sherlock Laminate Library are imported into a stackup, the lam-
inates are displayed as errors in the stackup. This serves as a reminder to update the stackup or to
add the laminates to the Library.

6. API Updates

Links:

6.1. General API Improvements

6.2. New APIs

6.3. Modified APIs

6.4. Deprecated APIs

6.5. Previously Deprecated APIs Removed

6.1. General API Improvements

When API calls are executed that are analogous to actions performed in the Parts Editor and Layer
Viewer, the Workbench application now receives notifications via the gRPC bi-directional stream. The
actions and notifications match those that occur when the Sherlock GUI is used.
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6.2. New APIs

• getTestPointProperties(): Returns the properties for a specified set of test points.

• importCopperFiles(): Imports copper layer files to a Sherlock project.

• getICTFixturesProperties(): Returns the properties for a specific set of ICT Fixture IDs.

• updateTestPoints(): Updates the properties of one or more test points in a CCA.

• importThermalSignal(): Enables the importing of thermal signal data.

• updateICTFixtures(): Updates the properties of one or more test points in a CCA.

• importPartsToAVL(): Import any supported file type containing parts to be added to the AVL
(Approved Vendor List).

• saveHarmonicProfile(): Saves a Harmonic profile to a .csv or .dat file.

• saveRandomVibeProfile(): Saves a Random Vibe profile to a .csv or .dat file.

• saveShockPulseProfile(): Saves a Shock Pulse profile a .csv or .dat file.

• saveThermalProfile(): Saves a Thermal profile a .csv or .dat file.

• updateLifeCycle(): Updates the Life Cycle of a project. It also allows you to save unsaved results
files as the GUI does. It overwrites existing results files with the same name.

• updateLifePhase(): Makes changes to a specific Life Phase. It also enables you to save unsaved
results files if an archive file name is included.

• updateMountPoints(): Updates mount point properties.

• deleteEvent(): Deletes a Life Cycle Event.

• deletePhase(): Deletes a Life Cycle Phase.

• importThermalSignal(): Updated rainflow cycle binning so it uses separate binning parameters
for range, mean, and dwell.

6.3. Modified APIs

• getStackupProps(): Updated to allow values to be retrieved based on the use of the improved
Stackup model, thanks to the new improveStackupModelEnabled parameter

• exportFEAModel(): Updated to allow the material elasticity type to be specified when exporting
WBJN files.

• Added validation for the side property in the updateMountPoints() API. If an invalid side is inputted,
the request fails now.

• The addCCA() API no longer waits thirty seconds to return. It now returns once the CCA has been
successfully added.
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6.4. Deprecated APIs

• Stackup service:

– ListLaminateThicknessUnits()

• Lifecycle service:

– ListFreqUnits()

– ListTempUnits()

– ListAmplUnits()

– ListShockLoadUnits()

6.5. Previously Deprecated APIs Removed

• Sherlock Common Service:

– getSolders()

• Sherlock Parts Service:

– getPartLocation()

7. Bug Fixes

• Corrected a mesh generation issue where mount hole meshes could sometimes overlap the PCB
mesh instead of merging with the PCB mesh when very small mesh sizes were used.

• Exported blocked CDB files using Shells and Beam elements for BGA's now correctly define the beam
element type in the CDB file.

• When running an analysis with leaded parts that do not have die properties, the Sherlock console
no longer displays a warning about missing die properties.

• Corrected the color display for component footprints in the Layer Viewer so the color of component
analysis results appear as expected when overlaid on the components.

• When importing ODB++ files, a parsing error is no longer displayed when user-defined attributes are
encountered.

• When importing a stackup, the Sherlock application might not properly associate or clear errors,
resulting in future imported stackups failing. This has been corrected.

• In some cases, when importing a stackup or editing a stackup layer, stackup rows appeared to be
missing or duplicated until the project was reopened. This has been corrected.

• When a stackup contained errors and the errors were cleared, the stackup would no longer display
the error tab if errors were subsequently introduced, such as after an import. This error has been
corrected.

105
Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.

Bug Fixes



• User-defined stackup properties are no longer reset when a CSV stackup is imported.

• Corrected an issue where IPC-2581 cutouts were getting converted with the wrong measurement
units, causing them to not be rendered improperly in the Layer Viewer.

• When trace models are generated from IPC-2851 archives, line paths are now properly filled.

• Corrected an issue where an imported Random Vibration analysis using nodal lead forces would fail
to run to completion when there was a missing PSD file.

• When exporting part material density values using part body weight, part corner shape is no longer
taken into account when computing density.

• Corrected an issue with the exporting of trace reinforcement models that could cause the length of
vias to be incorrect.

• In the Package Editor tabs, the application no longer allows you to save blank unit fields for Package,
Die, Pad, Ball, or Flag.

• The Solder Editor was not validating CC Calibration Factor values which permitted the field to be
blank. This prevented the exported solder from being reimported into the Sherlock application. The
blank field also prevented the getSolderInfo() API from returning solders. This bug has been fixed.

• When packages were exported, the exported Lead Height was set to 0 for packages that relied on
Guessed Lead Height values. This has been corrected.

• Fixed a bug causing illegible text on the Analysis Errors tab for the Japanese font.

• When editing conductor layers in a stackup, you can now change the Conductor Thickness units
when multiple layers with different Thickness values are selected.

• When importing a stackup CSV file, the Sherlock application no longer recomputes the layer material
property values based on matching Sherlock material and Laminate Library properties.

• Updated the spacing around the Help field dialog to prevent trimming of font glyphs.

• When importing laminates, the Manufacturer, Grade, or Material are no longer forced to upper-case.

• After changing the name of a Laminate, you no longer have to restart the Sherlock application for it
to appear in the Stackup Laminate Chooser field in the Stackup Editor.

• Corrected issues with importing ODB++ compressed files disguised as GZip files.

• Resolved a bug which resulted in a series of number formatting exception errors issue when importing
an IPC-2581 archive.

• Updated solder Senju M705 CC Calibration.

• Corrected an issue where the order of the connected points in the Material Temperature Calculator
was based on the X values (temperature) rather than the order they were calculated. Also, a limit of
300 points was added.
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• In the Strain Map analysis, the Maximum Strain might not be selected under a component footprint
in the following situation: The component strain is one of the image pixels at the maximum X or Y
location of the component, and the component did not fully cover the pixel. This has been corrected.

• A formula error for the IMS solder model has been corrected. The strain energy calibration at max
temp referenced hot-dwell effective package stiffness instead of cold-dwell effective stiffness.

• The following corrections have been made to the shells and beams CDB export feature:

– The error "Object doesn't support this property or method" no longer occurs when exporting to
the Workbench application.

– Corrected the problem of contacts not being created for one-element components.

– When exporting layer models, PCB surface Named Selections are now assigned correctly.

• Previously, the Sherlock application was not correctly parsing Gerber aperture definitions larger than
three digits, resulting in copper layers improperly drawn. This issue has been corrected.

• Corrected the tutorial file Assembly Tutorial.zip so the imported Parts List contains the correct
refDes data values.

8. Third Party Dependency Changes

• JAXB-RI 4.0.5 has been added to Sherlock

• Java OpenGL and Gluegen libraries have been updated to version 2.5.0.
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Release Notes
The 2026 R1 Ansys Forming release contains all of the capabilities from previous releases plus many
new features and enhancements. Review changes and new capabilities below:

1. Geometry & Preprocessing

2. Forming Process Enhancements

3. Solver & Performance Improvements

4. Postprocessing & Reporting

5. Documentation

1. Geometry & Preprocessing

New features and enhancements include:

1.1. Sketch Simple Curves Directly in Ansys Forming

1.2. Edit Curves for Faster, More Flexible Design

1.3. Guided Pin Generation for Greater Flexibility in Tool Design

1.4.Transition to Parasolid Geometric Kernel

1.1. Sketch Simple Curves Directly in Ansys Forming

You can now create simple curves within Ansys Forming, reducing dependency on external CAD tools
during the design process. Sketch simplifies geometry preparation for forming simulations and supports
common curve types such as points, lines, rectangles, circles, and splines.

Sketch allows you to:

• Define blank shapes, drawbeads, and trimming paths directly in the application.

• Apply geometric constraints and dimensions for precise control.

• Create curves in different planes.

• Interact with your sketch as you create by snapping points, dragging curves, and more.

This feature pairs well with another new feature, curve editing (p. 110), enabling quick modifications
to imported or sketched curves. Together, these tools provide a complete geometry workflow —
import, sketch, and edit — all within Ansys Forming.

Access Sketch from the Geometry section of the ribbon.

Review Sketch Curves to learn more.
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Figure 1: Sketch Interface with Sample Spline

1.2. Edit Curves for Faster, More Flexible Design

Curve Editing enables you to modify imported or sketched curves directly in Ansys Forming, reducing
the need to return to external CAD tools and accelerating design iterations.

Available editing options include:

• Split curves into multiple sections.

• Extend curve ends to meet design needs.

• Merge or bridge curves for smooth transitions.

• Locally shift segments for precise adjustments.

• Offset a new curve on either side of an existing 2D.

• Offset a 3D curve over surfaces.

• Extract the boundary of a surface to use as a curve.

Access Curve Editing from the Geometry section of the ribbon.

Review Edit Curves to learn more.
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Figure 2: Curve Editing Interface with Sample Curve Split into Four Segments

1.3. Guided Pin Generation for Greater Flexibility in Tool Design

Guided Pin Generation allows you to design guide pins directly within Ansys Forming. You can choose
from multiple generation methods — Free Picking Point, Center of Hole Curve, or Boundary Alignment
— and adjust parameters such as pin direction, radius, and length.

This feature streamlines setup and improves flexibility for complex tooling requirements. All pin
generation options are accessible from the Guide Pins task panel, ensuring a smooth workflow.

Review Add Guide Pins to learn more.

1.4. Transition to Parasolid Geometric Kernel

Ansys Forming now uses the Parasolid geometric kernel for geometry handling and operations. Note
the following important updates:

Forming Processes Remain Unchanged

All previously defined forming processes remain unchanged. If you open a project you started
in Ansys Forming 25R2 or earlier and only modify the forming process without redefining
tools or blanks, no action is required.

You May Need to Reimport Geometry

If you open a project you started in Ansys Forming 25R2 or earlier and you must change any
geometrical data, such as surfaces, curves, and similar entities, you must reimport your
geometries. These will not be automatically converted to the new kernel.
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Benefits of the new kernel include:

• Support for native Parasolid files.

• Foundation for advanced features such as Curve Editing and Guided Pin Generation.

• Improved robustness and accuracy for geometry operations.

This change lays the groundwork for future enhancements in geometry workflows.

2. Forming Process Enhancements

New features and enhancements include:

2.1. Improved Support for Solid Elements

2.2.Tipping Support for One Step Projects

2.3. Double Drawbead Now Supported

2.4. Define Multiple Offset Values for Local Tooling Regions

2.5. Flexible Gravity Simulation

2.6. Operation Suspension in Forming Workflows

2.1. Improved Support for Solid Elements

In the 25R2 release, Ansys Forming began supporting solid elements in stamping simulations as a
beta feature. This release delivers significant improvements for this function. These enhancements
provide greater accuracy and robustness for forming simulations involving thick or complex blanks.

• Improved Robustness for Solid Element Simulation

• Forming Limit Diagram (FLD) support for solid blanks, including through the thickness of the blank.

Review Simulate a Solid Element Blank to learn more.
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Figure 3: FLD for a Model with Solid Elements

2.2. Tipping Support for One Step Projects

Tipping is now available for One Step simulations, aligning imported part geometries with the press
coordinate system. This improves result interpretation, ensures cross-project consistency, and enhances
visualization for identifying potential issues such as undercuts or wrinkling.

Review Tip Your Model to the Press Position to learn more.

2.3. Double Drawbead Now Supported

Ansys Forming now allows you to easily generate double drawbead geometry for Round and Round
(Advanced) bead profiles on the binder mesh. The application can then calculate the corresponding
force for the paired beads.

Currently, you may only pair beads with the same profile. For example, you may not pair Round and
Round (Advanced) bead types.

Review Add Drawbeads to learn more.
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Figure 4: Sample Project with Double Drawbeads Defined

The figure above shows a sample project with two double drawbeads defined. The inner curve
(Drawbead-3) contains four segments (D3-S1, D3-S2, D3-S3, and D3-S4). The outer curvers to the left
and right are defined as Drawbead-1 and Drawbead-2 respectively, each comprised of only one seg-
ment. In this model, D3-S3 and D1-S1 are paired to represent a double drawbead (highlighted above),
as are D3-S1 and D2-S1.

2.4. Define Multiple Offset Values for Local Tooling Regions

You can now assign multiple offset values to different regions of a single tooling component. This
capability allows you to create region-specific tool clearances, such as applying different offset values
inside and outside a drawbead on the binder. Use this feature to fine-tune restraining force and better
control material flow during forming.

Review Define Multiple Offset Values in the Ansys Forming User's Guide to learn more.

2.5. Flexible Gravity Simulation

With improved gravity loading simulation, you now have more flexibility to define the lower support.

Each tool includes an As Positioning Base option to maintain stability:

• If only one tool exists, the option is enabled and locked by default.

• If the original positioning tool is present, the option remains enabled and locked.

• If multiple tools exist and none is the original positioning tool, you must select one tool and
enable As Positioning Base.

Review Simulate Gravity to learn more.

Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.114

Release Notes



2.6. Operation Suspension in Forming Workflows

You now have greater control when suspending operations in a forming workflow. Previously, sus-
pending an operation also suspended all subsequent operations, which limited flexibility during
design testing and iteration.

With this update, you can choose between two suspension options:

• Suspend: Disable the selected operation and all following operations.

• Suspend Current: Disable only the selected operation while keeping the rest active. You may
use this function to skip unfinished or computationally demanding operations, depending on
their location in the workflow and impact on subsequent operations.

Review Operations Tab to learn more.

3. Solver & Performance Improvements

New features and enhancements include:

3.1. Enhanced Implicit Solver Performance

3.2. Improved Speed at Binder Closing

3.1. Enhanced Implicit Solver Performance

Implicit solver improvements deliver up to 3X faster performance for gravity loading and springback
analysis. Advanced parameters optimize convergence and stability for nonlinear steps, reducing iter-
ation counts and improving robustness.

Review Simulate Gravity and Perform Springback Prediction to learn more.

3.2. Improved Speed at Binder Closing

During the binder closing phase, the solver delays mesh refinement and uses a coarser mesh around
the tight radii of 3D drawbeads to improve simulation speed. A finer mesh is applied later in subsequent
phases as needed.

4. Postprocessing & Reporting

New features and enhancements include:

4.1. Automatic Report Generation

4.2. New Advanced Solution Type: Stochastic Simulation

4.3. Edge to Drawbead Function

4.4. New Post-Processing Variable: Maximum FLC Failure

4.5. Support for Formability Index with Barlat 2000
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4.1. Automatic Report Generation

Automatic Report Generation helps you export and communication simulation results in a few simple
steps. After completing an analysis, you can generate a structured report that includes a cover page,
part and process summary, material details, and operation-specific insights.

The application exports reports as Microsoft PowerPoint presentations, making them easy to review,
present, and share. You can use the standard template or create custom templates to emphasize in-
formation most relevant to your projects.

Currently supported results include:

• Gravity simulation

• Drawing operations (formability, thinning, draw-in, and contact information)

• Trimming operations

• Springback compensation

• Measurement operations

Review Additional Tools on the Analysis Tab to learn more.

Figure 5: Sample Slide Generated with Automatic Report

4.2. New Advanced Solution Type: Stochastic Simulation

Stochastic Simulation (robustness analysis) accounts for variability in material properties, boundary
conditions, and process settings. This solution type uses Ansys LS-OPT for uncertainty quantification,
allowing you to:

• Quantify process robustness under real-world uncertainties.
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• Identify critical parameters influencing variability.

• Improve design confidence by reducing risk of failure.

An Ansys LS-OPT license is required to use this feature. Access stochastic analysis from the Process
tab alongside other advanced solution types.

Review Stochastic Simulation to learn more.

Figure 6: Sample Analysis in LS-OPT

4.3. Edge to Drawbead Function

The edge to drawbead function allows you to visualize and measure the distance between the blank
edge and the drawbeads throughout the forming process. This function enables you to:

• Ensure the blank edge remains at the intended distance relative to drawbeads, preventing
loss of bead engagement.

• Reduce the risk of forming defects such as wrinkling or tearing caused by uncontrolled mater-
ial flow.

• Optimize drawbead design and binder force settings for improved process robustness.

Access this new capability from the Analysis tab, under Draw-In drop down menu, and view results
as a vector plot with full animation support. This enhancement gives you deeper insight into material
flow control, helping you design more reliable tooling and achieve higher-quality stamped parts with
fewer iterations.

Review View Edge Draw-In to learn more.

117
Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.

Postprocessing & Reporting



Figure 7: Example of an Edge to Drawbead Draw-In Plot

4.4. New Post-Processing Variable: Maximum FLC Failure

Maximum FLC Failure tracks the highest ratio between major strain and the Forming Limit Curve (FLC)
strain across all operations, providing a comprehensive view of potential material failure. This variable
is currently available only for MAT-3-PARAMETER-BARLAT (MAT36).

Review View Contour Plots to learn more.

4.5. Support for Formability Index with Barlat 2000

You can now use Formability Index (FI) with the Barlat 2000 material model (MAT_BARLAT_YLD2000).
This failure criterion considers non-linear strain paths for improved accuracy in forming limit prediction.

5. Documentation

5.1. New Forming Keyword Reference Manual

The release introduces the Ansys Forming Keyword Reference, a manual that catalogues forming-
specific LS-DYNA keyword cards used by the Ansys Forming application. The manual organizes
forming-specific keyword cards alphabetically and also provides functional groupings that map directly
to core tasks such as control settings, contact definition, tool motion, model positioning, and solution
strategy.

Use this reference to understand how Ansys Forming interprets your model and to gain deeper insight
into solver behavior. Each entry includes a purpose statement, variable definitions with types and
defaults, and usage notes. Whether you want to interrogate your output file, modify and run models
outside the GUI, or automate your workflows with consistent input formats, this new reference helps
you work more efficiently and prepares you for future enhancements to the forming keyword set.
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Motion Release Notes
The following sections present the new features, enhancements and changes for the Ansys Motion™
standalone Solver, Preprocessor and Postprocessor for the 2026 R1 release.

For Motion in the Workbench application, see the Mechanical application Release Notes.

This release of Motion contains all the capabilities from previous releases plus many new features and
enhancements.

1. New Features

2. Functional Enhancements

1. New Features

The following new features are available:

• Simulation Configuration Parameters for the Preprocessor include a new option to execute
the Postprocessor automatically when the simulation has ended or stopped.

• Durability Analysis now includes a option to allow specification of a Fatigue material, either
in the Properties panel itself or in the Material Properties.

• A new Export Motion Files dialog has been added to allow selective export of DFS, SSC and
DFSXML files, as well as reference and post graphic files.

• The Preprocessor now supports the use of Python code as Python-Based User Subroutines.

• FMU export for FMI is now available for a Full Vehicle Assembly in the Car Toolkit.

• Areal and δ-F spline Contact Stiffness definitions are now supported for multiple contact objects,
including M by N Contact and links in a Chained System.

2. Functional Enhancements

The following functional enhancements are available:

• The user interface for the Mass feature in the Preprocessor, used to measure the total mass and
mass moment of inertia and center position of selected bodies, has been revised for easier oper-
ation.

• SixMotion joints have been modified to allow you to check total force, total torque, and total
friction results. Additionally, the individual directional components for the six DOFs are reported
by derived objects.
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• Initial Axis Titles have been updated for both multi-axis and single-axis Chart Plots in the
Postprocessor.

• The Body Properties for Visible Objects in the Postprocessor has been updated for ease of op-
eration, including new options for Plasticity Correction, DFMF file path and Deformation
Suppression.

• Parallel processing efficiency has been improved for analyses where Modal bodies have many
connectors.

• The speed of Nodeset and Patchset creation using a dragged selection in a dfmesh has been
improved.

• The name of a New Curve generated by a mathematical operation now contains previous curve
information as well as math type used.

• Selection of entities is now possible using direct entry of Node or Element ID.
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LS-DYNA Release Notes
This document contains release notes for most of the documentation found on the LS-DYNA product
page on the Ansys Help site.

• For release notes that are specific to the version of the LS-DYNA solver included in the unified installer,
see the FTP site.

• For release notes that are specific to changes in the LS-DYNA systems in the Mechanical Application,
see the release notes here.

This release contains all of the capabilities from previous releases plus many new features and enhance-
ments. Areas where you will find changes and new capabilities include the following:

1. New Documents

2. LS-PrePost Enhancements

3. LS-Run Enhancements

4. Envyo Application

1. New Documents

The following documents have been added to the LS-DYNA product documentation set in the Help
Viewer application. The guides were published on the Ansys website in the previous release and are
now available in the Help Viewer:

• Envyo User's Guide

Describes the use and features of the Envyo application, a mapping tool that transfers simulation
data between different meshes, primarily for the LS-DYNA product.

• LS-DYNA Implicit Analysis Guide

Describes how to set up various types of implicit analyses using the LS-DYNA solver.

2. LS-PrePost Enhancements

The LS-PrePost application includes new features and enhancements at Release 2026 R1 in the following
areas:

2.1. Geometry

2.2. Preprocessing

2.3. Postprocessing

2.4. Application

2.5. Solution Explorer
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2.6. Post Explorer

2.7. General

2.1. Geometry

Geometry updates include:

• The geometry kernel has been upgraded from OCC7.0.0 to OCC7.8.0.

• The CAD assembly model position error, which occurred when translated by HOOPS, has been
fixed.

• Geometry tessellation for IGA post models has been optimized.

• When importing an IGA post file (version 1.2), tessellation and fringe is supported.

• The right-click menu in the graphics viewport works for multiple parts. These can be selected
by either clicking and dragging (AreaPick) over the required parts, or holding the A key and
clicking parts when no dialogs are active.

• Additional Python and SCL API for geometry, along with new sample codes, are available.

• Transparency views for geometry parts are supported.

• Measurement values from active geometry tools can be displayed in exported images and
animations.

2.2. Preprocessing

Keyword

• Export YAML file with model include hierarchy. The following command exports a model's
include file tree to a specified filename:

cfile command: subsystem inctreeinfo2file filename

• Nested Keyword RefBy items. The items listed in the RefBy dialog, which is opened from
the Keyword Input Form, have been nested for easy navigation.

• Keyword Data Filter Table. The Keyword Data Filter Table allows you to navigate, filter, edit,
display, and compare keyword data. It enables efficient handling of large and complex LS-
DYNA models.

• Draw keyword entities. Toggle the eye icon in the first column to draw the keyword if it is
drawable.

• Right-click menu. You can select items in the Keyword Data Filter Table and then right-click
to open a contextual menu of further options.

Entity Display

• Improved Entity Display. *BOUNDARY_SALE_MESH_FACE boundaries can be drawn with
different colors, and segments can be drawn on boundaries that are non-reflective.

Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.122

LS-DYNA Release Notes



Measure

• Optimize segment to segment measuring. In the Measure dialog, when Item is set to Dist
Segm to Segm, you can select the Optimize check box to optimize the algorithm when the
nearest segment between Group 1 and Group 2 (in either direction) must be in the direction
of the segment normal. This setting is helpful when solid elements represent the blank part
for metal forming analyses.

IGA

• Support *BOUNDARY_PRESCRIBED_MOTION_POINT_UVW in Entity Creation dialog. In the
Entity Creation dialog, under Boundary > Prescribed Motion (BPM), the keyword option
POINT_UVW is available. This is used when prescribed boundary conditions are applied to IGA
shells.

• Removed IGA_NURBS_2D_XYZ and IGA_FACE_XYZ entities. Removed the IGA_NURBS_2D_XYZ
and IGA_FACE_XYZ entities in trimmed NURBS 3D entity for cube linear mapping. Node(control
point) was removed.

• Create trimmed IGA solid from STEP file. You can create a trimmed IGA solid from a STEP file
automatically by enabling Create(Auto) when importing the .stp geometry model and clicking
Apply. Every solid part will be converted to trimmed IGA solid respectively.

Note:

This feature is supported for .stp files only.

2.3. Postprocessing

Fringe Component and Fringe Legend

• Shell thickness visualization (PostDB). You can display fringe contours on shell elements while
Shell Thickness is on. This allows for a more realistic view of stress/strain distribution across the
geometry.

• Strain metrics. For Strain components, there is support for Tresca (max shear strain) for solid
elements.

• Fringe of max/min IPT selection of *INITIAL_STRESS with multiple IPT for solid elements .
*INITIAL_STRESS keywords that have multiple integration points are supported in the Max/Min
integration point selection option of the Fringe Component dialog.

• Laminate shell results enhancements. For LSDA defined fringe components, you can load
eloutdet files using the Branch drop-down menu to extract and fringe strain data across different
integration points in laminate shells.

There is also a new Option drop-down menu to switch the result coordinate system between
d3plot (Global system) and element (Local system).

• Fringe legend menu options. From the right-click menu of the Fringe legend, the following options
have been added:
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Identify Min/Max. Highlights the element or node with the minimum or maximum value
in the model view.

New Legend. Defines a new Fringe legend (Change Legend > New Legend). From here
you can define individual legend colors, the overall color palette, values, and fringe limits.

Palette Colors. Sets the legend to a pre-defined color palette. You can select from Default,
Turbo, Cool-warm, Plasma, Inferno, Viridis, and User File.

• Local Fringe legend support in split windows. User-defined Fringe legends can be used across
split windows by right-clicking the legend and going to Change Legend > Select Legend. Across
split windows, legends can vary in color, fringe level, font size, and placement within the display.

ASCII

• Node classification by Set ID. In Post > ASCII, you can classify Node IDs in the bndout branch
based on their specific Set ID. To do this, select the Highlight check box and then, in the Set Node
dialog, select By Set/Grp. This helps find and select specific nodes to Plot within large datasets.

• Rotational curve values unit display. You can switch the display of rotational curve values between
degree and radian (default) from the Settings tab in LS-PrePost, under Configuration Settings >
Display > General > Angular System. This option influences BINOUT and ASCII curve plots of ro-
tational-displacement, rot-velocity and rotational acceleration (nodout/rbdout).

BINOUT

• Element classification by Set ID. In Post > Binout, you can classify element data based on their
specific Set ID. To do this, select the Highlight check box and then, in the Set Elem dialog, select
By Set/Grp. This helps find and select specific elements to Plot within large datasets.

Vector Plot

• Velocity vector plotting for D3DAT. You can plot velocity vectors for d3dat files.

3D Graph View

• 3D Rainflow visualization. Added support for Rainflow Metric plots within the 3D Graph view.

2.4. Application

In the Application menu, the following enhancements have been made to Fragment Analysis and
Occupant Safety:

• Fragment Analysis for SPH. The Fragment Analysis tool supports Smoothed Particle Hydrodynamics
(SPH).

• Dummy Positioning enhancements. In Occupant Safety > Dummy Positioning, the following
buttons have been added:

Show dummy parts only. Displays only the parts referenced in the Dummy tree in the
model view.

Run Dyna. Creates discrete elements (*ELEMENT_DISCRETE) on positioning nodes and uses
the LS-DYNA simulation to pull the Human Body Model (HBM) to a target posture.
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2.5. Solution Explorer

General

• Keyword support for reading object data. LS-PrePost can decode the following keywords for
reading different object data:

Pressure. *LOAD_SHELL_ELEMENT, *LOAD_SHELL_SET, *LOAD_SEGMENT

SPC. *BOUNDARY_SPC_NODE, *BOUNDARY_SPC_NODE_BIRTH_DEATH

Force/Moment. *LOAD_NODE_SET, *LOAD_NODE_POINT

Prescribed Motion. *BOUNDARY_PRESCRIBED_MOTION_NODE

RBE3. *CONSTRAINT_INTERPOLATION

• Support composite layers in Shell Part objects. You can add composite layers in Shell Part objects.
The following keywords can be decoded within the model tree: *PART_COMPOSITE, *PART_COM-
POSITE_CONTACT, *PART_COMPOSITE_LONG, and *PART_COMPOSITE_LONG_CONTACT.

• Support discrete elements and section properties in Discrete Part objects. You can add discrete
elements and section properties in Discrete Part objects.

• Support Mass Element objects in Parts tree. You can add mass element objects in the Parts tree.

• Support Simple Airbag Models objects in Airbags object. You can add the new Simple Airbag
Models object in the Airbags object.

EM

• Support cell connections among replicated Unit Cells. You can add cell connections among
replicated unit cells by right-clicking the Unit Cell from the Solution Explorer tree and selecting
Cell Connection. From the Property Explorer you can then set the Connection Type, Connected
Isopotentials, and Connected Cells.

Material Library

• Support Plastic materials. You can define plastic materials (compression, tension) by right-
clicking the UserDefined Database and selecting New Material Plastics.

• Support Rubber materials. You can define rubber materials (simplified rubber/foam) by right-
clicking the UserDefined Database and selecting New Material →  Rubber.

• Support constitutive equations for metal materials. You can add new constitutive equations
- such as Johnson Cook, Power Law, Plasticity with Damage, and so forth - for metal materials
in the UserDefined Database.

• Support *MAT_MODIFIED_PIECEWISE_LINEAR_PLASTICITY in UserDefined Database.
*MAT_MODIFIED_PIECEWISE_LINEAR_PLASTICITY is supported in the UserDefined metal mater-
ials.

• New Structural Behavior options for Metal objects. In the UserDefined Database, Structural
Behavior options for Metal objects include SpotWeld (*MAT_SPOTWELD_) and SpotWeld
Daimlerchrysler (*MAT_SPOTWELD_DAIMLERCHRYSLER_).
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• Support Spring and Damper materials. You can define Spring and Damper materials by
right-clicking the UserDefined Database and selecting New Material →  Spring Damper.

• BaoSteel material support. You can add materials from the BaoSteel folder in the Built-in
Database.

• lspp_forming_temp\lspp_matlib_UnitB folder materials. You can add materials from the
...\lspp_forming_temp\lspp_matlib_UnitB folder, which is located in the LS-PrePost
installation path, in the Built-in Database.

2.6. Post Explorer

Fringe

• Moved Fringe legend settings. All Fringe legend settings have been moved to the Fringe legend
right-click menu.

• Record Plot Mode for selected parts. You can record the Plot Mode for selected parts under a
fringe component object. To do this: select the parts from the tree, right-click, and then select Plot
Mode followed by the required mode (for example, Shaded). From the Post Explorer tree, right-
click the Components folder and select the required results view.

BINOUT

• New BINOUT branches. Post Explorer supports the matsum and sbtout binout branches.

• Loading the binary output. LS-PrePost supports loading the Binout, which will be searched for in
current working directory.

2D Graph Viewer

• Integration with 2D Graph Viewer. Post Explorer States are supported in the 2D Graph viewer.
Right-click the viewport and go to Plot Manage to open the view state in the 2D Graph Viewer.

• Improved point selection. Curve points that are selected in the 2D Graph menu are also displayed
in the main window's XY Plot area.

Properties

• Model Title options. You can define the model title using the Title Option. Options include:

By D3Plot. Sets the title based on text found in the *TITLE keyword.

By Working Dir. Sets the title based on the name of the folder where the results are
saved.

User Defined. Allows you to enter a title manually.

2.7. General

General updates to LS-PrePost include:

• SCL from the command line. You can run SCL from the command line.
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• Latest FEMUNZIP libraries. The latest FEMUNZIP libraries (version 17.1.901) are supported.

• *SET_PART_TREE for FEMZIP models. FEMZIP models containing *SET_PART_TREE information
in the Subset Explorer are supported.

3. LS-Run Enhancements

The following enhancements for LS-Run are available in release 2026 R1. Refer to the product-specific
documentation for full details.

• Core Pinning. From the Settings dialog, you can pin each LS-DYNA process to a unique core
ID when running shared memory parallel processing (SMP) or massively parallel processing (MPP)
with Intel MPI on a local machine. This typically increases analysis performance and is beneficial
if, for example, the job is run on a computer with both E-cores and P-cores, as you can specify
that LS-DYNA processes run on P-cores only.

4. Envyo Application

The Envyo application includes new features and enhancements at Release 2026 R1 in the following
areas:

4.1. ACP-to-DYNA Mapping Option Enhancements

4.2. New Workflow Examples

4.3. Performance Improvements

4.1. ACP-to-DYNA Mapping Option Enhancements

The ACP-to-DYNA mapping option includes the following new material keywords and commands:

Material Keywords

• MAT_ELASTIC (MAT_001)

• MAT_HONEYCOMB (MAT_026)

• MAT_LOW_DENSITY_FOAM (MAT_057)

• MAT_FU_CHANG_FOAM (MAT_083)

• MAT_MODIFIED_HONEYCOMB (MAT_126)

Commands

• ConvertTShellsToSolids – Converts single-layered solid elements to *ELEMENT_SOLID_ORTHO
keywords.

• LinearizeQuadraticSolids – Removes all second-order nodes of quadratic solids, and exports ele-
ments as linear solids in the generated keyword file.
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4.2. New Workflow Examples

The following workflow examples have been added:

Continuous Fiber

• Shell to Shell: Single-Layered Draping

• Shell to Shell: Multi-Layered Draping

• Shell to Shell: Multi-Layered Draping with Two Fibers per Integration Point

• Plybook to Shell: Mapping Ply Orientations from *ELEMENT_SHELL_BETA to a Single-Layered Shell

Image Processing

• Grayscale to Shell: Mapping Image-Based Clusters to a Finite Element Model

• Grayscale to Solid: Mapping Adhesive Wetting Damage Parameter to Integration Points

• Point Cloud to Shell: Mapping Temperature Data to Nodes

4.3. Performance Improvements

Addressed bottlenecks reduce processing time by 30–60%.
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Ansys Fluids Products

As part of our commitment to deliver a simplified, modern license experience, Ansys is rolling out updated
license increments to our customers beginning January 2020. Ansys is making these changes so the
Ansys License Interconnect and License Preferences can be eliminated, greatly simplifying the customer
licensing experience. The new license files are fully compatible with previous versions of Ansys back to
release 17.0 when used with Ansys License Manager 2020 R1 or later.

Release notes are available for the following Ansys Fluids products:

Fluent (p. 131)

CFX (p. 153)

CFD-Post (p. 155)

TurboSystem (p. 157)

TurboGrid (p. 159)

BladeBuilder (p. 161)

Polyflow Classic (p. 163)

Forte (p. 165)

Ansys Chemkin (p. 167)

FENSAP-ICE (p. 169)

EnSight (p. 173)

Rocky (p. 183)

Freeflow (p. 177)





Fluent Release Notes
The following sections contain release information for Ansys Fluent 2026 R1.

1. Supported Platforms for Ansys Fluent 2026 R1

2. New Features in Ansys Fluent 2026 R1

3. Updates Affecting Ansys Fluent 2026 R1 Code Behavior

4. Features To Be Removed in a Future Release

Backwards Compatibility: Ansys Fluent 2026 R1 can generally read case files and data files from all
past Fluent releases. Solver and model settings from previous case files are typically respected. However,
in some cases due to defect fixes and core improvements to improve robustness and/or performance,
convergence behavior and/or results obtained may be different. Such release-to-release changes are
documented in the Fluent Migration Manual, along with instructions to recover the previous behavior
when possible.

1. Supported Platforms for Ansys Fluent 2026 R1

Information about past, present, and future operating system and platform support is viewable via the
Ansys website.

2. New Features in Ansys Fluent 2026 R1

The following sections list the new features available in Ansys Fluent:

2.1. Meshing Mode

2.2. Solution Mode

2.3. Fluent Workspace Applications

2.1. Meshing Mode

New features available in the meshing mode of Ansys Fluent 2026 R1 are listed below.

Fluent Guided Meshing Workflows

• The Watertight Geometry Workflow

– Stairstep options for thin volume meshing have been deprecated.

– The parallel region compute option for conformal regions has been added to the Generate
the Surface Mesh task, resulting in improved performance for cases with many objects.

– The following additional controls are now available in the Extrude Volume Mesh task for
extruding periodic zones:
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→ Extend to Periodic Pair

→ Extend Periodic

→ Max Layer Height

– In the Add Local Sizing task, the Ignore Proximity Across Objects option has been added
for controlling proximity size using faces only.

– Autodetection of thin regions has been improved for thin volume meshing. Auto-separated
source and target zones created during thin volume detection are now automatically merged
at the end of volume meshing, resulting in fewer zones and boundary condition settings in
the solver compared to previous releases.

• The Fault-tolerant Meshing Workflow

– The CAD Assemblies capability has been deprecated and will be removed in a future release.
For similar capability consider using the Part Management capabilities.

– In the Add Boundary Layers task, label(s) that have already been assigned boundary layers
will no longer be available in the list of named label(s).

– placeholder

• The 2D Meshing Workflow

– The Axisymmetric Sweep task has been added to the workflow and can be used to create
a 3D mesh by revolving a 2D axisymmetric mesh about a specified axis.

Mesh Generation

• When using curvature size functions with the Rapid Octree mesher, the following are now
supported as full features:

– You now have the ability to change the criterion used for the refinement of the curved
surfaces. The new choices—switched (which is now the default) or arc-estimate—are
less sensitive to surface faceting and can provide refinement even as the facet resolution
increases compared to facets-normal-angle (the default in previous releases). If you
want to revert to the criterion used in previous releases in order to maintain the same cell
counts, you can use the following text command: mesh/rapid-octree/mesh-siz-
ing/curvature-refinement-options/criterion facets-normal-angle

– You can now set maximum and minimum angle thresholds between the two facets for an-
gular refinements with curvature size functions; such settings can be useful, for example,
to exclude sharp corners and to prevent spurious refinements, respectively.

For further details, see Creating Size Functions.

2.2. Solution Mode

New features available in the solution mode of Ansys Fluent 2026 R1 are listed below. Where appro-
priate, references to the relevant section in the User's Guide are provided.
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User Experience

• Search is now available for filtering contents in both Preferences and the Console.

• The Raytracing Display window, where realistic images and volume renders are displayed, now
accepts graphics manipulations such as pan, rotate, and zoom. Refer to Realistic Rendering
Using Raytracing in the Fluent User's Guide to learn more about these types of displays.

Third-party Software

• HOOPS is now updated to 30.14 from 27.23 to address security vulnerabilities.

Solver-Meshing

• When using overset meshes, the Green-Gauss Node Based gradient scheme is now supported
with both the pressure-based solver and the density-based solver. (Overset Meshing Limitations
and Compatibilities)

• When using a mesh interface with the Green-Gauss Node Based gradient scheme, a new expert
option is available that allows you to control the enforcing of bounds on interpolation weights
for solution variables at the nodes of non-conformal interface boundaries. You can enter the
following text command to disable the clipping of the node interpolation weights, which can
improve the quality of gradients at the cells adjacent to the non-conformal interfaces:
solve/set/gradient-options/green-gauss-node-based/weight-treatment-
at-sliding-boundary? yes.

• The following improvements are available when you create a non-conformal mesh interface
using the default one-to-one interface creation method:

– A list is now automatically printed in the console for any associated boundary zone that is
deemed to be over-intersected (that is, a boundary zone that has at least one face in which
the total intersection area for the face is bigger than the area of that face multiplied by a
factor of 1.25), along with metrics that indicate the extent of the over-intersection. This in-
formation is also printed if you list the details of an existing mesh interface. You should in-
vestigate all over-intersected boundary zones, to confirm if their mesh interfaces are properly
defined.

– You can now specify whether the lists of mesh interfaces printed in the console are ordered
by their overlap area (that is, the area that the two boundary zones overlap) or by their
overlap area percentage (that is, the overlap area divided by the area of each of the two
boundary zones). Previously the lists were always ordered by the overlap area percentage.

– You can now define a minimum area of overlap that is used to create mesh interfaces when
zones are paired using the automatic method. This can help you avoid unnecessary or unin-
tentional mesh interfaces. Previously you could only define a minimum overlap area percent-
age.

– When you are deleting existing mesh interfaces that have small overlap, you can now specify
an area that is used for deletion: if the area that the two boundary zones overlap for any
mesh interface is less than this value, then it will be deleted. Previously you could only
specify an overlap area percentage for deletion.
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– The non-conformal interface surfaces from one-to-one mesh interfaces now participate in
postprocessing operations. Note that for the non-overlapping face zones, the faces adjacent
to the intersected zone will only be displayed or contribute to integrals if they are sufficiently
large compared to their parent faces (and then the parent faces will be used).

For details about non-conformal mesh interfaces, see Using a Non-Conformal Mesh in Ansys
Fluent.

• The following improvements are now available when deleting or deactivating cell zones:

– You can now delete or deactivate a cell zone with boundary zones that are non-manifold.
This was previously possible in the meshing mode of Fluent and is now also supported in
the solution mode. This can be useful when postprocessing for example, as you can visualize
a single small zone by deactivating all of the other zones.

– Fluent now robustly handles attempts to delete or deactivate a cell zone with a boundary
zone that has misoriented faces; while such an action has never been and is still not fully
supported, it will no longer result in a broken mesh or the abnormal termination of Fluent,
and this allows you proceed using Scheme commands at your own risk (as noted in warning
messages in the console).

For details about deleting and deactivating cell zones, see Deleting Zones and Deactivating
Zones, respectively.

• It is now possible to extract cells that are marked by a specified cell register (as well as any
specified additional layers of neighboring cells), so that they are preserved and all other cells
in the mesh are deleted. Extracting cells can be useful when working with a large mesh that
is difficult to manipulate, as it can allow you to focus on a small region of interest and easily
perform actions such as postprocessing. (Extracting Cells)

• You can now easily fuse all of the contacting face zones between selected cell zones, rather
than having to select all of the individual face zones. This is particularly useful if you have
disconnected cell zones and want to reestablish connection. (Fusing Face Zones of Selected
Cell Zones)

• The ability to project the nodes from one or more boundary zones so that they are moved to
be coincident with an auxiliary geometry definition is now supported as a full feature. This
can be useful for sliding mesh simulations, as you can make sure that all of the nodes of a
boundary pair for the non-conformal interface are on the same plane or on the same surface,
in order to reduce simulation errors. (Projecting Boundary Zones Onto an Auxiliary Geometry
Definition)

Cell Zones and Boundary Conditions

• When using the pressure-based solver with a turbulence model, a treatment option is now
enabled by default, such that the effects of turbulence wall functions are removed at walls
where you have specified zero shear. This treatment applies the Neumann boundary condition
for the turbulence quantities, so that the walls behave as symmetric boundary conditions. This
enhances the convergence, as no turbulence wall modeling is performed. It is possible that
this treatment may make minor changes to the solution near the wall, but they should not be
meaningful. You can disable this treatment by entering the following text command:
solve/set/advanced/specified-zero-shear-alternative-treatment? no.
(Specified Shear)
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• When using the pressure-based solver, a new treatment is applied by default to the following
boundary conditions, in order to avoid inaccurate flow prediction when the direction specified
is not well aligned with the local boundary face normal:

– pressure inlets with Direction Vector selected from the Direction Specification Method
drop-down list (see Pressure Inlet Boundary Conditions)

– pressure outlets that: have the Prevent Reverse Flow option disabled; have either Direction
Vector or From Neighboring Cell selected from the Backflow Direction Specification
Method drop-down list; and experience backflow conditions (see Pressure Outlet Boundary
Conditions)

If you do not want to take advantage of this increased accuracy, you can undo the default
treatment for pressure inlets and pressure outlets with misaligned directions using the appro-
priate prompt of the following text command: solve/set/previous-defaults/undo-
2026r1-default-changes?.

Heat Transfer / Radiation

• You can now model ambient radiation to the external environment without needing to create
a fluid box around the geometry. This significantly simplifies the case set up by eliminating
the need to mesh/model the fluid medium between surfaces and can also significantly reduce
computation time. (Ambient Radiation Modelling)

• The Macro heat exchanger model now supports non-conformal interfaces at flow inlets and
outlets.

Turbulence

• The original version of the GEKO model (GEKO_2015) has shown some conceptual weaknesses
which have motivated a moderate re-formulation (GEKO_2024) in order to improve tuning
capabilities. The main issue was the need to separate the tuning coefficients of the model
between coefficients affecting boundary layers and coefficients affecting frees shear flows.

The improved GEKO_2024 is the default GEKO model version in 2026 R1. The original GEKO_2015
is still available, but the recommended model version is GEKO_2024.

Note that in .cas files created with Fluent versions previous to 2026 R1 which not have GEKO
enabled, the default GEKO version will be set to 2024 in the background and version dependent
coefficients (CMIX, CJET and CJET_AUX) will be adjusted to their default values.(Generalized
k-ω  (GEKO) Model)

• For the WALE LES model, the turbulence length scale is now limited close to the walls for high
aspect ratio meshes. This improves solver stability for cases with poor mesh quality and without
influencing the solution and separation prediction on isotropic meshes. (Wall-Adapting Local
Eddy-Viscosity (WALE) Model)

• When using the GPU solver with the LES model, for near-wall treatment, you can now have
the input fields used for wall-function evaluation be taken from the second cell off the wall.
(Features Supported by the Fluent GPU Solver)
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• When using the GPU solver with either the kω-SST or GEKO models, the tabulated Near-Wall
Treatment is now available in addition to the correlation method. (y+-Insensitive Near-Wall
Treatment for ω-based Turbulence Models)

Turbo Setup Workflow

• Performance gains have been notably improved when copying and merging multiple cell
zones in the Turbo Setup Workflow.

Discrete Phase Model

• For simulations that involve the Lagrangian wall film (LWF), a new caloric temperature treatment
is now available for the film temperature calculation. The treatment provides improved accuracy
in cases where:

– the particle material has temperature-dependent specific heat

– the film consists of two or more materials with different physical properties that coexist on
the same wall face

For more information, see Calculation of Wall Film Face Variables in the Fluent Theory Guide.

• In coupled simulations with the GPU solver, the Linearize Source Terms option is now fully
supported for species sources.

• In simulations with the GPU solver where particle species are evaporating, the binary diffusivity
of the particle material can now be modeled using the film-averaged approach.

• For cases involving the film-to-wall heat transfer model, you can now specify the distance
between the film starting position and the heat transfer region. This capability can significantly
improve the accuracy of convective film heat transfer simulations, particularly when the film
start point is upstream of the heat transfer region. (Setting the Film-to-Wall Heat Transfer
Model)

Multiphase Models

• A text command, solve/set/multiphase-numerics/interphase-interac-
tions/turbulent-dispersion/disable-turbulent-dispersion-next-to-
flow-boundaries?, is now available for disabling momentum sources due to turbulence-
dispersion in cells next to flow boundaries. In certain cases this can significantly improve
convergence.

• For Eulerian multiphase cases that involve the critical heat flux (CHF) boiling model, droplet
diameters for the primary phase can now be modeled as a constant or using the bending
diameter model. (Procedure for Setting the Boiling Model in the Fluent User's Guide)

• For the wall boiling model, a new text command, solve/set/multiphase-numer-
ics/boiling-parameters/bubble-diameter-model-options, has been added.
The command allows you to select between the default and Unal bubble diameter modeling
options. This functionality was accessed through a scheme command in previous releases.

• For multiphase species-transport simulations, a vanishing phase treatment has been introduced.
The treatment respects initial mass fraction values in cases where phase change depends on
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partial pressure or where species transfer occurs between phases. (Modeling Multiphase Species
Transport)

Electric Potential Field and Electrochemistry Model

• The Electrolysis and H2 Pump Model has been renamed Electrochemical Devices and has
been enhanced with the following capabilities:

– The following new device types have been introduced:

→ Solid oxide fuel cell (SOFC)

→ Solid oxide electrolysis cell (SOEC)

→ Customized electrochemical reactions

See Electrochemical Devices in the Fluent Theory Guide for details.

– The ability to account for species diffusion through the membrane of electrochemical devices
has been added. (Setting Advanced Options (Advanced Tab))

– In the unresolved electrochemistry model, you can now customize the membrane electrolyte
conductivity via the DEFINE_ELECTROLYSIS_COND user-defined function (UDF). For details,
see DEFINE_ELECTROLYSIS_COND in the Fluent Customization Manual.

• For the Lithium-ion battery model, the following additional postprocessing quantities are now
available in the Lithium... category:

– Overpotential in Li-Intercalation Reaction

– Overpotential in SEI Growth Reaction (aging model)

– Overpotential in Li-Plating Reaction (aging model)

For definitions of these field variables, refer to Alphabetical Listing of Field Variables and Their
Definitions in the Fluent User's Guide.

Battery Model

• The following battery modeling capabilities are now supported with the GPU solver:

– CHT Coupling solution method

– Joule Heat in Passive Zones energy source option

– Battery ROM tool kit

• For the Newman's P2D model, you can now import model parameters from a BPX-format JSON
file using the BPX file reader. (Inputs for the Newman’s P2D Model)

• When using the ROM tool kit, you can now specify a heat flux distribution on selected walls
(Create ROM Training Data (ROM Data Creator Tab))

• For the one-equation thermal abuse model, the parameter estimation tool is now available in
the graphical user interface (GUI). Consequently, the Standalone Thermal Abuse Model dialog
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box has been renamed to Fitting Tool/Standalone Thermal Abuse Model, and the Preview
Thermal Abuse Model... button in the Battery Model dialog box (Advanced tab) has been
renamed to Fitting Tool/Standalone Model.... (Fitting Tool/Standalone Thermal Abuse Model)

Proton Exchange Membrane Fuel Cell (PEMFC) Module

• The degradation model to simulate degradation processes in the membrane is now available.
(Setting Material Chemical Degradation)

Solver

• When using the Green-Gauss Node Based gradient scheme, the improved treatment of symmetry
and periodic boundaries in the node-based reconstruction gradient is now available for the
pressure-based solver. This treatment ensures that the gradient respects symmetry and peri-
odic constraints at the discrete level, thus better matching results obtained on an untruncated
domain. (Green-Gauss Node-Based Gradient Evaluation)

• When using the pressure-based solver, you can now use a user-specified gradient scheme to
compute the reconstruction gradient that is used in the second-order pressure interpolation.
This allows better accuracy of the second-order scheme compared to the current default (which
is based on the Green-Gauss Cell Based scheme for general unstructured meshes). To use the
user-specified gradient scheme, enter the following text command: solve/set/gradient-
options/pressure-reconstruction-type? yes.

• When using the Least Squares Cell Based gradient, you can now control the weighting factor
used in the assembly of the least squares matrix system that computes the gradient weights.
You can specify that the weighting factor is unweighted, inverse distance weighted, or the
default inverse distance squared weighted. The use of unweighted or inverse distance weighted
may result in improved accuracy, especially at physical boundaries. To specify the weighting
factor, use the following text command: solve/set/gradient-options/least-
squares/weighting-factor.

• When using the pressure-based solver, you can now apply the PRESTO! pressure interpolation
treatment at fluid physical boundaries. This is intended to be used with any other pressure
interpolation scheme besides PRESTO!, in order to improve the flow prediction without being
subject to the mesh size sensitivity of the PRESTO! scheme. (Choosing the Pressure Interpolation
Scheme)

• You can now specify the use of the bi-conjugate gradient stabilized method (BCGSTAB) for
the energy equation in all future sessions of Fluent by enabling the BCGSTAB for Energy
Equation option in the Simulation branch of the Preferences dialog box (accessed through
File/Preferences...). This can be helpful with conjugate heat transfer (CHT) problems, as de-
scribed in Conjugate Heat Transfer. For further details about the BCGSTAB method, see Setting
the Stabilization Method.

Fluent Native GPU Solver

• The following improvements are available when using expressions for report definitions and
unsteady statistics with the GPU solver:

– Additional fields are now supported as a full feature for fully supported models, including
fields for material properties, turbulence modeling, reaction and combustion, the volume
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of fluid (VOF) model, and user-defined scalars (UDS). For the full list of supported fields and
other details, see Using Expressions with Report Definitions and Unsteady Statistics.

– When creating an expression report definition, the selection of existing report definitions
as part of the definition is now supported. For further details, see Using Expressions with
Report Definitions and Unsteady Statistics.

• When using the GPU solver, CPU/GPU remapping is now supported with asynchronous (async)
outputting, as long as the case does not have a command defined through the Execute
Commands dialog box for execution during the calculation that requires downloaded data
from the GPU. For further details about these features, see CPU/GPU Remapping and Asyn-
chronous Outputting, respectively.

• When using the GPU solver, asynchronous (async) outputting is now supported when automat-
ically exporting solution data as EnSight DVS files during a calculation. For further details about
these features, see Asynchronous Outputting and Exporting Solution Data as EnSight DVS Files,
respectively.

• The GPU Solver can now be started in hybrid precision, resulting in improved performance
and memory consumption when compared to the double precision solver.

• Supersonic inflow (ideal gas only) is now supported at velocity inlets and mass flow inlets.

• For the Potential/Electrochemistry model, time-dependent values and contact resistance can
now be specified at wall boundaries.

• Vertex Average, Vertex Minimum, and Vertex Maximum monitors can now be defined on zone,
point, and plane surfaces.

• Monitors can now be defined on iso-surfaces.

Graphics, Reporting, and Postprocessing

• You can create key frame-based animations without having a case or data file loaded by using
HSF animation files. Refer to HSF File and In Memory Key Frames in the Fluent User's Guide for
additional information.

• Volume rendering is now full feature, allowing you to create images like Figure 8: Example
Volume Rendering with Mesh (p. 140). These volumes can also be included within animation
definitions. Refer to Displaying Volume Renderings in the Fluent User's Guide for additional in-
formation.
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Figure 8: Example Volume Rendering with Mesh

• You can now create new and access existing graphics objects (such as contours, vectors,
pathlines, and so on) prior to reading a data file or initializing the flow field.

• The import of STL surfaces is now done through the External Surface dialog box. This new
approach (previously import was done using the Imprint Surface dialog box) uses a better
algorithm that results in superior data mapping. Refer to External Surfaces in the Fluent User's
Guide for additional information.

• You can now split surfaces, such as planes or external surfaces, at each location where that
surface crosses a boundary, allowing for greater granularity in postprocessing. Refer to Split
Surfaces in the Fluent User's Guide for additional information.

• The iso-surface and iso-clip algorithm is improved.

– For iso-surfaces, it offers improved performance, particularly when creating multiple surfaces
at once. It also has improved handling of boundaries during surface creation.

– For iso-clips, faceting is improved.

Adjoint Solver Module

• The prescribed profile boundary condition within the design tool can now be defined using
an expression with multiple input parameters.

• The Export Cad dialog box can now be accessed within the design tool, enabling export of a
modified geometry as a CAD file for use in other CAD software packages.

Fluent for Arm

• The following features are now supported with Fluent for Arm:
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– Sundials in reacting flow models

– Fluent native GPU solver with NVIDIA GPUs

For more details, see Running Ansys Fluent on Arm Compute Nodes.

Parametric Studies

• With the ability to run concurrent design point sessions (either locally or remotely) directly
from the parametric study, the need to save journal files for submission to a job scheduler or
to run the journals in different Fluent session(s) is no longer required. Therefore, the Save
Journal option(s) has been removed from the graphical user interface (that is, the ribbon and
the corresponding context menu). The functionality remains available in the text user interface,
but will be deprecated in a future release.

• In addition to configuring remote cluster job submission details for concurrent parametric
design point studies, you can now submit your remote concurrent parametric jobs directly to
Ansys Cloud Burst (see Configuring Remote Concurrent Parametric Sessions for details).

Simulation Reports

• You can choose to manage your data and generate your simulation reports using a local
server (the default), or by directly updating a ("serverless") database with the Ansys Dynamic
Reporting Workflow. You can choose the more direct approach using preferences (under the
Simulation Reports heading of the Simulation category in the Preferences dialog box

Cloud Computing and Remote Resources

• When specifying journal file details while submitting a remote or cloud-based job submission,
you can now automatically generate a simulation report as either HTML, PDF, or as a PowerPoint
presentation (see Specifying Journal Details for Remote or Cloud Jobs for details).

• From within your Ansys Fluent session, you can now choose to submit a single Fluent job to
any HPS-supported remote cluster (see Performing Calculations Using Remote Resources for
details).

• Improvements have been made when managing and the viewing the details of jobs submitted
to Ansys Cloud Burst or to other remote resources, such as being able to rerun jobs or manually
refresh job details (see Viewing and Managing Existing Remote or Cloud Jobs Within Your
Ansys Fluent Session for details).

• Improvements have also been made when viewing and managing existing jobs on a remote
cluster or cloud-based resources (see Viewing and Managing Existing Remote or Cloud Jobs
Within Your Ansys Fluent Session for details).

Cell Registers

• It is now possible to visualize a cell register in the context of the rest of the mesh using the
Contours dialog box. (Overset Meshing Limitations and Compatibilities)

Load Managers

• When running Fluent under LSF or PBS Professional, it is now possible to use the -sched-
uler_ppn=<x> and/or -scheduler_gpn=<x> command line options, in order to set the
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node processes per cluster node and/or the graphics processing units (GPUs) per cluster node,
respectively. (Scheduler Options)

Web Interface

• The Outline View is now referred to as the Settings Tab, whose visibility can now be toggled
by clicking the corresponding icon in the upper left hand side of the graphics window.

• By right-clicking the Graphics branch in the tree, you can use the Apply Mirror Planes...
context menu item to display the Apply Mirror Planes panel where you can define planes
around which you can mirror what is displayed in the graphics window.

• If an item in the tree contains a context menu, you can either right-click to display the menu
or you can click the icon that appears when you hover over the item in the tree.

• Additional controls are presented under View options in the View Arc. For instance lighting
controls that can provide subtle lighting effects such as ambient or specular lighting, as well
as distance measurement tools.

• There is an additional view-related tool for saving what you see in the graphics window from
time to time. Clicking the icon in the upper right-hand side of the graphics window, you can
save the current view.

• Unit specifications are available from the Units menu option from the File menu. This opens
the Display Units dialog box where you can view and edit the unit settings for a variety of
quantities (see The Main Menu for more information).

• When there are multiple processes that need to be monitored, a badge will indicate the
number of processes. Clicking the badge opens a Progress panel displaying all ongoing progress
indicators and their status.

• You now have the ability to create new surfaces when postprocessing your simulation results
for meshes, contours, vectors, pathlines, and particle tracks. In the Surfaces field, click the '+'
button to access the list of possible surface types to add to the list of potential surfaces for
your postprocessing objects.

• You can now configure axes and curve settings for a variety of plots, such as histogram plots,
XY plots, cumulative plots, residual plots, and report plots.

• You can start and stop the recording of Python journal files using the File > Write menu (see
The Main Menu for more information).

In addition, you are now able to copy Python commands and paste them into the clipboard,
as well as download multiple lines of Python commands to a file on the server (see The Console
Panel for more information).

• For panels with tabular data (such as materials-related panels with, for example, polynomial,
piecewise polynomial, or piecewise linear data), you can now import or export comma separated
values (CSV).

In addition, for such materials-related panels as well as such panels as the Power Law and
Sutherland Law viscosity input panels, you can now preview and plot tabular data.
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• Several enhancements have been introduced to various panels throughout the web interface,
such as:

– Making relevant commands more readily available, especially in object editor panels.

– Updating the colormap selection.

– Improving tabular data inputs (for example, polynomials).

– Improving in-line searching when selecting field variables.

– Allowing the height of panels to be adjustable.

• Display is now available at several locations including:

– Interfaces

– Cell registers

• The Non-Equilibrium Thermal Model (NETM) is now available in the web interface.

• The mixture multiphase model is now available in the web interface.

• The volume of fluid (VOF) multiphase model is now available in the web interface.

• You can now create new and access existing graphics objects (such as contours, vectors,
pathlines, and so on) prior to reading a data file or initializing the flow field.

• Field level unit specification is improved to allow you to type the desired units inline with the
value as well as offering a drop-down showing the equivalent value in the other valid units,
as shown in Figure 9: Example Inline Unit Drop-down (p. 143).

Figure 9: Example Inline Unit Drop-down

• Mesh Interface creation is improved and simplified, as well as offering diagnostics to help inform
you of the overlap which you can use to determine whether the interface is physically relevant.
Refer to Accessing Mesh Interface Settings in the Fluent User's Guide for additional information.

• You can now review cell zone adjacency and do bulk renaming of cell zones in the Adjacency
panel, opened from a right-click of the Cell Zone Conditions node in the Settings tree.
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Beta Features

• There are also some exciting new enhancements available as beta features that you may be
interested in trying out. Detailed documentation is in the Fluent 2026 R1 Beta Features Manual.

2.3. Fluent Workspace Applications

New features available in the client applications of Ansys Fluent 2026 R1 are listed below.

Fluent Icing

Fluent Icing allows you to easily conduct in-flight icing simulations within a dedicated Fluent
Application Client environment. The following additional functionality has been added in this
release.

• Constant roughness output for iced surfaces

The beading roughness output option in the ice physical models section updated to provide
a choice between constant roughness or beading as the output roughness height from ICE3D.
Constant roughness option will output the user specified roughness height on the iced areas
only.

• Water film reinjection with DPM (beta)

Water film that accumulates at trailing edges or separation lines can now be released into the
flow with the Lagrangian particle tracking model in the multi-shot and CHT workflows.

• Particle impingement update during CHT anti-icing with DPM (beta)

The anti-icing simulations using Lagrangian tracking and impingement can now have the
particle tracks reevaluated at each CHT loop, to recompute collection efficiency with changes
in droplet splashing and bouncing and ice crystal sticking efficiency. This capability can also
be coupled with DPM water film reinjection to represent water film shedding from heated
surfaces.

Changes to existing features and behavior

• DPM mixing plane

Mixing plane implementation that transfers particles collected at the exit of an upstream tur-
bomachinery row to the downstream row is updated for accuracy and robustness. Particles
that arrive at the mixing plane outlets are collected in a high-resolution bin distribution with
individual flow rate radial profiles. Vapor flow rate profile is included as a separate bin before
the particle bins. The out.mpdat file that lists these radial profiles for each bin can be used
to plot changes in radial flow rate distributions of bins as they move from one row to the next.
Effects of physical phenomena like ice crystal shattering (if provided via UDF) can be observed
as changes in particle size distribution and flow rates past rotors.

• ICE3D solution field profile macros for multishot UDFs

Some ICE3D solution fields are now automatically extracted as Fluent boundary profile data
which can be used as inputs for UDFs in the next shot in multi-shot workflows with UDF
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macros specifically assigned to these variables. This replaces the need to define UDMs and
assign icing values to them at the completion of an ice run, simplifying the use of icing solution
in particle/wall interaction UDFs that control splashing, bouncing, shattering, and sticking effi-
ciency.

• Multishot runs

– Multishot runs will no longer remesh the last shot and list the last shot + 1 entry in the
project view. Calculations will stop with the final ice step. Users can continue the multishot
resuming from the mesh update step of the last shot and increasing the number of shots.
This avoids waiting for the last remeshing step when it is not needed.

– The first shot’s mesh will not be loaded automatically when a multishot ends. This is done
to keep the last shot’s volume solution fields in memory to allow post processing. When
using very large grids, having to reload the last shot’s case and data files to post-process is
costly. Now the last solution will be readily available at the end of the run.

– To start a new multishot from the original grid, users MUST hit the Reset Multishot button
to reload the original grid, as this is no longer done automatically. If there is a restart air
solution to be provided, this has to be loaded manually as well after reloading the initial
case file.

– Custom multishot feature corrected, and the button to display the shot-by-shot settings is
moved adjacent to the drop down menu. The only available parameter to vary in this version
is the icing time per shot.

– If remeshing fails during a multishot run, the last shot will be reloaded and restart step will
be set to Mesh Update. Users can make changes in meshing settings like edge sizing, mater-
ial point coordinates and wrap resolution factor to retry remeshing.

• De-icing CHT run memory management

A defect with the FENSAP library was causing a cumulative memory leak in the multishot
workflows, which resulted in de-icing simulations with many time steps and inner iterations
to crash when the available memory is completely filled. The problem is corrected which extends
the number of time steps de-icing simulations can run.

• DPM inlet velocity specification

Lagrangian tracking can now assign air flow velocities to particle tracks at inlets. This is done
by unchecking the velocity option on the inlet boundary panel for particles, as done similarly
for the Eulerian (DROP3D) implementation.

Fluent Aero

Fluent Aero allows you to easily explore the aerodynamic performance of aircraft under a wide
range of flight regimes, from subsonic to hypersonic conditions, all within a dedicated Fluent
Application Client environment. A streamlined workflow guides you through the creation of a
matrix of flight conditions or design points where single and multiple flight parameters, such as
angle of attack, Mach number, altitude, etc., can vary. Most common models, solvers, and con-
vergence settings of Fluent are tuned using the latest best practices for external aerodynamic
problems and are available in Fluent Aero’s user interface. In this manner, simulations can be
conducted in a quick and user-friendly environment. The full capabilities of the Fluent Solution
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workspace remain accessible when its session is displayed through Workspaces → Solution
within the Fluent Aero ribbon. Tutorials are available to provide examples on how to conduct
exploratory simulations using single and multiple flight parameters.

In this release, a broad range of features have been added and are described below.

• Mesh Adaption

– A new combined Hessian Indicator has been introduced that uses Entropy (Combined Hes-
sian - Entropy) instead of Turbulent Viscosity (Combined Hessian - Turbulence). This indicator
has been identified as more generic and cost-effective when producing accurate RANS results
during the High-Lift Workshop 5.

– Extra wall monitors have been added to track average temperature and heat flux convergence
during adaption cycles as appropriate for high-speed flow simulations.

– It is now possible to Interrupt an adaption cycle and to directly continue to the next cycle
or the next design point without losing the interrupted cycle data.

• Expansion of Unit Systems (Beta)

– An additional unit system has been added to Fluent Aero, US Engineering Common. This
new unit system is similar to the US Engineering system but with changes to the units rep-
resenting angle, length and temperature quantities.

– The latest unit system used in a simulation is automatically saved and reloaded between
simulations.

• Overset Meshes for Parametric Analysis (Beta)

– Geometric Parametric Analyses can be conducted using Overset Meshes in Fluent Aero. In
this release, an aircraft component inside an overset mesh can be combined with a back-
ground mesh, that contains the aircraft, to conduct parametric simulations by varying the
angular position of this component per design point. Therefore, it is now possible to study
the impact of an aircraft component on the performance of the entire aircraft.

– Multiple overset meshes can be supported in Fluent Aero-with or without mesh adaption
per design point.

– Geometric Parametric Analyses with Overset can be conducted using RANS and URANS in
2.5D and 3D simulations in Fluent Aero.

• Transient Calculations (Beta)

– URANS calculations have been introduced in Fluent Aero to capture the natural transient
flow behaviour of certain conditions per design point.

– Convergence Criteria and Default or Robust Convergence Settings based on best practices
have not been introduced and therefore these settings should be specified in the baseline
case file.

– Transient calculations can start from a previously steady state solution computed with or
without mesh adaption in Fluent Aero.
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– Intermediate URANS solutions can be saved to post-process results.

– Only instantaneous aerodynamic forces and moments are provided through tables and
graphs of Fluent Aero. Time-averaged solutions are not provided.

– Prescribed time-dependent sinusoidal oscillatory angular motions are supported at each
overset aircraft component to study transient aerodynamic responses.

Polyflow

The Polyflow workspace is a means to explore manufacturing applications of highly viscous ma-
terials such as polymer extrusion, blowmolding, fiber spinning, etc. within the Fluent environment.

• Polyflow Workspace Add-In for Workbench

Gives access to a complete workflow, geometry modelling to results analysis, in the Workbench
environment.

• Statistical analysis

Allows statistical analysis as in the Polystat tool of the Polyflow Classic. Relies on CFD-Post to
create relevant animations.

• Adaptive meshing for large variations of field

Allows to refine the mesh to limit the variation of specific fields on a finite element.

• Surface tension for 2D and 3D free surfaces

Allows to include surface tension forces in flow modelling and dynamic contact point in 2D.

• Calibrator model

Allows to simulate actual calibrators that shape and cool extrudate as well as conveyors that
support profiles in extrusion lines.

• Mesh quality postprocessor (beta)

Allows to display element quality metric when transient mesh deformation occurs, possibly
with mesh adaption.

• Velocity imposed on a free surface (beta)

Allows to prescribe the motion of a free surface via its velocity in transient simulations.

• Electrical heating (beta)

Allows to calculate the electric potential field and its joule effect on the fluid temperature.

3. Updates Affecting Ansys Fluent 2026 R1 Code Behavior

The following sections list the code changes in Ansys Fluent 2026 R1.

3.1. Meshing Mode
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3.2. Solution Mode

3.3. Fluent Workspace Applications

General

3.1. Meshing Mode

This section contains a list of code changes implemented in the meshing mode of Ansys Fluent 2026
R1 that may cause behavior and/or output that is different from the previous release.

Mesh Generation

• When using the Rapid Octree mesher, the following improvements affect the code behavior:

– The smooth mesh coarsening option is now enabled by default for the Rapid Octree mesher,
so that the refined cells follow the geometry better. This option increases cell quality in
most cases, and can reduce the overall cell count while maintaining a comparable level of
accuracy. If you do not want to take advantage of this option, you can disable it by entering
the following text command: mesh/rapid-octree/mesh-sizing/smooth-mesh-
coarsening? no. (Mesh Parameters)

– When you specify a reference size (in order to precisely set the edge length for the maximum
cell size), the Rapid Octree mesher bounding box will now retain its extents better than in
previous releases. Typically it will not be revised at all, and if it is revised, it will only undergo
a slight change (up to the maximum cell size). For setups that use the Bound by Bounding
Box or Selected Material Points for the Volume Specification, you should still verify that
the bounding box is properly located after specifying the reference size. (Defining the Ref-
erence Size)

• In previous releases, reading a case file into the meshing mode of Ansys Fluent and then
writing out a mesh file would store the original case file version number in the resulting mesh
file. If this mesh file was used to set up simulations in later versions of the solver mode of
Ansys Fluent, this could result in older solver defaults / behaviors being used unexpectedly.

In release 2026 R1, this case file version information is omitted from any mesh file written by
meshing mode. Note that this change does not affect meshes newly created from geometry
in meshing mode, as case file version info was never present unless starting from a case file.

3.2. Solution Mode

This section contains a list of code changes implemented in the solution mode of Ansys Fluent 2026
R1 that may cause behavior and/or results that are different from the previous release.

Solver-Meshing

• The following improvements are now available when fusing face zones:

– The fusing performance is much faster, especially when fusing a large number of face zones.
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– When fusing multiple zones, the naming convention for the resulting zones is improved to
be that of the first zone of each fused zone pair, which can help to identify and track the
zones.

– The information printed in the console during fusing is improved: unnecessary warnings are
removed, more detailed information is provided (including the IDs of the fused zone pairs
and the resulting zones), and a summary is included at the end that provides the number
of zone pairs that were fused.

For information about fusing face zones, see Fusing Selected Face Zones.

• When you perform a mesh check, additional checks are now performed to detect mesh degen-
eracy. You should repair the mesh if any degeneracies are found, as they may cause the solver
to fail or may compromise the solver robustness. (Checking the Mesh)

Solver-Numerics

• Minor inconsistencies are now corrected in the wall distance calculation (when using the default
geometric method) for double-precision cases.

Cell Zones and Boundary Conditions

• Fluent now has an improved method for handling name conflicts for cell zones and boundary
zones. A name conflict arises when a new zone is created (by actions such as copying a cell
zone, appending a case file, and so on) and the name initially generated with the default
convention is already used by an existing zone, and so the proposed zone name must be
modified. The new handling for name conflicts produces names that have improved consistency
and readability, and may be more intuitive for wall-shadow pairs. Note that while the names
for new zones may differ compared to those generated in previous releases, the IDs will remain
the same.

For example, one of the changes in handling name conflicts can be seen in the following: if
you were to repeatedly append the same case file with a cell zone named fluid using the
previous release, you would end up with cell zones named fluid.1, fluid.1.1, and
fluid.1.1.1, whereas in the current release those same zones would be named fluid.1,
fluid.2, and fluid.3, respectively.

Multiphase Models, DDPM Models

• The solution results may now be more accurate for granular multiphase cases that involve the
filtered drag model in the Euler/Euler model and the DDPM model on coarse meshes due to
a correction of the terminal velocity calculations.

• For cases that use the incompatible combination of the alternative energy treatment for in-
terphase mass transfer and real gas property (RGP) tables, the default sensible enthalpy formu-
lation will be used instead of the alternative formulation. Consequently, you may notice changes
in solution results, as the default formulation properly accounts for the heat source due to
mass transfer.

Fluent Native GPU Solver

• The default group size for the coupled linear solver is now reduced from 8 to 4, in order to
improve the robustness of the coupled linear solver. To revert this change, enter the following
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Scheme command in the console: (rpsetvar 'gpuapp/amg-coupled/group-size
4).

• When using the pressure-based solver with a segregated scheme for the pressure-velocity
coupling, the linear solver now respects the cycle type that you have specified for pressure.
This is used primarily for some reacting flow workflows where this setting is set explicitly to
enhance robustness. To revert this change, set the pressure cycle type to its default setting of
V-Cycle (for example, in the Multigrid tab of the Advanced Solution Controls dialog box).

• At porous interfaces, pressure is now extrapolated in the normal direction only, in order to
improve robustness issues at fluid-porous interfaces with skewed meshes. There is no way to
revert this improvement.

• For compressible transient flows that use the pressure-based solver with a segregated scheme
for the pressure-velocity coupling, the solver now uses the pressure relaxation factor for the
compressible transient linearization to give faster convergence within a time step, and for
consistency with the CPU solver. To revert this change, enter the following Scheme command
in the console: (gpuapp-set-bool “flow/full-transient-compressible-
pressure-relaxation" #t).

• For LES / SBES simulations, the discretization of normal stress at walls and of the velocity
gradients used to compute the turbulent viscosity have been modified to improve robustness.
To revert this change, enter each of the following Scheme commands in the console:

– (gpuapp-set-string "turbulence/normal-stress-option-at-walls"
"turbulent")

– (gpuapp-set-bool "turbulence/use-lsq-grad-for-turbulent-viscosity"
#f)

Graphics, Reporting, and Postprocessing

• The iso-surface and iso-clip algorithm is improved:

– For iso-surfaces, it offers improved performance, particularly when creating multiple surfaces
at once. It also has improved handling of boundaries during surface creation. Note that
there may be some differences when comparing with previous releases. In particular, minor
changes in appearance may occur when all edges are displayed. Faceting may also be slightly
different.

– For iso-clips, faceting is improved. Note that there may be a noticeable change in the facet
count or in edge displays.

Use the surface/settings/previous-defaults/pre-26.1-algorithm text com-
mand to revert to the earlier algorithm.

3.3. Fluent Workspace Applications

This section contains a list of code changes implemented in the client applications of Ansys Fluent
2026 R1 that may cause behavior and/or output that is different from the previous release.
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Polyflow

• The number of processors used by the workspace solver has been increased from 2 to
4 processors.

–

– Mesh objects created by the workspace no longer use generic naming conventions
(mesh-1, mesh-2, etc.) by default. The new default is to use the topological names
found in the mesh file. The behavior can be changed using Preferences. See Setting
Preferences for Polyflow in the Fluent Workspaces User's Guide for details.

4. Features To Be Removed in a Future Release

This section contains a list of features that are supported in Release 2026 R1, but will be removed in a
future release of Ansys Fluent. It is recommended that you begin to migrate any cases that use these
features at your earliest convenience.

Solution Mode

• Discrete Phase Model

– Shared-memory parallel DPM tracking is deprecated and will be removed in a future release.

Graphics, Reporting, and Postprocessing

• The Imprint Surface feature is deprecated and will be removed at a future release. The dialog
box is already removed, but the feature is still available using the surface/create-imprint-
surface TUI command. The recommended replacement is External Surfaces (External Surfaces).

151
Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.

Features To Be Removed in a Future Release



Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.152



CFX Release Notes
The following sections contain release information for Release 2026 R1 of Ansys CFX.

1. Supported Platforms

2. New Features and Enhancements

3. Incompatibilities

1. Supported Platforms

Platform/OS levels that are supported in the current release are posted on the Ansys website.

Note:

• If you are using CFX-Pre, CFD-Post, or TurboGrid on a remote machine and the geometry
is not appearing in the viewer, try turning off the following user preference: Common >
Viewer Setup > Double Buffering.

2. New Features and Enhancements

This section lists features and enhancements that are new in Release 2026 R1 of Ansys CFX.

• There are two new GUI style (theme) options: Dark and Light.

When starting CFX-Pre (or any other CFX software) for the first time, a dialog box appears that enables
you to choose a GUI style (theme). When a GUI style is selected, it is stored as the GUI Style user
preference for future sessions. For details, see Starting CFX-Pre in the CFX-Pre User's Guide.

• Aerodynamic Damping monitors are now more like expression monitors:

– You can define monitor statistics for aerodynamic damping monitors.

– Within a CEL expression, you can use the probe function to refer to the current value from an
aerodynamic damping monitor.

• For Generalized Force monitors in transient blade row cases that have time integration and that do
not accumulate Fourier coefficients as part of the pitch-change model, there is a new Pressure
Definition option: Pressure Excitation Frequency. With this option, CFX internally accumu-
lates pressure Fourier coefficients on the specified Location only, for the specified Excitation Fre-
quency. The real and complex coefficients of the first harmonic order are then used in the Generalized
Force calculation. For details, see [Monitor Name]: Pressure Definition in the CFX-Pre User's Guide.
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• You can optionally specify three parameters of the Young growth model for droplet condensation,
namely Young Alpha, Young Beta, and Condensation Coeff., using CEL expressions. For details,
see the note at the end of The Droplet Condensation Model in the CFX-Solver Theory Guide.

• In CFX-Pre, for convenience when handling a large number of meshes, the Reload Mesh Files dialog
box now has a Select All check box for selecting/clearing all mesh-specific check boxes listed in the
dialog box. You could, for example, clear all check boxes before selecting some of them. In addition
to the File menu command Reload Mesh Files, a new shortcut menu command, Edit Mesh File
Paths and Reload, provides access to the Reload Mesh Files dialog box. For details, see Reload
Mesh Files Command in the CFX-Pre User's Guide.

• The following enhancements were made to the ANSYS CFX-Solver File Editor:

– A shortcut menu has been added to the object tree. For details, see Shortcut Menu Commands in
the CFX-Solver Manager User's Guide.

– The Edit menu has a new command, Options, to provide access to user preferences. For details,
see Options Command in the CFX-Solver Manager User's Guide.

3. Incompatibilities

This section describes the operational changes, the procedural changes (actions that have to be done
differently in this release to get an outcome available in Release 2025 R2), and the support changes
(functionality that is no longer supported) in Release 2026 R1 of Ansys CFX.

• In the user interface, aerodynamic damping monitors are now defined in a slightly different location.
In the previous release, aerodynamic damping monitors were listed separately, after the list of point
and expression monitors. Starting with Release 2026 R1, aerodynamic damping monitors are listed
along with point and expression monitors. To create an aerodynamic damping monitor, you need to
select the Aerodynamic Damping option under Monitor Points And Expressions. For details,
see [Monitor Name]: Option in the CFX-Pre User's Guide.
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CFD-Post Release Notes
The following sections contain release information for Release 2026 R1 of Ansys CFD-Post.

1. Supported Platforms

2. New Features and Enhancements

1. Supported Platforms

Platform/OS levels that are supported in the current release are posted on the Ansys website.

Note:

• The CFD-Post graphical user interface might not appear correctly when launching CFD-
Post via VirtualGL and VNC Connect/Turbo VNC on a remote Linux platform.

• When running CFD-Post on Ubuntu 22, if the Report Viewer tab is blank, try setting en-
vironment variable "QTWEBENGINE_CHROMIUM_FLAGS=-no-sandbox".

• If you are using CFX-Pre, CFD-Post, or TurboGrid on a remote machine and the geometry
is not appearing in the viewer, try turning off the following user preference: Common >
Viewer Setup > Double Buffering.

2. New Features and Enhancements

This section lists features and enhancements that are new in Release 2026 R1 of Ansys CFD-Post.

• There are two new GUI style (theme) options: Dark and Light.

When starting CFD-Post for the first time, a dialog box appears that enables you to choose a GUI
style (theme). When a GUI style is selected, it is stored as the GUI Style user preference for future
sessions. For details, see Starting CFD-Post in the CFD-Post User's Guide.
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TurboSystem Release Notes
TurboSystem is a set of software applications and software features that help you to perform turboma-
chinery analyses in Ansys Workbench. For details, see Introduction in the TurboSystem User's Guide.

These release notes cover:

• Turbo Setup system

• Performance Map system

• BladeGen and BladeEditor

• Vista AFD, Vista CCD, Vista CPD and Vista RTD

• Turbo Mesh cell

• Vista TF

• The Turbomachine Neutral Data Format

These release notes do not cover:

• BladeBuilder (see BladeBuilder Release Notes)

• TurboGrid (see TurboGrid Release Notes)

• CFX-Pre (see CFX Release Notes)

• CFD-Post (see CFD-Post Release Notes)

Note:

After reviewing the TurboSystem release notes, you are encouraged to see Usage Notes,
which describes some known TurboSystem workflow issues and recommended practices for
overcoming these issues.

1. Supported Platforms

Platform/OS levels that are supported in the current release are posted on the Ansys website.

2. New Features and Enhancements

This section lists features and enhancements that are new in Release 2026 R1 of TurboSystem.
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Ansys BladeGen

• NDF export commands have been updated:

– File > Export > Neutral Data File (BladeBuilder): This command exports in the newer profile
point NDF format (for passing geometry to BladeBuilder).

– File > Export > Neutral Data File (BladeEditor): This command exports in the traditional camber-
line/thickness NDF format (usually for passing geometry to BladeEditor).

Note that you can open (using File > Open) an NDF file from BladeEditor using file filter option
"Neutral Data File (BladeEditor) (*.ndf;*.xml)".
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TurboGrid Release Notes
The following sections contain release information for Release 2026 R1 of Ansys TurboGrid.

1. Supported Platforms

2. New Features and Enhancements

1. Supported Platforms

Platform/OS levels that are supported in the current release are posted on the Ansys website.

Note:

• If you are using CFX-Pre, CFD-Post, or TurboGrid on a remote machine and the geometry
is not appearing in the viewer, try turning off the following user preference: Common >
Viewer Setup > Double Buffering.

2. New Features and Enhancements

This section lists features and enhancements that are new in Release 2026 R1 of Ansys TurboGrid.

• When TurboGrid runs BladeBuilder to create a CAD model from an NDF file, BladeBuilder shares the
TurboGrid license so does not require a BladeBuilder license. When you run BladeBuilder as a stan-
dalone application, BladeBuilder still requires a BladeBuilder license.

• When generating CAD from profile points, there is now support for blades with Cut-off or square
leading or trailing edges, provided that you use BladeBuilder as the CAD Generation Tool. For details,
see Defining Geometry from Generated CAD: CAD From Profile Points in the TurboGrid User's Guide.

• Meshing with high-fidelity geometry now supports splitter blades, provided that the leading and
trailing edges are rounded. For details, see Meshing High-Fidelity Geometry in the TurboGrid User's
Guide.

• There are two new GUI style (theme) options: Dark and Light.

When starting TurboGrid for the first time, a dialog box appears that enables you to choose a GUI
style (theme). When a GUI style is selected, it is stored as the GUI Style user preference for future
sessions. For details, see Starting Ansys TurboGrid in the TurboGrid Introduction.
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BladeBuilder Release Notes
The following sections contain release information for Release 2026 R1 of Ansys BladeBuilder.

1. Supported Platforms

2. New Features and Enhancements

1. Supported Platforms

Platform/OS levels that are supported in the current release are posted on the Ansys website.

2. New Features and Enhancements

This section lists features and enhancements that are new in Release 2026 R1 of Ansys BladeBuilder.

• When TurboGrid runs BladeBuilder to create a CAD model from an NDF file, BladeBuilder shares the
TurboGrid license so does not require a BladeBuilder license. When you run BladeBuilder as a stan-
dalone application, BladeBuilder still requires a BladeBuilder license.
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Polyflow Classic Release Notes
The following sections contain release information for Ansys Polyflow Classic 2026 R1.

1. New Features

2. Supported Platforms

3. Resolved Issues and Limitations in Ansys Polyflow Classic 2026 R1

1. New Features

The new features in Ansys Polyflow Classic 2026 R1 are as follows:

• It is possible to run a calculation using several MPI threads and multiple GPUS on a cluster. To
activate this beta feature, set the environment variable to ANSYS_POLYFLOW_BETA_MPI_GPU=1
(Beta).

2. Supported Platforms

For information about past, present, and future operating system and platform support, see the Platform
Support section of the Ansys Website.

3. Resolved Issues and Limitations in Ansys Polyflow Classic 2026 R1

This section lists limitations that existed in previous releases, but that were removed in Ansys Polyflow
Classic 2026 R1.
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Forte Release Notes
The enhancements and defect corrections listed below are for Release 2026 R1.

1. New Features and Enhancements

2. Resolved Issues and Limitations

1. New Features and Enhancements

This section lists enhancements in Release 2026 R1 of Ansys Forte CFD, organized by topic.

Simulation Interface

• Beta in 2026 R1:

– An experimental feature was added to allow users to input a custom Deflection vs. Load profile
instead of supplying a fixed elastic modulus for the Beam Bending model using the Built-In FSI.

Job Submision, Monitoring, and Running Options

• Intel MPI 2021.16.1 is the default version.

• Opting In or Opting Out of the Performance Improvement Program is now handled by the Licensing
Settings Application and no longer the Forte User Interface.

2. Resolved Issues and Limitations

For a list of Ansys Forte issues that have been resolved in Release 2026 R1, refer to the Resolved Issues
and Limitations document on the Ansys Help site.
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Chemkin / Reaction Workbench / MFL Release Notes
The following sections contain release information for Release 2026 R1 of Chemkin products:

1. New Features and Enhancements

2. Resolved Issues and Limitations

1. New Features and Enhancements

Chemkin

• New reactor model is introduced in Release 2026 R1: Flammability Calculator model to compute rich
and lean flammability limits.

• pyChemkin:

– PSR network with heat exchange between the PSRs.

– ZND, incident-shock, and reflected-shock reactors.

– Burner-stabilized premixed flame model (given temperature profile and energy equation).

– Opposed-flow flame models.

– Multiprocessing/multithreading examples: brute-force sensitivity and parameter study.

– Advanced application examples: pseudo-stochastic HCCI engine model, SI engine optimization
using the pymoo package.

– Utilities: Partial mixing of two gas mixtures (IEM model), random number generator, normalized
species diffusion velocities between two gas mixtures.

• Expanded ability to submit Chemkin jobs to clusters through an offline parameter study capability.
Post-processing capability is now available, and the ability to submit reactor network cases is now
available (more than one reactor), provided there are no tear loops. See Running and Post-processing
from Batch Scripts in the Chemkin Advanced Analysis Guide.

• Reactions with more than 259 characters can now be handled.

• More capabilities with Chemkin/GT-Power co-simulation: The Chemkin multi-zone HCCI model can
be used as the external cylinder for GT-Power co-simulation.

• Inter-zonal heat transfer is now available to be considered in the Chemkin multizone HCCI model.

• The default connection for Workbench-Chemkin is now changed to a secure connection that requires
MTLS certificates.
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• Opting In or Opting Out of the Performance Improvement Program is now handled by the Licensing
Settings Application and no longer the Chemkin User Interface.

• Equilibrium fractions can now be calculated when EGR is specified for the closed homogeneous batch
reactor model.

Reaction Workbench

• Mechanisms can now be compared in Reaction Workbench. Parameter studies can be set up to account
for a range of operating conditions, and predictions from two mechanisms can be compared graph-
ically for user-selected targets.

• CSP is available as a stand-alone mechanism reduction option.

2. Resolved Issues and Limitations

For a list of issues that have been resolved in Release 2026 R1, refer to the Resolved Issues and Limitations
document on the Ansys Help site.
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FENSAP-ICE Release Notes
The following sections contain release information for Ansys FENSAP-ICE 2026 R1.

1. New Features and Enhancements in Ansys FENSAP-ICE

2. Resolved Issues and Limitations

1. New Features and Enhancements in Ansys FENSAP-ICE

• Ice Displacement and Multishot Remeshing Updates

Multishot remeshing workflows no longer require wall boundaries to be separated along sharp edges
to properly capture these features during the wrapping process. This is a significant usability improve-
ment, allowing the icing process to proceed without modifying the original grid boundary topology.

Non-conformal interfaces are removed from the mesh during remeshing. These boundaries are not
required in the remeshed grid, as it is generated using unstructured elements. Additionally, the
remeshing process cannot proceed if interfaces divide the domain into multiple volumetric regions.

Ice smoothing is automatically applied at wall/symmetry junctions in 3D remeshing simulations to
improve the robustness of the surface wrapping process and reduce the likelihood of prism and tet-
rahedral meshing failures in these regions.

To improve robustness at wall/symmetry junctions, the wrap resolution factor has changed from 1
to 0.9 for 3D meshing cases.

The STL ice thickness limit option limits the iced STL file to iced facets only using a user-set ice
thickness threshold. Limiting the STL to iced facets has the following benefits:

– STL file size is reduced, saving storage space.

– Excessive and spotty mesh refinements due to proximity detection between the STL and the ori-
ginal surface are avoided, resulting in smaller iced meshes during the multishot icing process.

– Remeshing time is noticeably reduced by reading a smaller STL file, minimizing proximity sizing
checks, and using a more optimal sizing function during wrapping.

– More optimal iced grids with reduced mesh sizes allow larger problems with more detailed ice
shapes to be solved using the same computing resources.

– STL files isolated to iced areas are easier to manipulate for downstream 3D printing processes,
where the ice shapes can be manufactured and attached to actual aircraft surfaces.

A new restart option, called Reset FENSAP DROP, has been added to the Multishot configuration
panel. This option skips shot-to-shot solution interpolation for FENSAP and DROP3D, avoiding memory
issues associated with the soln2soln interpolation tool when very large grids are used. It enables
the simulation to continue despite the large mesh size.

169
Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.



A new solution output mode, called Write All Variables, has been added to the FENSAP flow solver.
When disabled, this option skips non-essential fields in the solution file, reducing its size and helping
to avoid memory issues when DROP3D reads the file.

• MPI, Solver, and Memory Upgrades

FENSAP-ICE solver memory usage has been reduced by 35%, enabling larger problems to be solved
using the same computational resources.

The default number of momentum linear system iterations in the FENSAP flow solver has been reduced
from 10 to 5. This change significantly improves simulation speed without noticeably affecting con-
vergence. Legacy runs configured with the previous default value of 10 will continue to use that
setting unless changed manually. When a case is dragged and dropped into a new run, it will retain
the original value of 10, which can be manually updated to 5. New runs will automatically be configured
with the updated default value of 5.

A special set of Intel MPI flags is enabled by default to improve execution stability when running
with a large number of cores and grids exceeding 100 million nodes.

When using the SLURM scheduler, the Fluent Meshing process is configured to distribute the mesh
across HPC compute nodes rather than running entirely on the head node. This removes mesh size
limitations during remeshing and helps prevent memory-related failures during tetrahedral meshing
or while writing the newmesh.msh file. For other schedulers (for example, PBS), similar behavior can
be achieved by replicating the SLURM configuration using system-specific options.

• High Fidelity Multishot Ice Shape Simulations on Full-Scale Aircraft With Multiple Components

With improvements to STL file management, the remeshing script, FENSAP memory usage, and MPI
configuration, FENSAP-ICE can now compute detailed scallop ice shapes over entire wings of full-
scale aircraft such as the NASA CRM-HL model. Simulations including additional components—such
as the pylon, nacelle, and tail planes—are also supported. Multishot with remeshing runs have been
tested using up to 1024 cores and mesh sizes reaching 450 million cells.

• Constant Roughness on Iced Nodes Only

A new roughness output mode has been added to ICE3D to generate a roughness.dat file with
a user-defined, constant, and uniform roughness value applied only to iced nodes. This feature serves
as an alternative to the beading model, allowing you to begin with smooth walls and apply a prescribed
sand-grain roughness value in regions where ice is present.

• Ice Shedding with Parallel Solver for Stress Evaluation (Beta)

A new solver mode selection is available in the ice shedding model for rotating components. The
legacy single-CPU solver is now labeled Direct – Serial, and the newly introduced parallel solver is
labeled Iterative – Parallel. The parallel solver significantly improves performance, particularly for
propeller ice shedding cases involving unstructured grids.

• User Interface, User Experience, and Documentation Updates

– Iteration history is now included in the Minimal Log Output mode, showing only equation residuals
and solver time.

– ICE3D iteration history and crack propagation logs have been redesigned for improved readability.
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– The FENSAP Copy from Adiabatic right-click menu has been removed from the FENSAP wall
boundary temperature right-click menu to prevent configuration errors (for example, setting to
Adiabatic + 10K).

– Sliding wall options have been relabeled in the ICE3D Boundary Conditions panel for clarity.

– The default ice view threshold field in Viewmerical has been changed from Ice Growth (kg/m²) to
Ice Thickness (m).

– The ICE3D numbered solution file format has changed from 8-digit to 6-digit numbering to align
with Fluent Icing conventions.

– The y  values in the FENSAP solution (soln) file are now limited to first-layer wall-adjacent cells
only, as part of a memory optimization. This change removes the volume-to-surface cell projection
data structure, which was unused elsewhere.

– ICE3D - Ice Accretion and Water Runback and Multishot with Remeshing in the Ansys FENSAP-ICE
User Manual have been overhauled to include examples and guidelines aimed at clarifying various
options and supporting successful multishot icing simulations.

2. Resolved Issues and Limitations

For a list of issues that have been resolved in Release 2026 R1, refer to the Resolved Issues and Limitations
document on the Ansys Help website.
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EnSight Release Notes
The following sections contain release information for Ansys EnSight 2026 R1.

1. New Features and Enhancements in Ansys EnSight

2. PyEnSight

3. Ansys Dynamic Reporting (Nexus)

4. Beta in This Release

5. Alpha in This Release

6. Resolved Issues and Limitations

This document explains modifications and enhancements between EnSight releases. If you have not
used EnSight before, you can safely skip the reading of this document.

Welcome to EnSight 2026 R1!

Help System

The Help system utilizes the Ansys Help Viewer. When working in online mode, the Ansys Help Viewer
forwards help and documentation requests to the online location for help and documentation content.
When working in offline mode, the Ansys Help Viewer redirects to a locally stored help bundle from
Ansys. If you anticipate working offline, you should install the offline Help bundle from Ansys.

1. New Features and Enhancements in Ansys EnSight

The following list highlights the enhancements and changes to EnSight in 2026 R1. This list is very short
due to significant reallocation of effort towards internal integration of our technologies into other tools.
In addition, we have some enhancements that have reached Beta state and can be utilized under the
guidelines of a beta feature.

• Qt 6.8.3 Update

EnSight has been updated from Qt5 based UI to a Qt6 based UI. This change was brought on to
provide improved security, updated visual elements, and a cleaner UI layout. Some UI elements have
improved spacing/layout for more consistent Qt implementation. However, this has not resulted in
any major change to the UI, its layout, or operation for the user.

• gRPC Connection Updates

EnSight’s utilization of gRPC connection mechanisms has been updated for 2026 R1. EnSight, PyEnSight,
EnShell, PyEnShell, and DVS all have several new command line options to allow the user to control
how these applications establish connections when using gRPC.

• Fluent Results data consistency improvements
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Many updates to both the Fluent export and import of Fluent native files into EnSight have been
made to improve the Fluent-centric handling of data, metadata, and the interpretation of the data
into a Fluent-centric manner.

• AcuSolve Native Reader removed

The native AcuSolve format reader has been removed from EnSight. All AcuSolve users are encouraged
to utilize the existing and currently suggested EnSight format export capability within AcuSolve.

• USD Export Enhancements

The USD export from EnSight has undergone many improvements, including a completely new
transient data structure, smaller GPU footprint, better compatibility with omniverse environments,
and camera settings.

• Keyframe Camera Transformations

A new option was added to help handle large view transformations within the keyframe dialog. This
'use short path for transform interpolation' option will improve unwanted camera matrix swapping
during large transformations.

• Internal Library Updates

Many 3rd party libraries that are used internally have been updated (e.g. Qt, Python 3.12.11, FFMPEG,
Monotype fonts, Boost, OpenSSL, etc) to maintain consistency with other applications and corporate
wide requirements.

• Fluent Material

The Surface Property Editor dialog now includes a curated list of Fluent Material textures for visual
textures. There are also three controls in the UI section to control the application of those new ma-
terial textures.

• Rocky Reader Updates

The Rocky reader has gone through updates for changes to the format. It also allows the selection
the .freeflow extension, which selects the Rocky reader to interpret that file.

2. PyEnSight

The following list highlights the enhancements and changes to PyEnSight in 2026 R1.

• TBD

TBD

3. Ansys Dynamic Reporting (Nexus)

See the 2026 R1 version of the Ansys Dynamic Reporting Release Notes for enhancement and change
information.
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4. Beta in This Release

Documentation for the beta items can be found at Ansys EnSight Beta Manual.

5. Alpha in This Release

We have several items that are marked as Alpha for this release. This means that the features have not
yet been fully tested, documented, or have their intended functionality. They are meant to be used
only upon the guidance of EnSight staff. These include:

• DPF Reader

Work continues on a new Mechanical results file reader based on the DPF library. Currently tested
against Ansys Mechanical (.rst) file formats.

6. Resolved Issues and Limitations

For a list of issues that have been resolved in Release 2026 R1, refer to the Resolved Issues and Limitations
document on the Ansys Help website.
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FreeFlow Release Notes
Ansys FreeFlow™

Smoothed-Particle Hydrodynamics (SPH) Simulation Software

Ansys FreeFlow software was designed to provide an engineering tool to tackle complex free-surface
flow applications, offering a detailed and realistic representation of physical processes that are challenging
to simulate with other methods.

Ansys FreeFlow software offers a comprehensive platform to simulate single-phasefree-surface flows,
offering two different solver approaches, an implicit incompressible and a weakly compressible. Its
powerful GPU-based solver manages large-scale simulations featuring millions of SPH elements efficiently.

• Single-phase SPH Solvers;

• Surface Tension Modeling;

• Thermal Solver;

• Coupling with Ansys Motion and Ansys EnSight;

• Air drag forces through Ansys Fluent coupling;

• Solver Customization and PrePost Scripting.

See more details about Ansys FreeFlow software on Ansys Website

Learn how-to use with:

• Ansys FreeFlow User Manual

• Ansys FreeFlow Tutorial Guide

1. New Features

In this section you will find all FreeFlow software new features present in the 2026 R1 version.

1.1. SPH Adaptive Sizing (Beta)

Ansys, Inc. makes no commitment to resolve defects reported against these prototype features. However,
your feedback will help us improve the overall quality of the product. We will not guarantee that the projects
using this beta feature will run successfully when the feature is finally released so you may, therefore, need
to modify the projects.

The adaptive sizing is an exclusive FreeFlow feature. The SPH Adaptive Sizing Method's main purpose
is to give better performance in certain problems, specially for those which is necessary to have a
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better physical evaluation in a portion of the physical domain, instead of analysing the entire domain.
In such cases, it is interesting to have refined elements just near the region of interest instead of re-
fining all SPH elements. Therefore, using the SPH Adaptive for creating refined SPH elements, can
lower the computation time.

Important:

To use a beta feature the Experimental (Beta) Features checkbox must be enabled on
the Options | Preferences dialog.

1.2. General New Features (SPH)

• IISPH is now the default SPH solver, and it is no longer Beta.

• Pairwise Potential is now the default surface tension model, and it is no longer Beta.

• A capillary-friction model to enhance adhesion to walls when using the pairwise potential surface-
tension model was developed.

• The time periodic support for Fluid Inlets was created.

• The SPH Surface Monitor module, which calculates statistics of SPH other than mass flow, was cre-
ated.

• The Extend SPH Flowmeters were added to measure the average velocity (or temperature) of the
flow over a given surface

1.3. General New Features (Solver SDK)

• Support for global simulation variables was added.

• New post forces hook for the vicinities list hook.

• Support for user-defined point cloud properties was added.

For more details see  Rocky for Developers.

1.4. Ansys FreeFlow Coupling with Ansys optiSLang Software Feature

See below the new features you can use to perform the Ansys FreeFlow coupling with Ansys optiSLang®
software:

• Implemented new single-node optiSLang integration.

For more details see Ansys FreeFlow User Manual.

2. Improvements

In this section you will find the enhancements done for this version of FreeFlow Software.
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2.1. Performance Improvements

• The performance of point cloud visualization was improved.

• A search cut-off distance was applied to point clouds to improve the performance of nearest-point
search.

• The performance of SPH volumetric inlet generation was improved.

2.2. User Experience Improvements

• The SPH parameter was removed from the default data tree to keep the tree cleaner.

• Seed calculation based on the Volumetric Inlet center was automated.

For more details see Ansys FreeFlow User Manual.

2.3. Postprocessing Improvements

• A multi-source Eulerian Process was created to calculate mixed-source statistics (e.g., SPH-DEM
volume fraction).

• Dynamic keywords for Plot annotations were implemented.

• The Plane Group user process was implemented.

• Support for the Polyhedron user process on Geometries was created.

For more details see Ansys FreeFlow User Manual.

3. FreeFlow Modules

In this section you will find new FreeFlow Modules and main enhancements present in the 2026 R1
version.

• SPH Thermal Buoyancy: This module implements the Boussinesq approximation to add thermal
buoyancy to SPH fluid simulations.

• New Ready-to-use Modules Beta:

Ansys, Inc. makes no commitment to resolve defects reported against these prototype features. However,
your feedback will help us improve the overall quality of the product. We will not guarantee that the
projects using this beta feature will run successfully when the feature is finally released so you may,
therefore, need to modify the projects.

– Flat plate HTC correlation (Beta): This module implements the flat-plate correlation for heat
transfer coefficient calculation.

– SPH Implicit Non-Newtonian (Beta): Implicit version of non-Newtonian models.

Modules Improvements:

179
Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.

FreeFlow Modules



• The SPH Freeze Outside Region was promoted from Beta to a regular module.

Modules Removed:

• SPH Disable Wall Corrections

For more details see  Module Manual.

4. FreeFlow Scripts

In this section you will find new FreeFlow Scripts in the 2026 R1 version.

Important:

Usability Improvements:

All PrePost Scripts source code has been moved to the Ansys Rocky PrePost Scripts &
Modules Repository on theAnsys GitHub page.

New Ready-to-use Scripts:

• Export SPH information (General Scripts): Like the existing script that exports particle information,
this script exports SPH information (such as density, velocity, etc.) for all SPH elements in the compu-
tational domain at a chosen time step, saving the data as CSV files, either as one file per time step
or a single file with all outputs based on the user's selection.

5. Beta in This Release

In this section you will find the new beta features available in this release. Note that beta features have
not been fully tested and validated.

Ansys, Inc. makes no commitment to resolve defects reported against these prototype features. However,
your feedback will help us improve the overall quality of the product. We will not guarantee that the projects
using this beta feature will run successfully when the feature is finally released so you may, therefore, need
to modify the projects.

Important:

To use a beta feature the Experimental (Beta) Features checkbox must be enabled on the
Options | Preferences dialog.

• Fast 3D Motion Visualization beta advanced option was promoted to the default visualization mode
for geometries.

• Relaxed Incompressibility constraint for IISPH to reduce pressure fluctuations as a Beta Feature was
created.

• An Implicit Viscous Force solver to improve stability for high viscous and turbulent flows was created
as a Beta Feature. For the implicit non-Newtonian case, a Beta module was implemented.
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• The Flat plate HTC correlation module was created as a Beta feature.

• The Buyoancy Force Model module was created as a Beta feature.

• See FreeFlow Modules (p. 179) section to review the Readt-to-use modules beta in this release.

For more details see Ansys FreeFlow User Manual.

6. Resolved Issues and Limitations

For a list of issues that have been resolved in Release 2026 R1, refer to the Resolved Issues and Limitations
document on the Ansys Help website.

181
Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.

Resolved Issues and Limitations

https://ansyshelp.ansys.com/


Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.182



Ansys Rocky Release Notes
The following sections contain release information for Ansys Rocky™ particle dynamics simulation
software 2026 R1.

This Rocky software release continues to address customers' needs delivering features that enable users
to perform accurate DEM simulations, and optimize user experience, allowing limitless possibilities on
particle dynamics simulation.

Welcome to Ansys Rocky Software 2026 R1!

1. New Features

In this section you will find all Rocky new features present in the 2026 R1 version.

1.1. General New Features (DEM)

• The MPI support was added as a Beta Feature.

The support is only for spherical particle shape, with no support for coupling, no support for ex-
ternal modules or built-in modules in which inter-node reductions are required. The MPI enables
Rocky solver to run in distributed memory architetures ("inter-node"). Once with distributed parallel
computing support, Rocky users can run simulations in multiple computers (or nodes) connected
by a network, such as, InfiniBand. Hence, there will be an improvement on performance scalability
for DEM sphere simulations.

For more details see Rocky User Manual.

1.2. General New Features (SPH)

• IISPH is now the default SPH solver, and it is no longer Beta.

• Pairwise Potential is now the default surface tension model, and it is no longer Beta.

• A capillary-friction model to enhance adhesion to walls when using the pairwise potential surface-
tension model was developed.

• The time periodic support for Fluid Inlets was created.

• The SPH Surface Monitor module, which calculates statistics of SPH other than mass flow, was cre-
ated.

• The Extend SPH Flowmeters were added to measure the average velocity (or temperature) of the
flow over a given surface

For more details see Rocky User Manual.
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1.3. General New Features (Rocky SDK)

• Support for global simulation variables was added.

• New post forces hook for the vicinities list hook.

• Support for user-defined point cloud properties was added.

For more details see  Rocky for Developers.

1.4. Ansys Rocky Coupling with Ansys Fluent Software Features

See below the new features you can use to perform the Ansys Rocky coupling with Ansys Fluent®
software:

• Support for 2-way unresolved CFD-DEM coupling using the Fluent VOF method was implemented.

• Support for 1-way coupling between Fluent GPU and Rocky was implemented.

For more details see Rocky User Manual, and Rocky CFD Manual

1.5. Ansys Rocky Coupling with Ansys optiSLang Software Feature

See below the new features you can use to perform the Ansys Rocky coupling with Ansys optiSLang®
software:

• Implemented new single-node optiSLang integration.

For more details see Rocky User Manual.

2. Improvements

In this section you will find the enhancements done for this version of Rocky Software.

2.1. PrePost Scripting Improvements

See below the PrePost Scripting improvements that this new version brings:

• A method was created for all inlet classes to add a particle through the PrePost Scripting.

For more details see  Rocky for Developers.

2.2. Performance Improvements

• General performance improvements for DEM simulations with high-count, low-PSD spherical particle
simulations were implemented.

• The performance of point cloud visualization was improved.

• The performance for the volumetric generation of DEM particles was improved.
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• A search cut-off distance was applied to point clouds to improve the performance of nearest-point
search.

• The performance of SPH volumetric inlet generation was improved.

2.3. User Experience Improvements

• The SPH parameter was removed from the default data tree to keep the tree cleaner.

• Seed calculation based on the Volumetric Inlet center was automated.

For more details see Rocky User Manual.

2.4. Postprocessing Improvements

• A multi-source Eulerian Process was created to calculate mixed-source statistics (e.g., SPH-DEM
volume fraction).

• Dynamic keywords for Plot annotations were implemented.

• The Plane Group user process was implemented.

• Support for the Polyhedron user process on Geometries was created.

For more details see Rocky User Manual.

3. Rocky Modules

In this section you will find new Rocky Modules and main enhancements present in the 2026 R1 version.

New Ready-to-use Modules:

• 1-Way Free Surface: This module implements the receding fluid level, considering a given receding
velocity; the capillary force model acting on particles in contact with the fluid interface level; the
buoyancy force model acting on particles in the fluid modeled by the receding fluid level; the Stokes
friction force model acting on particles with the fluid modeled by the receding fluid level.

• Intermolecular Forces: This module implements the van der Waals force and the steric repulsive
force model as an adhesive contact model. It considers particle-particle interactions.

• SPH Thermal Buoyancy: This module implements the Boussinesq approximation to add thermal
buoyancy to SPH fluid simulations.

• New Ready-to-use Modules Beta:

Ansys, Inc. makes no commitment to resolve defects reported against these prototype features. However,
your feedback will help us improve the overall quality of the product. We will not guarantee that the
projects using this beta feature will run successfully when the feature is finally released so you may,
therefore, need to modify the projects.

– Flat plate HTC correlation (Beta): This module implements the flat-plate correlation for heat
transfer coefficient calculation.
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– SPH Implicit Non-Newtonian (Beta): Implicit version of non-Newtonian models.

Modules Improvements:

• The SPH Freeze Outside Region was promoted from Beta to a regular module.

Modules Removed:

• SPH Disable Wall Corrections

For more details see Rocky Module Manual.

4. Rocky Scripts

In this section you will find new Rocky Scripts in the 2026 R1 version.

Important:

Usability Improvements:

All PrePost Scripts source code has been moved to the Ansys Rocky PrePost Scripts &
Modules Repository on theAnsys GitHub page.

All Scripts Wizards (Material Wizard, Coating Visibility Wizard, Calibration Suite, Material Storage,
and Closed Loop Motion) are now distributed through the APP Catalog on the Ansys Developer
Portal.

New Ready-to-use Scripts:

• Closed Loop Motion (Wizard): The Closed Loop Motion script automates the creation of replicated
geometry motion. It will also generate motion frames with high accuracy. This script uses a table of
circles to define the movement's path, and there is also a preview panel to visualize it.

• Script Mixing Index (General Scripts): This script calculates the mixing index for multiple materials
in a mixer based on the proportions of each material across different cells in the domain. It is useful
for quantifying and evaluating the degree of mixing or homogeneity of different materials within the
mixer.

• Export SPH information (General Scripts): Like the existing script that exports particle information,
this script exports SPH information (such as density, velocity, etc.) for all SPH elements in the compu-
tational domain at a chosen time step, saving the data as CSV files, either as one file per time step
or a single file with all outputs based on the user's selection.

For more details see Rocky Scripts Manual.

5. Beta in This Release

In this section you will find the new beta features available in this release. Note that beta features have
not been fully tested and validated.
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Ansys, Inc. makes no commitment to resolve defects reported against these prototype features. However,
your feedback will help us improve the overall quality of the product. We will not guarantee that the projects
using this beta feature will run successfully when the feature is finally released so you may, therefore, need
to modify the projects.

Important:

To use a beta feature the Experimental (Beta) Features checkbox must be enabled on the
Options | Preferences dialog.

• Fast 3D Motion Visualization beta advanced option was promoted to the default visualization mode
for geometries.

• Relaxed Incompressibility constraint for IISPH to reduce pressure fluctuations as a Beta Feature was
created.

• An Implicit Viscous Force solver to improve stability for high viscous and turbulent flows was created
as a Beta Feature. For the implicit non-Newtonian case, a Beta module was implemented.

• The Flat plate HTC correlation module was created as a Beta feature.

• The Buyoancy Force Model module was created as a Beta feature.

• Distributed Parallel Computing was added as a Beta feature, improving scalability and enabling more
complex simulations.It is only available for DEM sphere particles.

• See Rocky Modules (p. 185) section to review the Readt-to-use modules beta in this release.

For more details see Rocky User Manual.

6. Ansys Engineering Copilot within Ansys Rocky (Beta)

When the Experimental (Beta) Features checkbox is enabled on the Options | Preferences dialog
this allows you to use the Ansys Engineering Copilot.

Ansys Engineering Copilot delivers content from Ansys content creators in response to your queries.
Content sources that are searched include the Ansys Innovation Space, knowledge articles, forum posts,
and AnsysGPT™.

Ansys Engineering Copilot opens a dock widget in Rocky software, where you can access several re-
sources that will help you find answers to your questions and learn something new by engaging with
the large global Ansys community. For more information, see the Ansys Engineering Copilot document-
ation.

For more details see Rocky User Manual.

Important:

Note that beta features have not been fully tested and validated. Ansys, Inc. makes no
commitment to resolve defects reported against these prototype features. However, your
feedback will help us improve the overall quality of the product. We will not guarantee that
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the projects using this beta feature will run successfully when the feature is finally released
so you may, therefore, need to modify the projects.

7. Resolved Issues and Limitations

For a list of issues that have been resolved in Release 2026 R1, refer to the Resolved Issues and Limitations
document on the Ansys Help website.
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Thermal Desktop 2026 R1 Release Notes

1. New features and capabilities

The following changes have been added.

General

• TD Direct will be discontinued in a future release and has been replaced by TD Designer in 2026 R1.

• Thermal Desktop Registers can now be used as System Coupling Parameters. This is a beta feature.

• Applications not supported using AutoCAD 2025:

– ModelCenter integration

– OptiSLang integration

– System Coupling client

– Any user-created OpenTD tools that connect to Thermal Desktop (reading save files is unaffected
by AutoCAD version)

Note:

Please see the Thermal Desktop manual (Overrides) to enable features if using AutoCAD
2025 or later.

• Modeling of participating media is radiation has been promoted out of Beta. Participating media is
a volume of solid, liquid, or gas that emits and absorbs radiation. The volumes may be analyzed for
heating rates from external sources and participate in volume-to-volume and surface-to-volume radi-
ation exchange. Only grey media without scattering is supported at this time. Common applications
of participating media include the analysis of ports used in manned spacecraft, protective covers for
optical systems and solar heat exchangers, lamp design, the analysis of canopies and windscreens
for cabin comfort in airplanes and automobiles, and survival analysis for irradiated critical components.

• In 26R1, the compartment evaluation workflow has been optimized to reduce unnecessary geometric
computations during wet/dry tracking and interface updates. The solver now avoids redundant recal-
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culations when the liquid plane is unchanged and skips expensive volume slicing when compartments
are fully empty or fully filled.

Note:

Expected results: Fluid models containing compartments may see reduced run time. Per-
formance gains are most pronounced in compartment-dominated cases. No changes to
model setup are required, and solution results are unchanged.
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Ansys Electronics Products

Release notes are available for the following Ansys Electronics products:

Icepak (p. 193)





Icepak Release Notes
Release 2026 R1 of the Ansys Icepak application offers most of the capabilities from previous releases
plus an enhancement.

• Introduction (p. 193)

• New and Modified Features in Ansys Icepak 2026 R1 (p. 193)

• Resolved Issues and Limitations in Ansys Icepak 2026 R1 (p. 193)

1. Introduction

Ansys Icepak 2026 R1 is a release of Ansys Icepak that has a new feature and resolved issues and limit-
ations.

2. New and Modified Features in Ansys Icepak 2026 R1

Release 2026 R1 of Icepak has no new features or enhancements.

Ansys 24.2 will be the final release of the Classic Icepak platform. Classic Icepak will continue to be ac-
cessible for download beyond the 24.2 release from the Ansys Customer Portal. ACE support will formally
continue for Classic Icepak until 31 December 2025.

3. Resolved Issues and Limitations in Ansys Icepak 2026 R1

For a list of issues that have been resolved in Release 2026 R1, refer to the Resolved Issues and Limitations
document on the Ansys Help website.
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Ansys Optical Products

Release notes are available for the following Ansys optical products:

Ansys SPEOS (p. 197)

SPEOS for NX (p. 207)

SPEOS for Creo Parametric (p. 215)

Ansys Optical Labs (p. 221)

SPEOS HPC (p. 225)





Speos Release Notes
The following sections present the new features, enhancements and changes for Speos 2026 R1 release.

1. Features from BETA to Official

2. Productivity Enhancement

3. Sensor / Autonomous Driving

4. Result Experience

5. Optical Part Design

6. Changes

7. Resolved Issues and Limitations

1. Features from BETA to Official

This section highlights the features that have evolved from beta version into fully supported, official
features.

Interactive Live Preview

The Interactive Live Preview tool is now official and no longer in BETA.

The Interactive Live Preview tool permits you to directly see in the current running Live Preview window
the changes applied on your project without having to launch a simulation to see the result.

2. Productivity Enhancement

This section highlights the new capabilities introduced in Ansys Speos 2026 R1 designed to enhance
productivity.

Speos RPC

Refer to the Developer Documentation portal to see the latest changes for Speos RPC.

Speos client APIs

Refer to the Developer Documentation portal to see the latest changes for Speos client APIs.

Ambient Sources

The Ambient source sampling algorithm in Direct simulation has been aligned with the other sources.
Consequently:
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• Ambient sources will have fewer rays for simulations with multiple sources. The Standard Deviation
is expected to increase marginally.

• Direct simulations time may be improved, especially when multiple sources and ambient sources
are used, and a significant number of rays is set.

• Power Report in the HTML Report now integrates the emitted power information of Ambient
sources (see below)

• Results may be slightly noisier as less rays are sent during the simulation compared to versions
prior to 2026 R1.

Simulation - Ray animation

In some cases, full ray tracing contains too much information to understand how light propagates and
interacts with the different optical interfaces.

• The new ray length parameter, available with Interactive simulations and Light Expert analysis,
permits to crop the ray paths and ease the analysis.

• In addition, the Play function (Interactive simulations / Light Expert analysis) literally animates
the ray tracing, offering the possibility to follow the propagation with different display modes.

Simulation - new 3D Irradiance sensor result

Direct simulation with 3D irradiance sensor now generates a new result that contains all useful inform-
ation for post processing. This is quite useful, especially when performing a Sun burn analysis.

Information for each 3D face includes:

• Every related to the meshing: facets, vertices and normals

• Radiometric values: irradiance, reflection, transmission, absorption, total power and absorbed
power

• Data to advanced filtering: area and number of impacts per facet

This new result *.rawxm3 file uses the HDF5 format that can be opened with open-source software or
via Python script.
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Simulation - Contextual menu actions for multi-selection of simulations

You can now perform the following contextual menu actions in case of a multi-selection of simulations.
The action selected will be performed for each selected simulation:

• GPU Compute

• Isolate

• Linked Export

• Export

This will streamline your workflows by eliminating the need to apply actions to each simulation indi-
vidually, therefore saving time and improving efficiency.

Simulation - Creating a simulation based on an existing simulation

Speos now offers the possibility to create a new simulation from an existing one (the simulation type
can be different) in few clicks. Compatible features used in the selections of the original simulation are
transferred to the new one, either all at once (sources, sensors and geometries) or individually. It eases
the setting up of new simulations. For instance, by reusing the selections from an Interactive simulation
to a Direct or Inverse simulation.

Live Preview

In the Simulation display options of the Live Preview, a new Preview mode has been added to define
how Live Preview displays results during static and dynamic view states to provide different user exper-
iences.

• The new Hybrid mode has been designed for visual fluidity during result navigation:

– When the viewpoint is static, Live Preview uses the GPU rendering. The Live Preview
simulation continues running.

– When moving the viewpoint, Live Preview switches to a traditional CAD colored render
to offer better motion fluidity. During the movement, Live Preview simulation is paused
and resumes as soon as the movement stops and immediately displays back simulation
rendering.

• The GPU mode corresponds to the original mode, and prioritizes GPU simulation visual over
motion fluidity.

– When the viewpoint is static, Live Preview uses the GPU rendering. The Live Preview
simulation continues running.
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– When moving the viewpoint, Live Preview keeps running the simulation but at a much
lower resolution to improve interactivity. Resolution gradually increases back to full resol-
ution as soon as movement stops.

Ansys Cloud Burst Compute

Ansys Cloud Burst Compute has been improved with the following new functionalities:

• The new Disable ray files and lpf/lp3 files output option is available in the job submission
window during the creation of the simulation jobs. As these files can take time to be generated,
disabling this option speeds up the simulation generation if you do not need them.

• The new Download results after completion option is available in the job submission window.
Thus, when activating this option, the simulation results are automatically downloaded when
the job is in Finished status.

• The new Stop and save option is available in the Ansys Cloud Burst Compute Job Manager
window (job monitoring window). This option appears only when a job is running. It stops the
simulation job and saves all results up to the current point.

Ansys Engineering Copilot

Ansys Engineering Copilot is now available to every user, expanding what you can do right away. An-
sysGPT stays part of the enhanced experience offered with an active AnsysGPT AI+ license.

Speos Core

Speos Core has been improved to provide you with a better user experience:

• Speos Core has been optimized to provide better memory management when running multiple
simulations in a row.

• Speos Core offers the possibility to set up GPU preferences as you will do in Speos through the
new GPU solver configuration button available in the SPEOS Core toolbar.

• Speos Core gives you access to the Simulation folder through the new Simulation folder button
available in the SPEOS Core toolbar.

• After a compute, simulation results and report can be opened from the Speos Core tree. This
direct access saves time to find the corresponding files on the hard disk drive.
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Libraries

As Ansys Optics Library is available in the installation package, Speos now offers a direct access to it
through:

• Material Libraries: all optical properties references are loaded and ready to be used in project
with simple drag and drop.

• Libraries: shows all the Optics library content (optical properties, sensors, sources and standards)

In addition, a direct access to List file references tool is possible from the ribbon. The tool permits to
easily manage paths to dependencies as well as related files.

3. Sensor / Autonomous Driving

This section highlights the new capabilities introduced in Ansys Speos 2026 R1 designed to enhance
sensors and autonomous driving.

Optical Design Exchange

• The Optical Design Exchange construction algorithm has been improved to deliver greater robustness
when importing a *.odx file and computing the Optical Design Exchange feature in Speos.

• Optical Design Exchange now supports Table Glass and creates at the import the corresponding
*.ZTG.ZemaxMaterial file.

Table Glasses in Ansys Zemax OpticStudio® are optical materials in which the material properties are
defined in a text file (*.ztg) explicitly, defining, for each wavelength, index of refraction, transmissivity
and corresponding thickness.

When exporting a *.odx file to Speos, Table Glass data are carried in an encrypted *.ZTG.ZemaxMater-
ial file that contains:

– Wavelengths in nm

– Dispersion coefficients (refractive index) for each wavelength

– Absorption coefficients in mm-1, calculated from the transmission and thickness data

Camera Sensor - XMP Template

Camera sensor offers the possibility to reference a XMP template (*.xml file) during its definition.

• The template contains useful information such as default measurements that will be automatically
applied to new spectral irradiance or exposure result.
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• In addition, you can choose to setup dimensions of the camera sensor from the template and
to apply display settings to new results.

XMP template contributes to save time during simulation iterations using camera sensor.

4. Result Experience

This section highlights the new capabilities introduced in Ansys Speos 2026 R1 designed to enhance
the result experience.

CPU/GPU solver algorithms

• CPU and GPU solver algorithms have been aligned for a better management of unpolished surfaces.

• GPU solver algorithm has been optimized to provide better memory management when running
multiple GPU simulations in a row.

• The GPU solver algorithm has been enhanced to ensure more robust execution when running an
Inverse simulation with the Optimized Propagation set to Relative.

• The GPU solver algorithm has been improved to correctly take into account rays intersecting Exit
Geometries (from Ray File or Surface source) during a simulation.

• The GPU solver algorithm has been aligned with the CPU solver algorithm for a better management
of Display sources in simulation. Now Fast Transmission Gathering algorithm (when activated)
automatically applies to the geometry (automatically created by the simulation) of a Display source.
Thus, the geometry is ignored by the simulation.

Simulation result - Improved visualization of results using transparency

Speos now permits to change the transparency of results displayed in 3D view, enhancing the visibility
of underlying elements, and enabling more effective analyses such as ray tracing or Light Expert. In
addition, xm3 results null values can be displayed as transparent. These new options are available in
the Light Simulation options of the SpaceClaim Options.

Simulation result - HTML GPU Report

Now, GPU simulation report provides the same level of information as CPU simulation.

• Propagation report section has been added and includes the error report that provides the
total number of errors and the list of error types.

• In addition, the Performance Analysis section of the report includes peak video memory usage
that corresponds to the highest amount of vRAM consumed by the simulation at a certain time.
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This information becomes quite useful when you want to estimate how much the resolution of
sensors can be increased for instance.

GPU acceleration - Rebalancing Camera simulation

Camera sensors in GPU Inverse simulations are now compatible with:

• the Optimized Propagation set to Relative when running the simulation.

• the Rebalancing mode set to Variance when running the Live Preview.

Virtual Photometric Lab / Virtual Human Vision Lab

• As of version 2026 R1, XMP files generated are in version 10.3. XMP files generated prior to version
2026 R1 will not load in the version 2026 R1 of Speos, Virtual Photometric Lab, and Virtual Human
Vision Lab.

• XMP Filtering is now deactivated by default (set to None) for XMP results generated with a sensor
without XML template applied. Consequently, simulations will require less memory during result
generation and will deliver faster result output, enabling Virtual Photometric Lab / Virtual Human
Vision Lab to open the results more quickly.

5. Optical Part Design

This section highlights the new capabilities introduced in Ansys Speos 2026 R1 designed to enhance
Optical Part Design features.

Optical Part Design - Updating Multiple Parameter Values Simultaneously

To simplify parameters definition, Speos introduces the possibility to edit multiple rows of a parameter
in a table by using the new multi-select column editing feature. Thus, you can select several cells
within a single parameter column and immediately apply a new value to all of them at once, which will
save you time in feature setting. This new feature is mainly beneficial for Optical Part Design features
but can be used with other tables of Speos features if allowed.

Optical Part Design - Optical Surface / Optical Lens

With the Custom Contour tool, it is now possible to use multiple surfaces to trim the Optical Surface
/ Optical Lens. Usually, those multiple surfaces come from style, mechanical, multiple parts assembly.
Prior to version 2026 R1, only a surface body was allowed to perform the trimming action.
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Optical Part Design - TIR Lens

Total Internal Reflection Lens can now be defined using an optical axis that can be tilted with respect
to the support plan where LED is placed.

• Prior to version 2026 R1, TIR lens design was based on a support plane, a defined source point,
and an automatically generated axis of revolution (the optical axis) normal to the plane. This
approach inherently produced symmetrical lenses.

• Since version 2026 R1, the Optical axis has become a user-defined parameter. TIR Lens design
continues to rely on a support plane, a source point, and the Optical axis itself. However, the
Optical axis is no longer constrained to be normal to the support plane. It can now be oblique,
allowing for the creation of asymmetrical lenses.

This can be used also inside Optical Lens as entry face with tilted PCB to reduce space required by the
optical system.

Optical Part Design - Light Guide

• The Light Guide construction algorithm has been enhanced to provide more robust results.

• Hybrid mode of Light Guide is extremely flexible as prism could be inside or outside main body. To
bring more flexibility, The Max prism height manufacturing parameter has been added to the Light
Guide definition. It allows you to limit the height of each prism from the guide curve, preventing any
collision with a mechanical element. Thus, you can optimize your light guide while considering various
manufacturing and assembly constraints.

Optical Part Design - Freeform Lens

Speos introduces a new type of Freeform Lens dedicated to create a sharp cut-off lens from a multichip
LED. Such a lens is particularly efficient for road lighting (automotive or motorbike).

Thus, to create such a lens, new parameters have been introduced to define the Back Face of the Lens
and the Target Beam rendering on the result. Upon compute of the Optical Part Design feature, the
geometric design is automatically optimized to achieve the user-defined optical target.

HUD Optical Design

HUD Optical Design now generates the rotation axis and gives access to the corresponding angles when
defining more than one eyebox and enabling multiconfiguration.
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HUD Optical Analysis

HUD Optical Analysis algorithm has been enhanced to better detect stigmatic systems and inform the
user of the situation where Sagittal Virtual Image, Tangential Virtual Image, and Best Focus Virtual Image
are coincident.

6. Changes

This section describes the operational and support changes introduced in Ansys Speos 2026 R1 release.

Ansys Product Improvement Program

The Ansys Product Improvement Program, controlled through the Licensing Settings utility, is now en-
abled by default. During each session, the product collects anonymous usage data. When the session
ends, this data is securely transmitted to a server accessible only to authorized Ansys employees. After
Ansys receives the data, statistical methods, such as distributions, counts, means, medians, and modes,
are applied to analyze and understand usage patterns.

You can stop participating at any time. See the Enabling the Ansys Product Improvement Program
(APIP) documentation in the Ansys, Inc. Licensing Guide for more information.

Documentation

• Documentation has been updated with a new chapter explaining how to access and collect logs. This
addition makes troubleshooting, debugging, and other diagnostic tasks easier. Besides, it also provides
the development team with possible useful information to investigate and resolve software issues
more efficiently.

• To improve clarity and provide a more coherent workflow, the Simulations and Results documentation
chapters have been reorganized and refined.

– Restructured Simulation chapter: The Simulation content is now organized into clearer,
stage-based sub-sections that better reflect the progression of the simulation process.

– Results integrated into the workflow: The former Results chapter has been moved under
Simulation and renamed Analyzing Results, placing outcome information directly alongside
the steps that produce it.

– Enhanced navigation: The table of contents has been updated to reflect this new structure,
making it easier for users to follow the end-to-end process.

Deprecated / End of support / End of life features

• SDOC file format is in end of support in version 2026 R1, meaning that *.scdoc files cannot be
opened from version 2026 R1. If you want to open a SCDOC project, convert the *.scdoc file to *.sdocx
by saving it from a prior version (2025 R1 or 2025 R2 for example), then open the *.scdocx file in
2026 R1.
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• FTM Layer is deprecated and in end of support in version 2026 R1 and will be in end of life in
version 2027 R1.

• Solstis ray files are deprecated and in end of support in version 2026 R1 and will be in end of
life in version 2027 R1.

• The following filtering options of Virtual Photometric Lab are deprecated and in end of support in
version 2026 R1:

• The following filtering options of Virtual Human Vision Lab are deprecated and in end of support
in version 2026 R1:

• The human vision Dynamic Adaptation option is deprecated and in end of support in version 2026
R1 in the following tools:

– Virtual Human Vision Lab

– Virtual Reality Lab

– Virtual Lighting Animation Tool

The default Adaptation type value is now set to Dynamic Adaptation 2019.

• The Deterministic algorithm with Photon Map (Build Photon Map, Load Photon Map, Build and Save
Photon Map) is in end of support in version 2026 R1.

• Ansys Cloud Direct is deprecated on December 31, 2025. Since this date, job submission to Ansys
Cloud Direct are no longer supported. Also, Ansys Cloud Direct documentation is removed from the
Ansys Help site in January.

Versions Update

• Windows: Windows 10 and Windows 11

Minimum NVIDIA Driver 581.42 is required from 2026 R1.

• Speos GPU solver algorithm is now compatible with NVIDIA Blackwell GPU architecture.

7. Resolved Issues and Limitations

For a list of issues that have been resolved in Release 2026 R1, refer to the Resolved Issues and Limitations
document on the Ansys Help website.
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Speos for NX Release Notes
The following sections present the new features, enhancements and changes for Speos for NX 2026 R1
release.

1. Productivity Enhancement

2. Sensor / Autonomous Driving

3. Result Experience

4. Optical Part Design

5. Changes

6. Resolved Issues and Limitations

1. Productivity Enhancement

This section highlights the new capabilities introduced in Ansys Speos for NX 2026 R1 designed to en-
hance productivity.

Speos RPC

Refer to the Developer Documentation portal to see the latest changes for Speos RPC.

Ambient Sources

The Ambient source sampling algorithm in Direct simulation has been aligned with the other sources.
Consequently:

• Ambient sources will have fewer rays for simulations with multiple sources. The Standard Deviation
is expected to increase marginally.

• Direct simulations time may be improved, especially when multiple sources and ambient sources
are used, and a significant number of rays is set.

• Power Report in the HTML Report now integrates the emitted power information of Ambient
sources (see below)

• Results may be slightly noisier as less rays are sent during the simulation compared to versions
prior to 2026 R1.
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Simulation - new 3D Irradiance sensor result

Direct simulation with 3D irradiance sensor now generates a new result that contains all useful inform-
ation for post processing. This is quite useful, especially when performing a Sun burn analysis.

Information for each 3D face includes:

• Every related to the meshing: facets, vertices and normals

• Radiometric values: irradiance, reflection, transmission, absorption, total power and absorbed
power

• Data to advanced filtering: area and number of impacts per facet

This new result *.rawxm3 file uses the HDF5 format that can be opened with open-source software or
via Python script.

Live Preview

In the Simulation display options of the Live Preview, a new Preview mode has been added to define
how Live Preview displays results during static and dynamic view states to provide different user exper-
iences.

• The new Hybrid mode has been designed for visual fluidity during result navigation:

– When the viewpoint is static, Live Preview uses the GPU rendering. The Live Preview
simulation continues running.

– When moving the viewpoint, Live Preview switches to a traditional CAD colored render
to offer better motion fluidity. During the movement, Live Preview simulation is paused
and resumes as soon as the movement stops and immediately displays back simulation
rendering.

• The GPU mode corresponds to the original mode, and prioritizes GPU simulation visual over
motion fluidity.

– When the viewpoint is static, Live Preview uses the GPU rendering. The Live Preview
simulation continues running.

– When moving the viewpoint, Live Preview keeps running the simulation but at a much
lower resolution to improve interactivity. Resolution gradually increases back to full resol-
ution as soon as movement stops.

Ansys Cloud Burst Compute

Ansys Cloud Burst Compute has been improved with the following new functionalities:
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• The new Disable ray files and lpf/lp3 files output option is available in the job submission
window during the creation of the simulation jobs. As these files can take time to be generated,
disabling this option speeds up the simulation generation if you do not need them.

• The new Download results after completion option is available in the job submission window.
Thus, when activating this option, the simulation results are automatically downloaded when
the job is in Finished status.

• The new Stop and save option is available in the Ansys Cloud Burst Compute Job Manager
window (job monitoring window). This option appears only when a job is running. It stops the
simulation job and saves all results up to the current point.

Ansys Engineering Copilot

Ansys Engineering Copilot is now available to every user, expanding what you can do right away. An-
sysGPT stays part of the enhanced experience offered with an active AnsysGPT AI+ license.

Speos Core

Speos Core has been improved to provide you with a better user experience:

• Speos Core has been optimized to provide better memory management when running multiple
simulations in a row.

• Speos Core offers the possibility to set up GPU preferences as you will do in Speos for NX through
the new GPU solver configuration button available in the SPEOS Core toolbar.

• Speos Core gives you access to the Simulation folder through the new Simulation folder button
available in the SPEOS Core toolbar.

• After a compute, simulation results and report can be opened from the Speos Core tree. This
direct access saves time to find the corresponding files on the hard disk drive.

Libraries

Speos for NX now offers the possibility to customize the path of the Optical Libraries folder (by default
in C:\Program Files\ANSYS Inc\vXXX\Optical Products\OpticalLibraries).

In addition, a direct access to Libraries shows all the Optics library content (optical properties, sensors,
sources and standards).
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2. Sensor / Autonomous Driving

This section highlights the new capabilities introduced in Ansys Speos for NX 2026 R1 designed to en-
hance sensors and autonomous driving.

Optical Design Exchange

Optical Design Exchange is now available in Speos for NX. The Optics Design Exchange feature allows
you to import an optical design system created in Ansys Zemax OpticStudio. Each geometry imported
(source, lens, mirror, stop) is located into a dedicated part that includes:

• Default properties: volume and surface optical properties, meshing properties

• Specific properties for coatings

• Surface sources for sources

Through the Speos for NX capabilities you will be able to use and analyze this optical design system.

3. Result Experience

This section highlights the new capabilities introduced in Ansys Speos for NX 2026 R1 designed to en-
hance the result experience.

CPU/GPU solver algorithms

• CPU and GPU solver algorithms have been aligned for a better management of unpolished surfaces.

• GPU solver algorithm has been optimized to provide better memory management when running
multiple GPU simulations in a row.

• The GPU solver algorithm has been enhanced to ensure more robust execution when running an
Inverse simulation with the Optimized Propagation set to Relative.

• The GPU solver algorithm has been improved to correctly take into account rays intersecting Exit
Geometries (from Ray File or Surface source) during a simulation.

• The GPU solver algorithm has been aligned with the CPU solver algorithm for a better management
of Display sources in simulation. Now Fast Transmission Gathering algorithm (when activated)
automatically applies to the geometry (automatically created by the simulation) of a Display source.
Thus, the geometry is ignored by the simulation.

Simulation result - HTML GPU Report

• Material names in the HTML Report have been renamed from Vop to Optic.

• Now, GPU simulation report provides the same level of information as CPU simulation.
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Propagation report section has been added and includes the error report that provides the
total number of errors and the list of error types.

–

– In addition, the Performance Analysis section of the report includes peak video memory usage
that corresponds to the highest amount of vRAM consumed by the simulation at a certain
time. This information becomes quite useful when you want to estimate how much the resol-
ution of sensors can be increased for instance.

GPU acceleration - Rebalancing Camera simulation

Camera sensors in GPU Inverse simulations are now compatible with:

• the Optimized Propagation set to Relative when running the simulation.

• the Rebalancing mode set to Variance when running the Live Preview.

Virtual Photometric Lab / Virtual Human Vision Lab

• As of version 2026 R1, XMP files generated are in version 10.3. XMP files generated prior to version
2026 R1 will not load in the version 2026 R1 of Speos, Virtual Photometric Lab, and Virtual Human
Vision Lab.

• XMP Filtering is now deactivated by default (set to None) for XMP results generated with a sensor
without XML template applied. Consequently, simulations will require less memory during result
generation and will deliver faster result output, enabling Virtual Photometric Lab / Virtual Human
Vision Lab to open the results more quickly.

4. Optical Part Design

This section highlights the new capabilities introduced in Ansys Speos 2026 R1 designed to enhance
Optical Part Design features.

Optical Part Design - Light Guide

The Light Guide construction algorithm has been enhanced to provide more robust results.

HUD Optical Analysis

HUD Optical Analysis algorithm has been enhanced to better detect stigmatic systems and inform the
user of the situation where Sagittal Virtual Image, Tangential Virtual Image, and Best Focus Virtual Image
are coincident.
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5. Changes

This section describes the operational and support changes introduced in Ansys Speos for NX 2026 R1
release.

Ansys Product Improvement Program

The Ansys Product Improvement Program, controlled through the Licensing Settings utility, is now en-
abled by default. During each session, the product collects anonymous usage data. When the session
ends, this data is securely transmitted to a server accessible only to authorized Ansys employees. After
Ansys receives the data, statistical methods, such as distributions, counts, means, medians, and modes,
are applied to analyze and understand usage patterns.

You can stop participating at any time. See the Enabling the Ansys Product Improvement Program
(APIP) documentation in the Ansys, Inc. Licensing Guide for more information.

Documentation

• Documentation has been updated with a new chapter explaining how to access and collect logs. This
addition makes troubleshooting, debugging, and other diagnostic tasks easier. Besides, it also provides
the development team with possible useful information to investigate and resolve software issues
more efficiently.

• To improve clarity and provide a more coherent workflow, the Simulations and Results documentation
chapters have been reorganized and refined.

– Restructured Simulation chapter: The Simulation content is now organized into clearer,
stage-based sub-sections that better reflect the progression of the simulation process.

– Results integrated into the workflow: The former Results chapter has been moved under
Simulation and renamed Analyzing Results, placing outcome information directly alongside
the steps that produce it.

– Enhanced navigation: The table of contents has been updated to reflect this new structure,
making it easier for users to follow the end-to-end process.

Deprecated / End of support / End of life features

• FTM Layer is deprecated and in end of support in version 2026 R1 and will be in end of life in
version 2027 R1.

• Solstis ray files are deprecated and in end of support in version 2026 R1 and will be in end of
life in version 2027 R1.

• The following filtering options of Virtual Photometric Lab are deprecated and in end of support in
version 2026 R1:

• The following filtering options of Virtual Human Vision Lab are deprecated and in end of support
in version 2026 R1:
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• The human vision Dynamic Adaptation option is deprecated and in end of support in version 2026
R1 in the following tools:

– Virtual Human Vision Lab

– Virtual Reality Lab

– Virtual Lighting Animation Tool

The default Adaptation type value is now set to Dynamic Adaptation 2019.

• The Deterministic algorithm with Photon Map (Build Photon Map, Load Photon Map, Build and Save
Photon Map) is in end of support in version 2026 R1.

• The Camera Post Processing is in end of support in version 2026 R1.

• Ansys Cloud Direct is deprecated on December 31, 2025. Since this date, job submission to Ansys
Cloud Direct are no longer supported. Also, Ansys Cloud Direct documentation is removed from the
Ansys Help site in January.

Versions Update

• Windows: Windows 10 and Windows 11

Minimum NVIDIA Driver 581.42 is required from 2026 R1.

• Speos GPU solver algorithm is now compatible with NVIDIA Blackwell GPU architecture.

Operating System

• NX 2312 is no longer supported as of 2026 R1.

• NX 2406 up to NX 2406 (2406.9160) service pack is now supported as of 2026 R1.

• NX 2412 up to NX 2412 (2412.8701) service pack is now supported as of 2026 R1.

• NX 2506 is no longer in BETA and now officially released as of 2026 R1.

NX 2506 up to NX 2506 (2506.6002) service pack is now supported as of 2026 R1.

• NX 2512 up to NX 2512 (2512.1700) service pack is now supported as of 2026 R1.

6. Resolved Issues and Limitations

For a list of issues that have been resolved in Release 2026 R1, refer to the Resolved Issues and Limitations
document on the Ansys Help website.
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Speos for Creo Parametric Release Notes
The following sections present the new features, enhancements and changes for Speos for Creo Para-
metric 2026 R1 release.

1. Productivity Enhancement

2. Result Experience

3. Changes

4. Resolved Issues and Limitations

1. Productivity Enhancement

This section highlights the new capabilities introduced in Ansys Speos for Creo Parametric 2026 R1
designed to enhance productivity.

Speos RPC

Refer to the Developer Documentation portal to see the latest changes for Speos RPC.

Ambient Sources

The Ambient source sampling algorithm in Direct simulation has been aligned with the other sources.
Consequently:

• Ambient sources will have fewer rays for simulations with multiple sources. The Standard Deviation
is expected to increase marginally.

• Direct simulations time may be improved, especially when multiple sources and ambient sources
are used, and a significant number of rays is set.

• Power Report in the HTML Report now integrates the emitted power information of Ambient
sources (see below)

• Results may be slightly noisier as less rays are sent during the simulation compared to versions
prior to 2026 R1.

Simulation - new 3D Irradiance sensor result

Direct simulation with 3D irradiance sensor now generates a new result that contains all useful inform-
ation for post processing. This is quite useful, especially when performing a Sun burn analysis.

Information for each 3D face includes:
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• Every related to the meshing: facets, vertices and normals

• Radiometric values: irradiance, reflection, transmission, absorption, total power and absorbed
power

• Data to advanced filtering: area and number of impacts per facet

This new result *.rawxm3 file uses the HDF5 format that can be opened with open-source software or
via Python script.

Live Preview

In the Simulation display options of the Live Preview, a new Preview mode has been added to define
how Live Preview displays results during static and dynamic view states to provide different user exper-
iences.

• The new Hybrid mode has been designed for visual fluidity during result navigation:

– When the viewpoint is static, Live Preview uses the GPU rendering. The Live Preview
simulation continues running.

– When moving the viewpoint, Live Preview switches to a traditional CAD colored render
to offer better motion fluidity. During the movement, Live Preview simulation is paused
and resumes as soon as the movement stops and immediately displays back simulation
rendering.

• The GPU mode corresponds to the original mode, and prioritizes GPU simulation visual over
motion fluidity.

– When the viewpoint is static, Live Preview uses the GPU rendering. The Live Preview
simulation continues running.

– When moving the viewpoint, Live Preview keeps running the simulation but at a much
lower resolution to improve interactivity. Resolution gradually increases back to full resol-
ution as soon as movement stops.

Ansys Cloud Burst Compute

Ansys Cloud Burst Compute has been improved with the following new functionalities:

• The new Disable ray files and lpf/lp3 files output option is available in the job submission
window during the creation of the simulation jobs. As these files can take time to be generated,
disabling this option speeds up the simulation generation if you do not need them.

• The new Download results after completion option is available in the job submission window.
Thus, when activating this option, the simulation results are automatically downloaded when
the job is in Finished status.
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• The new Stop and save option is available in the Ansys Cloud Burst Compute Job Manager
window (job monitoring window). This option appears only when a job is running. It stops the
simulation job and saves all results up to the current point.

Ansys Engineering Copilot

Ansys Engineering Copilot is now available to every user, expanding what you can do right away. An-
sysGPT stays part of the enhanced experience offered with an active AnsysGPT AI+ license.

Speos Core

Speos Core has been improved to provide you with a better user experience:

• Speos Core has been optimized to provide better memory management when running multiple
simulations in a row.

• Speos Core offers the possibility to set up GPU preferences as you will do in Speos for NX through
the new GPU solver configuration button available in the SPEOS Core toolbar.

• Speos Core gives you access to the Simulation folder through the new Simulation folder button
available in the SPEOS Core toolbar.

• After a compute, simulation results and report can be opened from the Speos Core tree. This
direct access saves time to find the corresponding files on the hard disk drive.

Libraries

Speos for Creo Parametric now offers the possibility to customize the path of the Optical Libraries folder
(by default in C:\Program Files\ANSYS Inc\vXXX\Optical Products\OpticalLibraries).

In addition, a direct access to Libraries shows all the Optics library content (optical properties, sensors,
sources and standards).

2. Result Experience

This section highlights the new capabilities introduced in Ansys Speos for Creo Parametric 2026 R1
designed to enhance the result experience.
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CPU/GPU solver algorithms

• CPU and GPU solver algorithms have been aligned for a better management of unpolished surfaces.

• GPU solver algorithm has been optimized to provide better memory management when running
multiple GPU simulations in a row.

• The GPU solver algorithm has been improved to correctly take into account rays intersecting Exit
Geometries (from Ray File or Surface source) during a simulation.

• The GPU solver algorithm has been aligned with the CPU solver algorithm for a better management
of Display sources in simulation. Now Fast Transmission Gathering algorithm (when activated)
automatically applies to the geometry (automatically created by the simulation) of a Display source.
Thus, the geometry is ignored by the simulation.

Simulation result - HTML GPU Report

Now, GPU simulation report provides the same level of information as CPU simulation.

• Propagation report section has been added and includes the error report that provides the
total number of errors and the list of error types.

• In addition, the Performance Analysis section of the report includes peak video memory usage
that corresponds to the highest amount of vRAM consumed by the simulation at a certain time.
This information becomes quite useful when you want to estimate how much the resolution of
sensors can be increased for instance.

GPU acceleration - Rebalancing Camera simulation

Camera sensors in GPU Inverse simulations are now compatible with the Rebalancing mode set to
Variance when running the Live Preview.

Virtual Photometric Lab / Virtual Human Vision Lab

• As of version 2026 R1, XMP files generated are in version 10.3. XMP files generated prior to version
2026 R1 will not load in the version 2026 R1 of Speos, Virtual Photometric Lab, and Virtual Human
Vision Lab.

• XMP Filtering is now deactivated by default (set to None) for XMP results generated with a sensor
without XML template applied. Consequently, simulations will require less memory during result
generation and will deliver faster result output, enabling Virtual Photometric Lab / Virtual Human
Vision Lab to open the results more quickly.
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3. Changes

This section describes the operational and support changes introduced in Ansys SPEOS for Creo Para-
metric 2026 R1 release.

Ansys Product Improvement Program

The Ansys Product Improvement Program, controlled through the Licensing Settings utility, is now en-
abled by default. During each session, the product collects anonymous usage data. When the session
ends, this data is securely transmitted to a server accessible only to authorized Ansys employees. After
Ansys receives the data, statistical methods, such as distributions, counts, means, medians, and modes,
are applied to analyze and understand usage patterns.

You can stop participating at any time. See the Enabling the Ansys Product Improvement Program
(APIP) documentation in the Ansys, Inc. Licensing Guide for more information.

Documentation

• Documentation has been updated with a new chapter explaining how to access and collect logs. This
addition makes troubleshooting, debugging, and other diagnostic tasks easier. Besides, it also provides
the development team with possible useful information to investigate and resolve software issues
more efficiently.

• To improve clarity and provide a more coherent workflow, the Simulations and Results documentation
chapters have been reorganized and refined.

– Restructured Simulation chapter: The Simulation content is now organized into clearer,
stage-based sub-sections that better reflect the progression of the simulation process.

– Results integrated into the workflow: The former Results chapter has been moved under
Simulation and renamed Analyzing Results, placing outcome information directly alongside
the steps that produce it.

– Enhanced navigation: The table of contents has been updated to reflect this new structure,
making it easier for users to follow the end-to-end process.

Deprecated / End of support / End of life features

• FTM Layer is deprecated and in end of support in version 2026 R1 and will be in end of life in
version 2027 R1.

• Solstis ray files are deprecated and in end of support in version 2026 R1 and will be in end of
life in version 2027 R1.

• The following filtering options of Virtual Photometric Lab are deprecated and in end of support in
version 2026 R1:

• The following filtering options of Virtual Human Vision Lab are deprecated and in end of support
in version 2026 R1:
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• The human vision Dynamic Adaptation option is deprecated and in end of support in version 2026
R1 in the following tools:

– Virtual Human Vision Lab

– Virtual Reality Lab

– Virtual Lighting Animation Tool

The default Adaptation type value is now set to Dynamic Adaptation 2019.

• The Deterministic algorithm with Photon Map (Build Photon Map, Load Photon Map, Build and Save
Photon Map) is in end of support in version 2026 R1.

• The Camera Post Processing is in end of support in version 2026 R1.

• Ansys Cloud Direct is deprecated on December 31, 2025. Since this date, job submission to Ansys
Cloud Direct are no longer supported. Also, Ansys Cloud Direct documentation is removed from the
Ansys Help site in January.

Versions Update

• Windows: Windows 10 and Windows 11

Minimum NVIDIA Driver 581.42 is required from 2026 R1.

• Speos GPU solver algorithm is now compatible with NVIDIA Blackwell GPU architecture.

Operating System

• Version of Creo 8 is no longer supported as of 2026 R1.

• Versions of Creo 9 from 9.0.1.0 to 9.0.11.0 are now supported as of 2026 R1.

• Versions of Creo 10 from 10.0.0.0 to 10.0.9.1 are now supported as of 2026 R1.

• Versions of Creo 11 from 11.0.0.0 to 11.0.6.0 are now supported as of 2026 R1.

• Versions of Creo 12 from 12.0.0.0 to 12.4.1.0 are now supported as of 2026 R1.

4. Resolved Issues and Limitations

For a list of issues that have been resolved in Release 2026 R1, refer to the Resolved Issues and Limitations
document on the Ansys Help website.
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Speos Labs Release Notes
The following sections present the new features and changes for Speos Labs 2026 R1 release.

1. New Features and Enhancements

2. Changes

3. Resolved Issues and Limitations

1. New Features and Enhancements

This section describes the new features and enhancements introduced in Speos Labs 2026 R1 release.

Speos RPC

Refer to the Developer Documentation portal to see the latest changes for Speos RPC.

Simulation - new 3D Irradiance sensor result

Direct simulation with 3D irradiance sensor now generates a new result that contains all useful inform-
ation for post processing. This is quite useful, especially when performing a Sun burn analysis.

Information for each 3D face includes:

• Every related to the meshing: facets, vertices and normals

• Radiometric values: irradiance, reflection, transmission, absorption, total power and absorbed
power

• Data to advanced filtering: area and number of impacts per facet

This new result *.rawxm3 filenew result *.rawxm3 file uses the HDF5 format that can be opened with
open-source software or via Python script.

Virtual 3D Photometric Lab

Upon creation of a new area in the Measures table, the purple area is automatically set to half the width
and height sizes of the bounding box. In the Measures window, Dimension section, you can resize the
Width and Height freely.
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Virtual Photometric Lab / Virtual Human Vision Lab

• As of version 2026 R1, XMP files generated are in version 10.3. XMP files generated prior to version
2026 R1 will not load in the version 2026 R1 of Speos, Virtual Photometric Lab, and Virtual Human
Vision Lab.

• XMP Filtering is now deactivated by default (set to None) for XMP results generated with a sensor
without XML template applied. Consequently, simulations will require less memory during result
generation and will deliver faster result output, enabling Virtual Photometric Lab / Virtual Human
Vision Lab to open the results more quickly.

2. Changes

This section describes the operational and support changes introduced in Ansys Optical Labs 2026 R1
release.

Deprecated / End of support / End of life features

• FTM Layer is deprecated and in end of support in version 2026 R1 and will be in end of life in
version 2027 R1.

• Solstis ray files are deprecated and in end of support in version 2026 R1 and will be in end of
life in version 2027 R1.

• The following filtering options of Virtual Photometric Lab are deprecated and in end of support in
version 2026 R1:

• The following filtering options of Virtual Human Vision Lab are deprecated and in end of support
in version 2026 R1:

• The human vision Dynamic Adaptation option is deprecated and in end of support in version 2026
R1 in the following tools:

– Virtual Human Vision Lab

– Virtual Reality Lab

– Virtual Lighting Animation Tool

The default Adaptation type value is now set to Dynamic Adaptation 2019.
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Versions Update

• Windows: Windows 10 and Windows 11

Minimum NVIDIA Driver 581.42 is required from 2026 R1.

• Speos GPU solver algorithm is now compatible with NVIDIA Blackwell GPU architecture.

3. Resolved Issues and Limitations

For a list of issues that have been resolved in Release 2026 R1, refer to the Resolved Issues and Limitations
document on the Ansys Help website.
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Speos HPC Release Notes
The following sections present the changes and enhancements for Speos HPC 2026 R1 release.

1. New Features and Enhancements

2. Resolved Issues and Limitations

1. New Features and Enhancements

Simulation

• The multi-GPU memory-management algorithm has been optimized to deliver better performance
when running simulations containing a Physical Camera sensor.

• The Speos HPC algorithm has been enhanced to provide faster simulation result-generation perform-
ance.

GPU

• Windows: Windows 10 and Windows 11

Minimum NVIDIA Driver 581.42 is required from 2026 R1.

• Linux

Minimum NVIDIA Driver 580.95.05 is required from 2026 R1.

• Speos GPU solver algorithm is now compatible with NVIDIA Blackwell GPU architecture.

2. Resolved Issues and Limitations

For a list of issues that have been resolved in Release 2026 R1, refer to the Resolved Issues and Limitations
document on the Ansys Help website.
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Ansys Acoustics Products

Release notes are available for the following Ansys Acoustics Products:

ANSYS Sound (p. 229)





Ansys Sound Release Notes
The following sections present the new features, enhancements and changes for Ansys Sound™ products
in the 2026 R1 release.

1. Changes in Product Behavior

2. Ansys Sound: Analysis and Specification

3. Ansys Sound: Jury Listening Test

1. Changes in Product Behavior

Release 2026 R1 includes new features and enhancements that result in product behaviors that differ
from previous releases. These behavior changes are presented below.

• The default ECMA-418-2 Psychoacoustic Tonality indicator in Ansys Sound: Analysis and
Specification has been updated to use the 3rd edition of the standard instead of the 1st edition
used in previous releases. Results for this indicator may therefore differ from those obtained
using previous versions of the application.

2. Ansys Sound: Analysis and Specification

The following sections present the new features and enhancements for the Ansys Sound: Analysis and
Specification™ application 2026 R1 release.

2.1. New Features

ECMA-418-2 Tonality Indicator

The ECMA-418-2 psychoacoustic tonality indicator has been updated to support the 3rd (2024) edition
of the standard in addition to the 1st (2020), selectable using a drop-down menu in the UI. The 3rd
edition is now the default setting, so results may differ from those obtained using previous versions
of the application.

Sound Generation from dBA Spectrum

The AnsysSound_Spectrum file format has been incremented to version 4 to add support for dBA
and dBA/Hz data.

Calculate Octave and One-third Octave Levels from PSD

Octave and One-third octave levels can now be calculated from a Power Spectral Density (PSD), in
addition to a temporal signal.

Level vs Frequency File Format
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A new file format has been created to allow import of files containing level against frequency for
Generation of Harmonics from a Waterfall and Creating a Track with a Harmonics Source.

2.2. Enhancements

Mix Table

The Mix Table user interface has been updated to allow complete display of the signal names.

Spectrum Calculation Parameters

You can now update and reapply Spectrum Calculation Parameters for any signals displayed in a
spectrum window.

2.3. Resolved Issues and Limitations

For a list of issues that have been resolved in Release 2026 R1, refer to the Resolved Issues and Lim-
itations document on the Ansys Help website.

3. Ansys Sound: Jury Listening Test

The following sections present the new features and enhancements for the Ansys Sound: Jury Listening
Test™ application 2026 R1 release.

3.1. Enhancements

Recording Device Equalization

The setup for the Sounds Database has been restructured to allow selection of the appropriate record-
ing device from an Equalization menu and a subsequent Setting for that device where applicable.

3.2. Resolved Issues and Limitations

For a list of issues that have been resolved in Release 2026 R1, refer to the Resolved Issues and Lim-
itations document on the Ansys Help website.
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Ansys Autonomous Vehicle Products

Release notes are available for the following Ansys Autonomous Vehicle products:

Ansys AVxcelerate Lighting and Sensors (p. 233)

Ansys AVxcelerate Sensors (p. 235)





AVxcelerate Lighting and Sensors Release Notes
The following section presents the enhancement and changes for AVxcelerate Lighting and Sensors
2026 R1 release.

1. Enhancement

2. Changes

1. Enhancement

This section describes the enhancement introduced in AVxcelerate Lighting and Sensors 2026 R1 release.

1.1. Co-simulation with CarMaker 14

You can now perform Co-simulation with CarMaker using version 14.1. The AVxcelerate Headlamp
Library for CarMaker has been enriched with a sample project as well as TestRuns, roads and assets
for this CarMaker 14 version.

AVxcelerate Lighting and Sensors is compatible with CarMaker versions 12.0.1, 13.0 and 14.1. CarMaker
11 is no longer supported.

1.2. Enhanced security added to gRPC communication

In AVxcelerate Lighting and Sensors, the default configuration now uses the UDS transport mode to
secure the connection between the software and CarMaker.

For more details, refer to Transport Modes section on this page in the User Guide.

2. Changes

This section describes the changes introduced in AVxcelerate Lighting and Sensors 2026 R1 release.

2.1. Integrated Plugins

The Virtual Regulation plugins, previously delivered as add-on packages, are now included into the
Ansys AVxcelerate Headlamp product. You can find the C-IASI, IIHS, and FMVSS components in the
VirtualRegulations subfolder in the AVxcelerate Lighting and Sensors installation directory.

2.2. Updated Installation Paths

The following File Locations have been changed:
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• The AVxcelerate Lighting and Sensors software is now installed in a the Autonomy\AVxcel-
erateHeadlamp\VRX folder, no longer in Optical Products\VRXPERIENCE\VRX.

• The AVxcelerate Lighting and Sensors logs are now saved to %localappdata%\An-
sys\v261\Autonomy\AVxcelerateHeadlamp\VRX.

• The default location for SCANeR resources corresponding to your AVSimulation SCANeR™
version are now located in a folder named AVX_SCANeR_2026R1 in the AVSimulation
folder.

2.3. Windows 10 No Longer Supported

In the 2026 R1 release, all references to Windows 10 have been removed from the product document-
ation. This change aligns with Microsoft's official end of support for Windows 10, ensuring the product
remains consistent with current platform standards and supported environments.

Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.234

AVxcelerate Lighting and Sensors Release Notes



AVxcelerate Sensors Release Notes
The following sections present the new features, enhancements and changes for the AVxcelerate

SensorsTM solution 2026 R1 release.

1. New Features

2. Enhancements

3. Changes

1. New Features

This section describes the new features introduced in AVxcelerate Sensors Simulator 2026 R1 release.

1.1. OSI Input Availability added to AVX Simulations

ASAM Open Simulation Interface (OSI) API is now available as an addition to the standard AVxcelerate
Sensors Simulator API. This enhancement enables seamless integration with industry-standard simu-
lation environments and toolchains, improving interoperability for ADAS and autonomous driving
development workflows.

Benefits include:

• Standardized Data Exchange:  Supports OSI-compliant environment data formats.

• Improved Compatibility:  Easily connect with third-party simulation tools and ASAM-compliant
platforms.

• Future-Ready:  Aligns with automotive industry standards for simulation and testing.

For more details on ASAM OSI and how to configure it, refer to the Ansys Developer Portal.

1.2. IP Protection for Camera Sensors

Using the AVxcelerate Sensor Labs application or the Sensors REST API v8, you can activate IP protection
on any section of a camera or fisheye camera, namely Lens System, Imager, Default Post Processing
or Sensor Output. It is now also possible to activate the Global Protection in order to protect all
the sections of the sensor at once.

The following parameters however are always visible and editable even when protection is activated:

• the Windshield parameters of the Lens System section,

• the Native Resolution parameter of the Imager section,
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• the Frame Rate, Time Encoding and Diffraction Spike parameters of the Default Post Pro-
cessing section,

• the Output parameter of the Sensor Output section.

2. Enhancements

This section describes the enhancements introduced in AVxcelerate Sensors Simulator 2026 R1 release.

2.1. Camera Simulation with Light Propagation Engine

First released in 2025 R2, the new rendering engine for camera sensor simulation remains a beta
feature in 2026 R1. The performance as well as the output quality of camera simulations with Light
Propagation Engine have been greatly improved thanks to new features and various enhancements.

2.1.1. New Raytraced Ambient Occlusion

Instead of using the Screen Space Ambient Occlusion to compute ambient occlusion maps, you
can now use Raytraced Ambient Occlusion, which calculates shadows and depth more accurately,
therefore producing more photo-realistic output.

Occlusion Map with Raytraced Ambient
Occlusion

Occlusion Map with Screen Space Ambient
Occlusion

2.1.2. New Raytraced Reflections

You now have the possibility to enable the new Raytraced Reflections feature so that the specular
materials reflect not only the sky, but also surrounding objects taking into account the different
types of light sources in the scene.
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2.1.3. Improved Raytraced Shadows

When the Raytraced Shadows parameter is enabled, all the shadows are now raytraced, no matter
the type of shadow configured in the properties of the point lights (static or dynamic). Thanks to
this enhancement, GPU memory consumption remains moderate even when the scene includes
many point lights. For more information on the above three ray-tracing features in LPE, see the
Camera Simulation Parameters page in the User's Guide.

2.1.4. Enhancement to the Fog feature

The fog beta feature delivered in the previous release did not simulate atmospheric scattering effects.
Now, fog color accounts for sky radiance, producing more realistic variations based on the camera's
angle to the sun.

2.1.5. Rain in simulation

The 2026 R1 release introduces a real-time, physics-based rain phenomenon to enhance the realism
of camera testing. The rain dynamically interacts with the environment and lighting conditions,
improving accuracy in sensor evaluation.

In addition to the rain intensity, the wind conditions can be set. The rain rendering depends on
the vehicle's speed and is dynamically correlated to the camera sensor exposure time.
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Note: Rain Simulation is released as a beta feature. Functionality may evolve in future versions.

2.2. Thermal Camera Sensor Creation and Edition

From now on you can create, edit and manage thermal cameras from the AVxcelerate Sensor Labs
application or its REST APIs just like any other type of sensors.

New sets of dedicated parameters let you configure each component of a thermal camera sensor so
that the simulated model reflects the specifications of your Long Wavelength InfraRed (LWIR) camera.

If safeguarding your Intellectual Property is a concern, you can activate the IP protection on one or
several specific components, Lens System, Imager, Default Post Processing, or on the entire sensor.
The only parameters that are always visible are the imager's native resolution and the frame rate.
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After creation and edition, thermal camera models can be downloaded as a file (with the lwircamerax
extension) or added to a sensor layout that will be used in simulation.

Important note: Be aware that thermal camera sensors from any version prior to 2026 R1 are now
longer supported in the 2026 R1 release of the AVxcelerate Sensors.

The Thermal Camera Editor tool, which was previously delivered as a beta feature, as well as the
packer and unpacker executables are no longer delivered.

2.3. GPU Direct Memory Access (DDMA) to Sensors Outputs

The GPU Direct Memory Access feature allows accessing raw sensor data directly on GPU, without
going through the CPU & Memory. Fast GPU post-processing or fast data transfer for HIL injection
are now possible.

Delivered as a beta feature, the DDMA Software Development Kit (SDK) includes the components
required to develop your own custom library on Windows or Ubuntu operating systems, namely the
DDMA extension, the ProcessSensorData.h header file, as well as samples (such as Camera GPU DDMA
and Radar DDMA).

In addition, the new GPU RDMA sample, which is an alternative to the already existing CPU RDMA
sample, allows for the transfer of some types of camera sensor output data from the GPU memory
using an RDMA sender.

For more details, especially on the supported data formats, refer to Raw Data Output for DDMA and
Raw Data Output for RDMA.

In this release, an additional step is required to use DDMA or RDMA, the Data Access Settings section
in the simulation parameters of your radar or camera sensor must be configured with the new Data
Direct Memory Access parameter, in which you can define the Target to either GPU or CPU according
to the memory domain you want to use.

2.4. Co-simulation with CarMaker 14

AVxcelerate Sensors Simulator is now also compatible with CarMaker version 14.1.

The complete list of CarMaker and CarMaker HiL versions supported by AVxcelerate Sensors Simulator
2026 R1 are listed in AVxcelerate Sensors Simulator System Requirements.

2.5. Radar Simulation Improvement with Respect to Curved Surfaces

Part of the Radar Simulation Parameters, this optional parameter indicates whether or not to consider
the curvature of a surface for bouncing rays. The curvature of the surface being always considered
for the back scattered power calculation at the receiver antenna.

2.6. New Tracks Added

Two new tracks from 3D Mapping Solutions are available for the library, which correspond to real
locations in Germany:

• A8 Leonberg - Germany (highway): This is included in the installation library.
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• Downtown Ingolstadt - Germany (urban):  Available for download at the Ansys Download
Center, found on the Current Release page in the AddOn Packages section.

For other tracks corresponding to different locations, contact 3D Mapping Solutions at 3D Mapping.
They will provide an environment in Ansys AVxcelerate .track data format with physics-based aug-
mentation.

2.7. Addition of NCAP 2026 Assets and Track

NCAP (New Car Assessment Program) assets and track are now provided during product installation
for use in simulations.

• Asset files provided are located in the [Library Installation Directory]/AVX_Library_v261/As-
sets_Standalone folder.

• Track file provided is located in the [Library Installation Directory]/AVX_Library_v261/Tracks_Stan-
dalone folder.

The dimensions of the NCAP assets are based on NCAP specifications. Refer to Euro NCAP AEB LSS
VRU Test Protocol - v4.5.1.

2.8. Enhanced security added to gRPC communication used within the
AVxcelerate SensorsTM solution

Enhanced security settings have been implemented to enable secure-by-default settings in gRPC.

2.8.1. AVxcelerate Sensors Simulator and API

To ensure security, AVxcelerate Sensors Simulator now uses the UDS transport for internal commu-
nication across its processes on the same workstation.

If you are distributing AVxcelerate Sensors Simulator processes across multiple workstations (see
Multi-machine Simulations), AVxcelerate Sensors Simulator must be configured to use the mTLS
transport mode instead of UDS.

To pilot AVxcelerate Sensors Simulator or to collect sensor data via its API, you have to select the
appropriate transport mode depending on whether it is done from the same workstation or not:

• UDS transport mode when it is done from the same workstation,

• mTLS transport mode when it is done from a remote workstation.

An insecure option remains available, but its use is not recommended.

For more details, refer to Transport Modes.

2.8.2. Asset Preparation API

With the default communication configuration, the Asset Preparation server now only accepts
connections from client applications using the Unix Domain Socket (UDS) transport mode.

You should then modify your client applications so that they use the same transport mode.
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Alternatively, you may use the insecure transport mode.

For more details, refer to the Transport Modes section in the AVxcelerate Asset Preparation API
Documentation.

3. Changes

This section describes the changes introduced in AVxcelerate Sensors 2026 R1 release.

3.1. AVxcelerate Sensors Simulator API v1

In the 2026 R1 release, the AVX internal gRPC server supports two versions of the AVxcelerate Sensors
Simulator API: v0 and v1.

The AVxcelerate Sensors Simulator API v0 delivered in 2026 R1 is identical to the version delivered
in 2025 R2. This version of the API will be officially discontinued in 2028.

In the AVxcelerate Sensors Simulator API v1, new features have been added and deprecated fields
have been removed. The comprehensive list of changes can be found in the Changelog section of
the API documentation available in the AVxcelerateSensors/APIs/VSS_API/Documentation/v1 folder or
on the Ansys Developer Portal.

To benefit from new features introduced in 2026 R1, any custom applications or scripts must be up-
dated to use AVxcelerate Sensors Simulator API v1. Additionally, Ansys strongly recommends to update
your simulation parameters json files.

The CarMaker connectors, the samples illustrating the usage of the AVxcelerate Sensors Simulator
API, as well as the simulation parameters example files provided in the AVxcelerate Sensors Library
or in the AVxcelerate Sensors Library for LPE now use the AVxcelerate Sensors Simulator API v1.

3.2. Discontinued Tools and Samples

• The packer and unpacker executables are no longer delivered.

• The Binary Data Transfer sample is discontinued.

3.3. AVSimulation SCANeRTM Connector

SCANeR connector and co-simulation is no longer distributed as part of the installer. It has to be re-
quested from the support team.

3.4. Windows 10 No Longer Supported

In the 2026 R1 release, all references to Windows 10 have been removed from the product document-
ation. This change aligns with Microsoft's official end of support for Windows 10, ensuring the product
remains consistent with current platform standards and supported environments.
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Ansys Mesh Prep Products

Release notes are available for the following Ansys Mesh Prep products:

Meshing (p. 245)

ICEM CFD (p. 249)





Meshing Application Release Notes
Release 2026 R1 of the Meshing application contains many new features and enhancements. Areas
where you will find changes and new capabilities include the following:

1. Changes in Product Behavior from Previous Releases

2.Topology Suppress

3. Morph Control

4. Enhancements to Mesh Workflows

5. Enhancements to MultiZone Method

6. Enhancements to Weld

7. Enhancements to Meshing Options

8. Enhancements to Sizing Group

Many of the enhancements detailed in the Mechanical Application Release Notes are also relevant to
the Meshing application.

1. Changes in Product Behavior from Previous Releases

The 2026 R1 release includes the following changes in product behavior:

• In Mesh Workflows,

– Create Labels  operation is renamed to Add Labels.

– Proximity Label Creation is renamed to Proximity Label Addition.

– Scope Label Creation is renamed to Scope Label Addition.

• Automatic (PrimeMesh) method can now apply sizing before Repair Topology operations.

2. Topology Suppress

This is the first release of Topology Suppress. Topology Suppress allows you to suppress the selected
entities in the topology. Topology Suppress supports only solids scoped with Multizone and shells
scoped with Automatic (PrimeMesh)methods.

For more detailed information, see Topology Suppress.
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3. Morph Control

This is the first release of Morph Control. Morph Control allows you to select points in the mesh, move
the selected points with a prescribed transformation and perform a smooth interpolation for the
morphable layer between the moving and the fixed nodes without destroying the mesh integrity.

For more detailed information, see Morph Control.

4. Enhancements to Mesh Workflows

Mesh Workflows has been enhanced to:

• Provide two new mesh workflows namely:

– FSI FEM Acoustics

– Direct Morphing

• Stacker Mesh Workflow has been enhanced to include:

– MultiZone: Mesh Surface operation

– Create Solder Ball operation

– Non-stackable faces and edges outcome

– Stacker diagnostics to check intersections in bodies.

– Merge replicated bodies to the parent bodies in mesh volume.

For more detailed information, see Stacker Mesh Workflow.

• Provide new controls and outcomes in operation.

For more detailed information, see Mesh Workflows.

5. Enhancements to MultiZone Method

MultiZone Method has been enhanced to perform smoothing on mesh using Enable Smoothing and
skips smoothing on inflation layers when Freeze Inflation Layers is Yes.

For more detailed information, see MultiZone Mesh Method.

6. Enhancements to Weld

Weld has been enhanced to create Weld Tail Extension at both ends of the weld body when the
Source is Mesh.

For more detailed information, see Weld.
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7. Enhancements to Meshing Options

Meshing Options has been enhanced to include the following options:

• Global Sizing Type to choose the default behavior for Mesh Sizing under Sizing Group in
Mesh Details view.

• Show Hex Dominant Method for Explicit Physics to display Hex Dominant Method for Explicit
Physics Preference. The default value for Show Hex Dominant Method for Explicit Physics is
No as Explicit Physics Preference does not prefer pyramid generation.

• Mechanical Physics Preference Fallback on Failure to enable fallback option when meshing
fails on a part or body. The default value is Adaptive Remesh.

• Mesh Disconnected Body Groups in Parallel to perform parallel meshing on disconnected
body groups. Here, body group is a collection of multiple bodies that are connected and is
treated as a single entity for meshing. The default value is No.

For more detailed information, see Meshing Options.

8. Enhancements to Sizing Group

Sizing group has been enhanced for Mechanical Physics Preference to include Mesh Sizing to refine
the mesh size based on the mesh sizing options. The available mesh sizing options are:

• Coarse

• Medium

• Fine

• Uniform

• Advanced

• Adaptive

For more detailed information, see Sizing Group.
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ICEM CFD
Release 2026 R1 development efforts included enhancement of Ansys ICEM CFD as a standalone applic-
ation as well as continued development of its underlying technology exposed within the Ansys Work-
bench-based Meshing application.

Ansys ICEM CFD 2026 R1 changes and new capabilities include the following:

1. Import Geometry Options

1. Import Geometry Options

Import Geometry now supports only the following Legacy CAD formats for both Windows and Linux
OS:

• CATIA V4

• Rhino 3DM

• Plot3d

Import Geometry does not support the following Legacy formats:

• ACIS (Linux only)

• DWG (Linux only)

• GEMS, IDI (Linux only)

• ParaSolid (Linux only)

• STEP / IGES (Linux only)
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Ansys Connect Products

Release notes are available for the following Ansys Connect products:

Ansys Minerva (p. 253)

Distributed Compute Gateway (p. 257)

optiSLang (p. 259)

ModelCenter (p. 267)





Ansys Minerva
The following topics provide an overview of what is new and improved in Ansys Minerva 2026 R1:

1. New Features and Enhancements

2. Resolved Issues

3. Known Issues and Limitations

4. Documentation Enhancements

1. New Features and Enhancements

New features and enhancements are available in the following areas of Ansys Minerva 2026 R1:

1.1. User Experience

1.2. Data

1.3. Configuration

1.1. User Experience

You now have an improved user experience when navigating Ansys Minerva, with the following
changes:

• The overall user interface, including the Form 2.0 elements, has been updated to provide a
more modern and consistent look.

• Less frequently used options have been hidden from the item toolbar and user menu.

• Unused applications such as Paint, Notepad, and Remote Desktop have been removed.

253
Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.



1.2. Data

• You can now open a folder in a new Data view tab for faster navigation and better content man-
agement. To do so, use either of the following methods:

– In the Data view, select a folder and click Open, or Ctrl+ click the folder.

– When viewing an item, click any of its parent folders in the breadcrumbs.

• When you select an item in the Data view and click Properties, the item now opens in a new tab
with the Properties tab active. Previously, a fixed set of properties was displayed in a dialog.

1.3. Configuration

• In the query builder, when defining a custom format for the property information to be returned,
you now need to use a Mamba expression instead of an SQL query. This helps you protect your
data from risks like SQL injection.
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For more information, see ????.

• The following enhancements have been made to Forms 2.0:

– The Name property is now required for the Form element.

– The styling of the form elements have been improved to provide a more modern look.

– You can now configure an Action Submit button to validate the form on click. This prevents
users from submitting the form with invalid inputs. See ????.

– A new Preview  button is available in the Form 2.0 editor. It enables you to preview the form
with a desired context, exactly as it will appear when rendered.

2. Resolved Issues

For a list of issues that have been resolved in Ansys Minerva 2026 R1, see the Ansys Minerva section of
the Ansys Resolved Issues and Limitations.

3. Known Issues and Limitations

All issues and limitations known at the time of release are listed in the ???? section of the Ansys Minerva
Troubleshooting Guide.

Issues discovered after release are listed in the Ansys Minerva section of the Ansys Known Issues and
Limitations.
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4. Documentation Enhancements

• A dedicated user's guide for Generic Connector is now available. See Ansys Minerva Generic Connector
User's Guide.

• The Forms 2.0 section in configuration guide has been improved to include a comprehensive walk-
through video, task-oriented topics detailing the usage of individual Form 2.0 elements, and some
form examples. See Ansys Minerva Configuration Guide: ????.

• A Quick Start section is now available for the Mamba Expression Language. It helps you quickly explore
and understand commonly used expressions in Ansys Minerva, with examples and syntax explanations.
See Ansys Minerva Configuration Guide: ????.
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Distributed Compute Gateway (DCG)
The following topics provide an overview of what is new and improved in Distributed Compute Gateway
2026 R1:

1. New Features and Enhancements

2. Resolved Issues

3. Known Issues and Limitations

1. New Features and Enhancements

No enhancements were made to Distributed Compute Gateway in this release.

Advisory

Release 2026 R1 will be the final version of the Distributed Compute Gateway (DCG) application. Support
for DCG will end in 2027.

The functionality of DCG has been transitioned to Ansys HPC Platform Services — the next-generation
solution for HPC workflow management from Ansys. With support for both on-premises and cloud
computing environments, HPC Platform Services helps you manage the execution of simulations while
making use of your full range of computing assets.

For more information, see the Ansys HPC Platform Services page on the Ansys Help site or contact
Ansys Support.

2. Resolved Issues

For a list of issues that have been resolved in Distributed Compute Gateway 2026 R1, see the Distributed
Compute Gateway (DCG) section of the Ansys Resolved Issues and Limitations.

3. Known Issues and Limitations

All issues and limitations known at the time of release are listed in the Troubleshooting section of the
Distributed Compute Gateway User's Guide.

Issues discovered after release are listed in the Distributed Compute Gateway (DCG) section of the Ansys
Known Issues and Limitations.
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optiSLang
The following sections contain release information for Ansys optiSLang 2026 R1:

1. General

2. User Interface

3. Connectors

4. Algorithms

1. General

Installation Improvements: Installer Granularity & Size Reduction

• Added New Install Options

– Ansys optiSLang Core Headless (1.5 GB) - For "inside" Flagships (except AEDT/Workbook) and for
pyoptiSLang

– Ansys optiSLang Core UI (0.9 GB) - Desktop UI, Integrations, Examples, tools

– AI (2.2 GB)

– AI+ App Generation (0.6 GB)

• Reduced total optiSLang installation size from 6.7GB to 1.5GB for "inside" use (78% reduction).

• Uses more Ansys central components

Ansys optiSLang "inside" Ansys Discovery

• Define variations now supports Sensitivity Analysis

– Determines predictive quality and sensitivity matrix

– Visualize the relationship between inputs and output with 3D response surfaces plots

– Improves investigation of the influence of parameterized inputs on outputs

• One Click Optimization (coming in 2026R1 SP1)

– Embedded optiSLang algorithms allow users to set constraints or objectives to optimize against

– Ansys Discovery builds a Pareto front with provided range of parameters plus maximum quantity
of variations

– Easily explore a range of values before validating designs in Ansys Mechanical, Fluent, or Icepak
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• Log/debug messages available in Ansys Discovery. Export to optiSLang GUI and Postprocessing for
more.

PyOptiSLang Enhancements

Configuration Example

• Algorithms are directly accessible via pyoptiSLang. Define parametric and create design studies.

• Execute via Callbacks, run with Getter/Setter

• Inspect result designs

• Goto optiSLang

PyOptiSLang Cheat Sheet

• Added to the pyoptislang documentation.

• Similar to other PyAnsys Libraries

• Summarizes key functionality

• Covers: optiSLang instance management, project management, design evaluation, workflow generation,
and working with placeholders.

SSH Remote Execution Enhancements

• Most changes require no "reset" of remote execution

• Remote profile changes are now reflected in remote execution

• Improved reconnect capabilities

• Now handles brackets in system name/working directory path

• C-Shell (csh/tcsh) remotes now fully supported

• Applying wizards to SSH systems now fully working

• Can now handle renamed systems/changed design directories

• Passwordless setup script now works for ports other than 22.

• Improved/extended logging

HPS Integration

• Self-contained optiSLang projects can be prepared and published to an HPS service instance.

– The integration supports parameters, responses, placeholders, and input files defined at project
level.
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• HPS-published projects can then be used in Ansys optiSLang workflows

– Change input parameters/files

– Receive output parameters as responses/output files

2. User Interface

GUI Updates

• Supported UI styles on Windows:

– Dark, Light

→ use fixed Ansys colors

→ Independent of any Windows color/style/theming settings

– Fusion, Windows, Windows Vista, Windows11

→ Follows and respects the Windows platform palette.

→ Works with high-contrast themes in the Windows accessibility settings

• Fixed styling issues in Plugin Dialogs and HighDPI/4K issues in the overall GUI.

Workflow US Style Adoption

• Edges and flyouts now have rectangular corners, with a new setting for round corners on flyouts.

• In Condensed mode, flyouts no longer expand. The slot item itself is the drag-and-drop area.

• Postprocessing icons have been updated.

3. Connectors

Unified Run Options

• "Delay before execution" / "Delay between parallel executions" options are now consistent across
integration nodes with new Run Options tab

LS-OPT Node

• New LS-OPT node allows you to use legacy LS-OPT projects in optiSLang,

• Workflows can be continued/extended with algorithms like OCO and AMOP.

• Integration & Automation can be accessed with more solvers or AI.

• Parent-Child licensing context for using the same license.
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Ansys SimAI Solver Node (Beta)

• Inputs: Geometry, Boundary Conditions

• Outputs: Defined Global Coefficients, Confidence Score is shown

• Option to download result in vtk format

Ansys Rocky

• Updated the connector to single node solution

• Implemented guided solver wizard

Ansys FreeFlow

• New node based on Rocky integration

• Implemented guided solver wizard

Ansys Lumerical Node

• Added Parameter extraction and Output Extraction from all sources (Model, Root Element, Structure
groups)

• Added Custom script path support (including relative paths to *.lsf )

• Added Automatic solver selection

• Now allows Script for Pre-/Post-Processing

• Added GPU-based execution

• Added Export tab for plots and data

Ansys OpticStudio Node

• Added a Radius vs. curvature setting

• Supports Hybrid mode (sequential mode with NSC and parameter extraction from both editors)

• Added Merit function value extraction

• Enhanced support for archive files

• Added an Export tab for plots and data

COMSOL Connector

• Extended support to COMSOL v3

• Adopted new customization interface v2520 standard
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• Added the test run feature

• Added a tutorial for COMSOL

NX and NASTRAN Connectors

• Extended support to latest versions

• Adopted new customization interface v2520 standard

• Added a tutorial for NASTRAN

Fluent Mesh Node

• Added support for post-processing script to customize and adapt mesh postprocessing

ETK Abaqus

• Introduced ODB file version chooser: you can select the version when opening an ODB file

• Added a new column to the Variables tab to show the selected Abaqus version. The version can also
be changed from here.

• Backward compatible to Abaqus 2021.

ETKnD Node

• Supports plugins: 2D Grid, CSV as point cloud, RST to VTP/VTU, RST to JSON, Images.

• Export format options: vtp, vtu, and sdb.

• Provides convenient and consistent data generation for 2D/3D AI training.

VTK Import in optiSLang 3D Postprocessor

• Available in oSP 3D GUI, oSL workflow, and API.

• Allows multi-design import with mesh mapping and single design/mesh import (via API).

• Supports .vtp and.vtu

Field Data Mining Node

• Prepare data for Machine Learning with support for optiSLang 3D PP and Twin Builder.

• Supports vtp, vtu, and sdb files.

• Added support for different mesh mappers and creating FMOP.
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SimAI Integration

• Full workflow integration: Run DOE & process chain to create training data, upload and train for Ansys
SimAI, use Ansys SimAI in optimization workflows.

4. Algorithms

Damped Least Squares (DLS) Algorithm (Beta)

• Added a new optimizer, Damped Least Squares (DLS) (also known as Levenberg-Marquardt), dedicated
to calibration optimization tasks. Deterministic optimizer excellent for local optimization near optimum.

• Integrated in One-Click-Optimizer (OCO): Added Calibration mode in advanced options. Supports the
following calibration expressions:

xy_dataVectorSignalExpressions /
Data

YesYesYeseuklidnorm(<data>)

YesYesYesnorm(<data>,2)

n/aYesn/a<data>*<data>

• Provides stable one-click solution, independent of range and start point.

New Signal models

LSTM (Long Short-Term Memory)

• Parameters repeated and stacked with index "t" times.

• Predicts one element at a time until entire signal is predicted.

• Current output fed back into cell for memory behavior.

IndexNN

• Problem scalarized - every signal element modeled as single scalar problem.

• Index appended as parameter at input, NN predicts element at a time.

• The approximation function is responsible for reconstructing the initial signal

Benchmarks: Tested on 9 datasets with sensitivity analysis disabled, variance averaged CoP showing
improved build time and quality.

Probability Function Export

• Available in Postprocessing. Statistical data plot visual.

• Syncs with histogram plot.
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• Can export parameter definition (including correlation)

• Can import in Robustness/Reliability workflows.
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ModelCenter Release Notes
The following sections contain release information for Ansys ModelCenter 2026 R1:

1. ModelCenter Desktop

2. ModelCenter Remote Execution

3. ModelCenter MBSE

1. ModelCenter Desktop

• Added support for Java 21. Java 8 support is now deprecated.

• Added support for the versions of CPython (3.10) and Java (Eclipse Temurin JDK 21) that ship with
and are installed by the Ansys installer.

• Added support for SOLIDWORKS 2025.

• Added support for MATLAB 2025A.

• Added support for CATIA V5 2025 (R35).

• Added support for NX 2506.

• Added support for Creo 12.

• Added UI improvements, including a new icon set, and better support for high DPI scaling.

• Added Ansys Engineering Copilot.

• Added a Python script component plug-in (BETA feature).

2. ModelCenter Remote Execution

• Added support for Java 21. Java 8 support is now deprecated.

• Added support for the versions of CPython (3.10) and Java (Eclipse Temurin JDK 21) that ship with
and are installed by the Ansys installer.

• Improved support for LDAP authentication.

3. ModelCenter MBSE

• Added support for Java 21. Java 8 support is now deprecated.
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• Added support for the versions of CPython (3.10) and Java (Eclipse Temurin JDK 21) that ship with
and are installed by the Ansys installer.

• Allow organizing execution plan results under specific plans in the Workspace Explorer.

• Added support for requirement attributes linked to constraints in the TeamWork Cloud Live Data
plug-in.

• Added support for Capella 7.0.

• Added Ansys Engineering Copilot.

• Added support for expression evaluation in the MBSE connector for Ansys SAM (ALPHA feature).

• Added the ability to publish requirement validation status to Ansys SAM.

• Allow saving baseline values when attributes are inherited in the MBSE connector for Ansys SAM.
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Ansys Platform Products

Release notes are available for the following Ansys Platform products:

ACT (p. 271)

Ansys Dynamic Reporting (p. 273)

CAD Integration (p. 277)

DesignXplorer (p. 281)

RSM (p. 283)

System Coupling (p. 285)

Workbench (p. 289)





ACT
No enhancements were made to ACT in 2026 R1.
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Ansys Dynamic Reporting
This document covers the Ansys Dynamic Reporting release notes for versions 2025 R1 and later. For
previous release notes, see the Ansys Dynamic Reporting section in the relevant version of the EnSight
release notes.

The following list highlights the new features and enhancements for Ansys Dynamic Reporting in 2026
R1.

• First full release of the Ansys Dynamic Reporting Serverless configuration, allowing you to take ad-
vantage of ADR's capabilities without having to run an ADR-specific service.

• Added ability to export Python scripts for the Serverless configuration in the Template Editor.

• Added support for JSON template import/export in Serverless ADR.

• Updated the user interface libraries to modernize the look and feel of reports.

• Redesigned the three-way image comparison to improve the user experience.

• Added the Table Mapping generator template for mathematical manipulation of table values.

• Added an API to get the list of selected parts in the AVZ viewer component.

• Improved autoscaling for line plots and added font and font size control for PowerPoint templates.

• Added natural sorting to Data Filter templates.

• Added API to control the order of templates, with performance improvements in the Server configur-
ation.

• Added properties to control the tick spacing in plots.

• Improved the user input validator.
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Ansys Viewer
The following sections contain release information for Ansys Viewer 2026 R1:

1. Advisory: Ansys Viewer End of Life

2. New Features and Enhancements

3. Resolved Issues and Limitations

4. Known Issues and Limitations

1. Advisory: Ansys Viewer End of Life

Ansys Viewer 2025 R1 will be the final version of Ansys Viewer released by Ansys. As of this release, no
further updates or bug fixes will be provided.

As of the next Ansys release (2025 R2), Ansys Viewer will be removed from the Ansys Installation program,
and support for Ansys Viewer will end.

If you use Ansys Viewer for graphics visualizations, Ansys encourages you to transition to alternative
tools or workflows. If you have any questions or need assistance, please contact Ansys support.

Note that this advisory is not referring to the Ansys Help viewer, which provides access to Ansys help
documentation for customers without internet access.

2. New Features and Enhancements

No enhancements were made to Ansys Viewer in this release.

3. Resolved Issues and Limitations

See the Resolved Issues and Limitations document for information on previous limitations and key defects
resolved in the current release.

4. Known Issues and Limitations

All issues and limitations known at the time of release are listed in the Known Issues and Limitations
section of the Ansys Viewer User's Guide.
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CAD Release Notes
This section summarizes the new features in CAD Integration Release 2026 R1.

For more information, see the CAD Integration section of the Ansys Help.

Rocky Linux 8.10, 9.4, and 9.6 Support

The following interfaces are supported by Ansys:

• ACIS (Reader)

• AutoCAD (Reader)

• CATIA V4 (Reader)

• CATIA V5 (Reader)

• CATIA V6 (Reader)

• Creo Parametric (Reader)

• IGES (Reader)

• Inventor (Reader)

• JT (Reader)

• Monte Carlo N-Particle

• NX (Reader and Plug-In)

• Parasolid (Reader)

• Rhinoceros (Reader)

• Solid Edge (Reader)

• SOLIDWORKS (Reader)

• STEP (Reader)

Ubuntu LTS 22.04 and 24.04 Support

The following interfaces are supported by Ansys:

• ACIS (Reader)

• AutoCAD (Reader)
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• CATIA V4 (Reader)

• CATIA V5 (Reader)

• CATIA V6 (Reader)

• Creo Parametric (Reader)

• IGES (Reader)

• Inventor (Reader)

• JT (Reader)

• Monte Carlo N-Particle

• NX (Reader)

• Parasolid (Reader)

• Rhinoceros (Reader)

• Solid Edge (Reader)

• SOLIDWORKS (Reader)

• STEP (Reader)

Geometry Interface Update for New CAD Releases

Geometry interfaces are updated to support new CAD releases including:

• AutoCAD 2025 (Reader, Linux and Windows)

• CATIA V5 V5-6R2025 (Reader, Linux and Windows)

• CATIA V6 3DXML 4.3 (Reader, Linux and Windows)

• Creo Elements / Direct Modeling 20.8 (Plug-In, Windows only)

• Creo Parametric 12.4.0.0 (Reader, Linux and Windows)

• Inventor 2026 (Reader, Linux and Windows)

• NX 2506 (Reader, Linux and Windows)

• Solid Edge 2026 (Plug-In, Windows only)

For detailed version support information, see CAD Integration> Geometry Interface Support in the CAD
Integration section of the Ansys Help.

Information about past, present and future CAD, operating system and platform support is viewable
via the Ansys, Inc. website (Customers > Support> More Support > Platform Support).
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Distributed Compute Services (DCS)
No enhancements were made to DCS in 2026 R1.
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DesignXplorer
DesignXplorer is deprecated. Ansys recommends using optiSLang containers.

The DesignXplorer license (dsdxm license feature) enables comparable functionality for Correlation
Analysis, Design of Experiments, Response Surface Modeling, and Optimization. You can reuse your
design points generated by DesignXplorer in optiSLang by using the Export DX Data and Import DX
Data  menu options in the Ansys Workbench optiSLang Extension. For more information, see optiSLang
Extension User Interface Reference.

Replaced the graphics library used for Workbench charting. The content of existing charts remains the
same, but how they are displayed has changed. Some chart properties have changed. 3D charts and
pie charts are no longer supported.
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Remote Solve Manager (RSM)
The following sections contain release information for Ansys Remote Solve Manager 2026 R1:

1. New Features and Enhancements

2. Issues Resolved in this Release

3. Known Issues and Limitations

1. New Features and Enhancements

No enhancements were made to Remote Solve Manager in this release.

2. Issues Resolved in this Release

For a list of issues that have been resolved in Remote Solve Manager 2026 R1, see the Remote Solve
Manager (RSM) section of the Ansys Resolved Issues and Limitations.

3. Known Issues and Limitations

All issues and limitations known at the time of release are listed in the Known Issues and Limitations
section of the Remote Solve Manager User's Guide.

Issues discovered after release are listed in the Remote Solve Manager (RSM) section of the Ansys Known
Issues and Limitations.
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System Coupling
The following features have been added to the Ansys System Coupling™ 2026 R1 release:

1. Participants

2. Mapping Accuracy

3. System Coupling in Workbench

4. Mapping Analysis Type

5. System Coupling Infrastructure

6. Data Model

7. Participant Library

8. Known Issues and Limitations

1. Participants

The following improvements have been made to System Coupling's participant coupling:

• Added the ability to use the Fluent GPU solver with System Coupling.

• If a FMU supports CanGetAndSetFmuState and CanSerializeFmuState (listed in the Model-
Description.xml file), the FMU proxy participant now supports restarts.

• Ansys Electronics Desktop participants now keep licenses checked out for the duration of the coupled
analysis by default. An option is available to disable this if desired.

• Added support for Fluent parameters max-iterations-per-step and number-of-iterations
so that you can set the maximum number of iterations for steady state and transient Fluent cases.

• Added support for Fluent Flow Boundary coupling.

• Added LS-DYNA as a solver in the System Coupling ecosystem (beta feature).

• Upper and lower bounds can now be provided for Attributes.

• System Coupling Participant Library APIs for Fluent have been updated, and the older version deprec-
ated. You can still use the old APIs by activating the hidden alpha feature using the command-line
interface.

>>> DatamodelRoot().ActivateHidden.AlphaFeatures = True
CouplingParticipant[<fluent participant name>].UseNewAPIs = False
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2. Mapping Accuracy

You can expect the following changes for profile-preserving mapping on surfaces when source and
target data or both on face centroids:

• Faster and more robust mapping and weights calculation

• Preserve second-order accuracy

• Different mapped statistics on source side

• Changes to mapped values on target side

• Previous behavior can be restored by setting AnalysisControl.AvoidDataReconstruc-
tion.SurfaceMapping data model setting to False.

3. System Coupling in Workbench

Replaced the graphics library used for Workbench charting. The content of existing charts remains the
same, but how they are displayed has changed. Some chart properties have changed. 3D charts and
pie charts are no longer supported.

4. Mapping Analysis Type

Added a new Mapping analysis type, a special case of co-simulation. Used for file-type participants with
static data.

5. System Coupling Infrastructure

The following improvements have been made to System Coupling's infrastructure:

• You can now open pre-created System Coupling examples that are ready to solve and explore.

• Improved the logic used when launching the Ansys Electronics Desktop executable.

• Now allow the same library/Instancing objects to be reused on multiple interfaces.

• Improved the compatibility with non-ANSI characters.

6. Data Model

A list of the changes made to System Coupling's data model is available in the Migrating Command-
Line System Coupling Scripts section of the System Coupling User's Guide.
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7. Participant Library

Extensions to System Coupling's Participant Library APIs improve usability and broaden the range of
functionality available to coupling participants. These changes are listed in the Changelog section of
the System Coupling Participant Library documentation.

8. Known Issues and Limitations

All issues and limitations known at the time of release are listed in the Known Issues and Limitations
section of the System Coupling User's Guide.
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Workbench
The Ansys Workbench platform offers many new features and enhancements. Areas where you will find
changes and new capabilities include the following:

1. General Workbench Enhancements

2. Engineering Data Workspace

3. Injection Molding Data

1. General Workbench Enhancements

The following general enhancements were made for 2026 R1:

• New Ansys HPC Platform Services job definition settings have been added.

• Released the Maxwell to Motion coupling.

• Replaced the graphics library used for Workbench charting. The content of existing charts remains
the same, but how they are displayed has changed. Some chart properties have changed. 3D charts
and pie charts are no longer supported.

• You can now retain design point data when submitting design points to Ansys HPC Platform Services,
then automatically or manually download that data to import back into the Workbench project.

2. Engineering Data Workspace

For Release 2026 R1, the following enhancements have been made to the Engineering Data workspace:

• Crack Growth - Paris' Law. You can now directly choose the units of measurement for Length
per Cycle Units and Stress Intensity Factor Units instead of using reference units. This allows
you to enter experimental material data directly in your preferred unit system. Workbench and
the solver automatically convert these values to the current unit system.

• The following material models for fatigue crack growth analyses are now available:

– Tabular Fatigue Law

– Forman Equation

– Walker Equation

– NASGRO Equation V3

– NASGRO Equation V4
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3. Injection Molding Data

For Release 2026 R1, there are no new feature updates for Injection Molding Data.
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Embedded Software Products

Release Notes

Release notes are available for the following Ansys embedded software products:

Scade One (p. 293)

SCADE Suite (p. 299)

SCADE Display (p. 303)

SCADE Test (p. 307)

SCADE Architect (p. 313)

SCADE LifeCycle (p. 317)

SCADE Solutions for ARINC 661 Compliant Systems (p. 321)

SCADE Avionics Package (p. 325)





Scade One Release Notes
The following sections present the new features and enhancements for Scade One 2026 R1 release.

1. New Features and Enhancements

2. Limitations/Known Issues

1. New Features and Enhancements

This section describes the new features and enhancements introduced in SCADE Suite 2026 R1 release.

Improved Modeling and Testing Workflows

• Multiple and detached diagrams: organize complex models with better scalability for operators.

• Model pragmas and annotations: add information about model elements and requirements trace-
ability.

• UI/UX for test results: get clearer insights and streamlined reporting with test results visualization
in the Job graph, Model explorer and test harnesses.

• Improved data type support in interactive debug:

– Chars

– Groups

• Simplified test harness with simulation data with sensor data type: no need to connect the Data
source to the set sensor block.

• SCADE Test import: migrate existing test cases into the Scade One environment.

• UI/UX enhancements:

– Discoverability: interact and navigate in model using new shortcuts and actions.

– For test execution jobs: multi test harnesses support.

– When opening projects with dependencies.

• Performance improvements:

– Opening and navigating in models.

– Viewing and editing block diagrams.

– Performance and reactivity of on-the-fly checks.
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Configurable and Efficient Code Generation

• Probes: observe values during simulation and testing activities, and gain deeper visibility into gener-
ated code behavior, by monitoring internal flows with an observation structure.

• Root interface as globals: generate root operator I/Os and context as global C variables.

• Memory control in generated code (Beta): add constrains on the code generator to have more control
on memory allocation.

• C standard:

– SwanCG generates C99 code.

– SwanCG is also compatible with later standards, including C11 and C23.

• Optimized generated code: general optimizations to achieve better performance.

Better Connectivity

• Simulink import: import Simulink® and Stateflow® models into the Scade One tool with customizable
translation, including Stateflow® charts, MATLAB® variables, and Simulink subsystems.

• Configurable SAM import: adapt SAM data import to your needs:

– Python library for custom import.

– Personal access token support for authentication.

• Improved FMI export and Python wrapper: imported code (as project resources) and Linux support.

• Updates and enhancements for PyScadeOne:

– Automatic installation of Python tools in a Python virtual environment.

– Updates and refactorings in the model classes:

→ Rename Model classes (OperatorDeclaration, OperatorDefinition)

→ Predefined groups (bar, concat, byname, bypos)

→ Predefined array operators (flatten, pack, reverse, transpose)

– Support of:

→ Memory control annotations

→ Documentation and traceability pragmas

→ Multiple diagrams

→ Project resources and dependencies (read / create)

→ Test module (test harness, Data source, Oracle) (read / create)
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→ Model Check jobs

– State Machine navigation

Documentation

• UI localization and integrated help resources in Japanese.

• New language examples: DC Motor, Moving Average.

Installation

The Scade One and SCADE Rapid Prototyper software packages are downloaded and installed using
the Ansys Automated Installer (Ansys ID required), providing a single installer for most Ansys tools,
including SAM Enterprise desktop tools. The installer only downloads and installs necessary packages,
supports Windows and Linux, and enables silent or download-only installation.

2. Limitations/Known Issues

This section describes the limitations and workaround solutions applying to Scade One 2026 R1 release.

Language/Code Generator

The following constructs are not supported:

• forward with a return clause specifying both last and default expressions

• forward with an array return clause specifying a last expression

• Abstract types, that is, types with a declaration (in the module interface) and a definition (in the
module body)

Projects

Save will overwrite/update all projects, including all referenced projects (except libraries in Scade One
installation directory that are considered read-only).

Modeler

The following language features/constructs are not supported by the modeler:

• Comments or pragmas entered at the end of a text (for example, at the end of a global declaration)
are lost after save/load.

Workaround: Put the comments before the declaration.

• Variant types editing is limited in the signal editor.
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Debugger

• Variant types are read-only and not editable during interactive debug.

• Not possible to select the instance for a forward in a textual operator, for an anonymous operator
under an iterator in both textual and graphical operators.

• If navigating in an operator instance under a forward, the current forward iteration is not visible in
the navigation pane.

SCADE Importer

• The output model may be incorrect (due to incompatibilities or lack of equivalent language construct)
when the input model contains:

– Anonymous polymorphic structures (ex : {a: 'T}).

– Imported numeric types.

– Public declarations whose definition depends on private imported types, private enumerated types,
or values of a private enumerated type.

– Unsupported combinations of activate and restart.

– lxor, cast or n-ary operators in size expressions.

– Signals declared in a state and emitted in a weak transition of that state.

• The output model is correct, but the behavior is not the same as the SCADE model in the following
cases (the importer raises a warning):

– Synchro transitions are not correctly imported if there is a state that is both initial and final.

– When partial iterators applied on restart or activate .. every operators.

• The output model triggers warnings in the following cases:

– The model contains circular dependencies between modules.

– There may be overlaps in the generated diagrams: using the -diagram_ratio option can reduce
these overlaps.

Workaround: Fix the model manually after import, using the diagnostics raised by the modeler.

PyScadeOne

Consult the PyScadeOne documentation to get information about limitations for each service.

SCADE Test Importer

Consult the SCADE Test Importer documentation to get information about limitations for each service.
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SAM Importer

Consult the System Architecture Modeler Importer documentation to get information about limitations.

Documentation

UI localization and integrated help resources in Japanese: some parts can be given in English, including
diagnostics and log messages.
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SCADE Suite Release Notes
The following sections present the new features and enhancements for SCADE Suite 2026 R1 release.

1. New Features and Enhancements

2. Certification Credits

3. Limitations and Workarounds

4. Migration Information

5.Tools Version Compatibility

1. New Features and Enhancements

This section describes the new features and enhancements introduced in SCADE Suite 2026 R1 release.

AnsysGPT Assistant Integration

• New Ansys GPT assistant:

– Ability to open AI-powered assistant in the GUI

SCADE Suite UX Improvements

• Easy access to Code generator tools without the need to change active project

SCADE Suite Design Verifier Improvements

• Ability to check Operators Input definition domain

• Ability to check Operator’s contract (Guarantees)

• Ability to run Design Verifier executable in command line

SCADE Python API

• SCADE accepts and works with a Python virtual environment from GUI and batch

SCADE Automotive Package

• New SCADE ACG 2.8:

– Support of AUTOSAR parameters mapped to sensors

– New certification credits for ISO 26262 (see Certification Credits (p. 300))

• Ability to set code generation using either ACG 2.6 or ACG 2.8, both with certification credits

SCADE Test Integration
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For details, consult SCADE Test Release Notes (p. 307).

SCADE LifeCycle Integration

For details, consult SCADE LifeCycle Release Notes (p. 317).

2. Certification Credits

The SCADE Suite 2026 R1 release includes the following tool with certification credits:

• SCADE Suite KCG 6.6.4 and SCADE Suite KCG 6.6.2 for qualification under DO-178C/DO-330 up to
TQL-1 and for certification under ISO 26262 up to ASIL D, IEC 61508 up to SIL 3, or EN 50128 up to
SIL 3/4

• SCADE ACG 2.6 and SCADE ACG 2.8 for certification under ISO 26262 up to ASIL D

• See also Certification Credits (p. 308) for SCADE Test and Certification Credits (p. 317) for SCADE LifeCycle

3. Limitations and Workarounds

This section describes the limitations and workaround solutions applying to the SCADE Suite 2026 R1
release.

Limitation in Simulink Importer

• Import does not support tunable popup parameters set using a referencing enumeration class.

Limitation in Code Generation for FMUs

• When using FMU states, any modification of model requires to save FMU states.

Limitation in Python Scripts

• Some Python extension modules (Python modules implemented in C) like numpy or lxml are not
working in SCADE environment.

Limitation in SCADE Suite Modeling

• Floating windows do not operate properly when a SCADE Architect project is loaded at the same
time as SCADE Suite: close and reopen SCADE Suite to resolve the issue.

Limitation in SCADE Suite Simulation

• Ada language pragmas referenced in SCADE Suite KCG “pragma” pragma may potentially not be
supported for Ada code simulation.

Limitations in Code Integration

• [Ada] Provided Targets and Adaptors do not support Ada. Ada dedicated utilities can be developed
using Python API.

• [C] Imported types at root level are not supported when generating wrapping code for Ansys Twin
Builder.
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Limitation in Multicore Code Generator

• With clocked tasks, generated code may contain cyclic dependency between methods, which prevents
from integrating it.

Limitation in SCADE Applications

• SCADE applications may not scale well (with symptoms like tiny icons and UI elements) on high-DPI
(high-dots-per-inch) displays, depending on the display scaling factor selected for the user's Windows
display settings.

Workaround*: users can let Windows automatically manage the scaling of SCADE applications. This
may result in applications being blurry, but scaled correctly.

1. Right-click the SCADE product binary (scade.exe) in File Explorer (or Desktop shortcut) to
open Properties. On Compatibility tab, click Change high DPI settings, under High DPI
scaling override section, check the Override high DPI scaling behavior option.

2. Select System for the Scaling performed by drop-down.

* This is only applicable to Windows 10 version “1703” (also called “Creators Update”, delivered
in April 2017) and subsequent ones, and can be applied to all SCADE versions. The same
operation can be applied to the vcs.exe binary in the same folder.

Limitation in PDF User Documentation

• Hyperlinks in PDF documents opened in some web browsers may not work, preventing navigation
between documents.

Workaround: set Adobe Acrobat as default PDF reader.
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4. Migration Information

SCADE Suite 2025 R2 to 2026 R1

• No format change: no project migration issue

SCADE Automotive Package 2025 R2 to 2026 R1

• No format change: no project migration issue: see SCADE Automotive Package (each re-
lease) (p. 302)

SCADE Automotive Package (each release)

• SCADE Architect projects referencing libraries and/or configurations must be properly migrated.
The migration of projects with libraries can be automated by a script distributed within SCADE
installation and located at \SCADE\scripts\Migration\Architect.

For migration information related to previous versions, contact the Technical Support at https://custom-
er.ansys.com.

5. Tools Version Compatibility

For complete information on the external tools and environments and on the versions supported by
the different modules installed with SCADE products, consult Appendix B - SCADE Products Interoperability
with External Tools in SCADE Installation Guidelines.
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SCADE Display Release Notes
The following sections present the new features and enhancements for SCADE Display 2026 R1 release.

1. Fixes and Enhancements

2. Certification Credits

3. Limitations and Workarounds

4. Migration Information

5.Tools Version Compatibility

1. Fixes and Enhancements

This release of SCADE Display is a maintenance release containing fixes and enhancements.

SCADE Display Model Export

• Ability to export model as FMU for Ansys STK integration

• Support a transparent overlay of the Display panel in STK views, as well as a dedicated window

SCADE Display UX Improvements

• Multi-spec batch snapshot export

• New command to display file directory containing project resources

SCADE Test Integration

For details, consult SCADE Test Release Notes (p. 307).

SCADE LifeCycle Integration

For details, consult SCADE LifeCycle Release Notes (p. 317).

2. Certification Credits

The SCADE Display 2026 R1 release includes the following tools with certification credits.

• SCADE Display KCG Code Generator 6.7.2: for qualification under DO-178C/DO-330 up to TQL-
1 and for certification under ISO 26262, IEC 61508 up to SIL 3, or EN 50128 up to SIL 3/4

• SCADE Display KCG Code Generator 6.7.1: for qualification under DO-178C/DO-330 up to TQL-
1 and for certification under ISO 26262, IEC 61508 up to SIL 3, or EN 50128 up to SIL 3/4
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• See also Certification Credits (p. 308) for SCADE Test and Certification Credits (p. 317) for SCADE
LifeCycle

3. Limitations and Workarounds

This section describes the limitations and workaround solutions applying to the SCADE Display 2026
R1 release.

Limitations in SCADE Display Modeling

• Effect containers are incompatible with glTF objects and should not be used with them

• No support of animations internal to glTF objects when using GltFImporter widget

• Masks on active areas are not supported

Limitations in Code Generation for FMUs

• When using FMU states, any modification of model requires to save new FMU states

• When using FMU states, user imported function with memory must not store pointers

Limitation in SCADE Display Simulation

• “Restart” command and “Reset” scenario command in reference object simulation: array and structure
variables are not updated to the Variable Dictionary's initial value. Instead, they are initialized to 0

Limitations in SCADE Display KCG & OGLX

• When drawing a primitive with arc segments, and setting transparency on the outline part of the
primitive, darker points appear where the elementary lines used to draw the segment are superposed.

• Clip-planes are not supported in OGLX with OpenGL driver SC 1.0.1.

• Only 16 nested containers with Push/Pop matrix supported with OpenGL driver SC 1.0.1.

Limitation in SCADE Applications

• SCADE applications may not scale well (with symptoms like tiny icons and UI elements) on high-DPI
(high-dots-per-inch) displays, depending on the display scaling factor selected for the user's Windows
display settings.

Workaround*: users can let Windows automatically manage the scaling of SCADE applications. This
may result in applications being blurry, but scaled correctly.

1. Right-click the SCADE product binary (scade.exe) in File Explorer (or Desktop shortcut) to
open Properties. On Compatibility tab, click Change high DPI settings, under High DPI
scaling override section, check the Override high DPI scaling behavior option.

2. Select System for the Scaling performed by drop-down.
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* This is only applicable to Windows 10 version “1703” (also called “Creators Update”, delivered
in April 2017) and subsequent ones, and can be applied to all SCADE versions. The same
operation can be applied to the vcs.exe binary in the same folder.

Limitation in PDF User Documentation

• Hyperlinks in PDF documents opened in some web browsers may not work, preventing navigation
between documents.

Workaround: set Adobe Acrobat as default PDF reader.

4. Migration Information

SCADE Display 2025 R2 to 2026 R1

• No format change: no project migration issue

For migration information related to previous versions, contact the Technical Support at https://custom-
er.ansys.com.

5. Tools Version Compatibility

For complete information on the external tools and environments and on the versions supported by
the different modules installed with SCADE products, consult Appendix B - SCADE Products Interoperability
with External Tools in SCADE Installation Guidelines.
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SCADE Test Release Notes
The following sections present the new features and enhancements for SCADE Test 2026 R1 release.

1. New Features and Enhancements

2. Certification Credits

3. Limitations and Workarounds

4. Migration Information

5.Tools Version Compatibility

1. New Features and Enhancements

This section describes the new features and enhancements introduced in SCADE Test 2026 R1 release.

SCADE Test UX improvements

• Ability to check test cases without launching them

SCADE Python API

• SCADE accepts and works with a Python virtual environment from GUI and batch

Test Verifier

• New Test Verifier tool:

– Ability to automate Test Case reviews when Test Cases are automatically generated for LLR Testing
(for DO-178C DAL A Applications)

SCADE Test Target Execution for SCADE Display

• New VectorCAST support for SCADE Test for Display

• New certification credits (see Certification Credits (p. 308))

SCADE Test Environment for SCADE Display

• New certification credits (see Certification Credits (p. 308))

SCADE Test Environment for SCADE Display

• New command to display file directory containing project resources

• Ability to draw in frame buffer instead of window, with transparency

• Ability to export model as FMU for Ansys STK integration
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SCADE LifeCycle Integration

For details, consult SCADE LifeCycle Release Notes (p. 317).

2. Certification Credits

The SCADE Test 2026 R1 release includes the following tool with certification credits:

• SCADE Test Environment for Host for SCADE Display - 2026 R1 for qualification under DO-178C/DO-
330 TQL-5 and for certification under ISO 26262 TCL3, IEC 61508 T2, or EN 50128 T2

• SCADE Test Target Execution for SCADE Display - 2026 R1 for qualification under DO-178C/DO-
330 TQL-5 and for certification under ISO 26262 TCL3, IEC 61508 T2, or EN 50128 T2

• SCADE Test Environment for Host for SCADE Suite - 2025 R2 for qualification under DO-178C/DO-
330 TQL-5 and for certification under ISO 26262 TCL3, IEC 61508 T2, or EN 50128 T2

• SCADE Test Model Coverage for SCADE Suite - 2025 R2 for qualification under DO-178C/DO-330
TQL-4 and for certification under ISO 26262 TCL3, IEC 61508 T2, or EN 50128 T2 (Ada coverage is
outside certification scope)

• SCADE Test Target Execution for SCADE Suite - 2025 R2 ready for qualification under DO-178C/DO-
330 TQL-5 and for certification under ISO 26262 TCL3, IEC 61508 T2, or EN 50128 T2

• SCADE Test Model Coverage for SCADE Display - 2025 R1 (for SCADE Display KCG 6.7.2 usage)
for qualification under DO-178C/DO-330 TQL-5 and for certification under ISO 26262 TCL3, IEC 61508
T2, or EN 50128 T2 (Ada coverage is outside certification scope)

• SCADE Test Model Coverage for SCADE Display - 2021 R2(for SCADE Display KCG 6.7.1 usage)
for qualification under DO-178C/DO-330 TQL-5 and for certification under ISO 26262 TCL3, IEC 61508
T2, or EN 50128 T2 (Ada coverage is outside certification scope)

3. Limitations and Workarounds

This section describes the limitations and workaround solutions applying to the SCADE Test 2026 R1
release.

Limitation in Coverability Analysis

• Internal failure occurs when analyzing a model containing an operator abstracted by mixed list of
imported or non-imported operators and where several abstract operators are polymorphic in type
and size.

Workaround:

1. Update the model so that an operator abstracts either imported operators or non-imported oper-
ators.

2. Update the model so that it does not contain any size polymorphic abstract operator.

Limitations in Rapid Prototyper
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• No support of animations internal to glTF objects when using GltFImporter widget

• Masks on active areas are not supported

• No support for SCADE Suite KCG 6.6 Ada

• Code Generation for FMUs:

– When using FMU states, any modification of model requires to save FMU states

– When using FMU states, user imported function with memory must not store pointers

Limitation in Test Execution

• Snapshots not supported by test execution on SCADE Display specifications

Limitations in Test Target Execution

• Test Harness Generation (C or Ada): assignments and tests on data of external types, and snapshots
are not supported

• Test Harness for RTRT target (C): for generated test harnesses to be properly interpreted by RTRT,
kcg_char must be mapped to unsigned char

• Test Harness for VectorCAST target:

– Models with sensors redefinition cannot be used by VectorCAST test harnesses (C code)

– For generated test harnesses in C code to be properly interpreted by VectorCAST, kcg_char must
be mapped to char and kcg_true must be mapped to 1 and kcg_false to 0 (default mapping)

Limitation in SCADE Applications

• SCADE applications may not scale well (with symptoms like tiny icons and UI elements) on high-DPI
(high-dots-per-inch) displays, depending on the display scaling factor selected for the user's Windows
display settings.

Workaround*: users can let Windows automatically manage the scaling of SCADE applications. This
may result in applications being blurry, but scaled correctly.

1. Right-click the SCADE product binary (scade.exe) in File Explorer (or Desktop shortcut) to
open Properties. On Compatibility tab, click Change high DPI settings, under High DPI
scaling override section, check the Override high DPI scaling behavior option.

2. Select System for the Scaling performed by drop-down.
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* This is only applicable to Windows 10 version “1703” (also called “Creators Update”, delivered
in April 2017) and subsequent ones, and can be applied to all SCADE versions. The same
operation can be applied to the vcs.exe binary in the same folder.

Limitation in PDF User Documentation

• Hyperlinks in PDF documents opened in some web browsers may not work, preventing navigation
between documents.

Workaround: set Adobe Acrobat as default PDF reader.

4. Migration Information

SCADE Test 2025 R2 to 2026 R1

• No format change: no project migration issue

SCADE Rapid Prototyper 2025 R2 to 2026 R1

• No format change: no project migration issue

For migration information related to previous versions, contact the Technical Support at https://custom-
er.ansys.com.
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5. Tools Version Compatibility

For complete information on the external tools and environments and on the versions supported by
the different modules installed with SCADE products, consult Appendix B - SCADE Products Interoperability
with External Tools in SCADE Installation Guidelines.
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SCADE Architect Release Notes
The following sections present the new features and enhancements for SCADE Architect 2026 R1 release.

1. Fixes and Enhancements

2. Limitations and Workarounds

3. Migration Information

4.Tools Version Compatibility

1. Fixes and Enhancements

This release of SCADE Architect is a maintenance release containing fixes and minor UX Improvements.

SCADE LifeCycle Integration

For details, consult SCADE LifeCycle Release Notes (p. 317).

2. Limitations and Workarounds

This section describes the limitations and workaround solutions applying to the SCADE Architect 2026
R1 release.

Limitations in SCADE Architect Modeling

• Changing type of part/reference not supported

• Turning part into reference not supported

• SCADE Architect diagrams may not display connections and associations properly (for example,
alignment of wires shifting) when opening diagram with different DPI (high-dots-per-inch) displays:
the option DPI Rendering can be used in diagram properties to correct alignment

• Definition of new Guard and Weight properties on existing Control Flows may not display in Activity
diagrams: recreate the Control Flow to refresh diagram with new property information.

Limitations in SCADE Architect Application

• SCADE Architect may fail to start or may allocate too little memory to its Java Virtual Machine under
some rare circumstances (mostly when running in a virtualized environment with machines having
less than 8 GB RAM). Default memory allocation can be fine-tuned by adding a specially crafted sc-
sys.ini file in the <INSTALLATION>/SCADE/ folder and containing the following line:
-Xmx1024m. The value after -Xmx is given in megabytes and can be adjusted as required.
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• SCADE applications may not scale well (with symptoms like tiny icons and UI elements) on high-DPI
(high-dots-per-inch) displays, depending on the display scaling factor selected for the user's Windows
display settings.

Workaround*: users can let Windows automatically manage the scaling of SCADE applications. This
may result in applications being blurry, but scaled correctly.

1. Right-click the SCADE product binary (scade.exe) in File Explorer (or Desktop shortcut) to open
Properties. On Compatibility tab, click Change high DPI settings, under High DPI scaling override
section, check the Override high DPI scaling behavior option.

2. Select System for the Scaling performed by drop-down.

* This is only applicable to Windows 10 version “1703” (also called “Creators Update”, delivered
in April 2017) and subsequent ones, and can be applied to all SCADE versions. The same operation
can be applied to the vcs.exe binary in the same folder.

Limitations in Model Import/Export

• Table query scripts, ATY files, and content providers must be explicitly added by users when exporting
an archive

• Object colors in diagrams are lost when importing Enterprise Architect models

Limitations in Configurator

• Reference establishment is limited to the scope of user metaclasses. It is not possible to directly ref-
erence Architect API metaclasses.
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• SCADE LifeCycle Reporter ignores configuration aspects and reports configured models as standard
SCADE Architect models.

• During a working session, it is required to open only SCADE Architect projects or only SCADE Architect
Configurator projects. If ever alternating projects, one must close the current session and reopen the
application. A message warns you about potential conflicts or loading errors whenever switching
between SCADE Architect projects and SCADE Architect Configurator projects in the same session.

Limitations in Diff/Merge

• Diagrams, Sequences, and Use Cases are only matched/ merged as a whole (no matching/merging
of sub-elements).

• Notes with structured types are accessible as a whole from API and merged as a whole.

Limitation in Architect API

• SCADE Architect Java API for annotations depends on ANTLR 3.2.0 (Java component parsing textual
files). The API cannot be installed on an Eclipse target platform that includes a more recent and in-
compatible version of the org.antlr.runtime plug-in. Recent versions of the XText Eclipse modeling
component rely on ANTLR 4 and cannot be installed on the same platform as the API.

• SCADE Architect API has no support for concepts coming from Use Case or Sequence diagrams.

Limitation in PDF User Documentation

• Hyperlinks in PDF documents opened in some web browsers may not work, preventing navigation
between documents.

Workaround: set Adobe Acrobat as default PDF reader.

3. Migration Information

SCADE Architect 2025 R2 to 2026 R1

• No specific issue: see SCADE Architect (each release) (p. 315)

SCADE Architect (each release)

• SCADE Architect projects referencing libraries and/or configurations must be properly migrated.
The migration of projects with libraries can be automated by a script distributed within SCADE
installation and located at \SCADE\scripts\Migration\Architect.

• If ever using an in-house configuration, it is necessary to regenerate it and redeploy it within
teams using it. If the configuration contains libraries, one has to do the same for libraries, starting
from them. For all projects, configured and not, it is necessary to load/save all models, starting
from libraries if any.

• Synchronization may not work properly when pushing to a SCADE Architect model that was not
first migrated to the latest tool version.

For migration information related to previous versions, contact the Technical Support at https://custom-
er.ansys.com.
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4. Tools Version Compatibility

For complete information on the external tools and environments and on the versions supported by
the different modules installed with SCADE products, consult Appendix B - SCADE Products Interoperability
with External Tools in SCADE Installation Guidelines.
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SCADE LifeCycle Release Notes
The following sections present the new features and enhancements for SCADE LifeCycle 2026 R1 release.

1. New Features and Enhancements

2. Certification Credits

3. Limitations and Workarounds

4. Migration Information

5.Tools Version Compatibility

1. New Features and Enhancements

This section describes the new features and enhancements introduced in SCADE LifeCycle 2026 R1 release.

SCADE LifeCycle ALM Gateway

• Ability to import attributes in DNG Connector

2. Certification Credits

The SCADE LifeCycle 2026 R1 release includes the following tool with certification credits:

• SCADE LifeCycle Reporter 2025 R2 for SCADE Suite Certification Data Rev B

– For qualification under DO-178C (DO-330 TQL-5)

– For certification under ISO 26262, IEC 61508, and EN 50128

• SCADE LifeCycle Reporter 2025 R1 for SCADE Display Certification Data

– For qualification under DO-178C (DO-330 TQL-5)

– For certification under ISO 26262, IEC 61508, and EN 50128

• SCADE LifeCycle Reporter 2020 R2c for SCADE Test Certification Data

– For qualification under DO-178C (DO-330 TQL-5)

– For certification under ISO 26262, IEC 61508, and EN 50128

• SCADE LifeCycle Reporter 2024 R1 for SCADE ARINC 661 UA DF Generator Certification Data

– For qualification under DO-178C (DO-330 TQL-5)

• SCADE LifeCycle Model Change 2021 R2 for SCADE Suite Certification Data Rev B
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– For qualification under DO-178C (DO-330 TQL-5)

– For certification under ISO 26262, IEC 61508, and EN 50128

3. Limitations and Workarounds

This section describes the limitations and workaround solutions applying to the SCADE LifeCycle 2026
R1 release.

Limitations in Requirements Management

• Exporting models to DOORS NG, Jama, or Polarion is slow (API-related issue from each ALM tool).

Workaround: use custom model export from UI to reduce elements to export and launch export
in batch.

• Codebeamer Connections:

– If API throttling is active in Codebeamer ALM tool, import/export is slower.

• Polarion Connections:

– When importing a Polarion document in a baseline, if the document contains both work items
and headings at the same level, they might be ordered differently than in Polarion because
of equal outline numbers.

– Filtered documents cannot be imported if work items are referenced from another document
(Polarion API issue)

– Impossible to delete exported elements: Polarion API adds a “TO_DELETE” tag on such elements.

Workaround: filter elements tagged by "TO_DELETE".

• DOORS NG Connections:

– Selecting views is not available in DOORS Next Generation 6.0.5 & 6.0.6 connection, if Jazz
Team Server has no Global Configuration Manager installed.

– When working with DOORS NG 6.0.4, accessing the local configuration of DOORS NG is limited
to the content of the initial stream.

Workaround: fixed by using 6.0.5 or higher.

• DOORS 9.x (native) Connections:

– When using DOORS baselines for traceability, requirement location by navigation from SCADE
projects to ALM tools is not possible.

• SCADE Suite:

– It is not possible to trace model objects defined textually in .scade files. [CR110-44]

– Exporting model objects defined textually in .scade files causes object duplication or errors
in DOORS, DOORS NG, Polarion, or Jama tools.
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• SCADE Architect:

– When using default full export, it is not possible to export back to ALM tool databases an
AUTOSAR, Avionics, FACE, or any SCADE Architect configured model. Instead use custom
model export.

Limitation in Reporter

• SCADE Architect: configured models are reported as standard SCADE Architect models and
configuration aspects are ignored.

• SCADE Suite, SCADE Architect, and SCADE Test: Use of Unicode UTF-8 option in Windows
Regional settings is not supported for report generation.

Limitation in PDF User Documentation

• Hyperlinks in PDF documents opened in some web browsers may not work, preventing navigation
between documents.

Workaround: set Adobe Acrobat as default PDF reader.

4. Migration Information

ALM Gateway 2025 R2 to 2026 R1

• No format change: no project migration issue

For migration information related to previous versions, contact the Technical Support at https://custom-
er.ansys.com.

5. Tools Version Compatibility

For complete information on the external tools and environments and on the versions supported by
the different modules installed with SCADE products, consult Appendix B - SCADE Products Interoperability
with External Tools in SCADE Installation Guidelines.
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SCADE Solutions for ARINC 661 Compliant Systems
Release Notes
The following sections present the new features and enhancements for SCADE 2026 R1 Solutions for
ARINC 661 release.

1. New Features and Enhancements

2. Certification Credits

3. Limitations and Workarounds

4. Migration Information

1. New Features and Enhancements

This section describes the new features and enhancements introduced in SCADE 2026 R1 Solutions for
ARINC 661 release.

ARINC 661 Widgets

• Various maintenance updates improving stability and consistency

SCADE UA DF Generator

• New SCADE UA DF Generator 6.8.1:

– New certification credits for DO-178C/DO-330 (see Certification Credits (p. 322))

– Support hard-coded A661_BROADCAST_DATA message in BufferFormat widget

– New option -no_timestamp to disable printing date in generated files

– Support fr type with max ULONG for 3D widgets introduced in A661-8

Test Automation Framework (TAF)

• Updated documentation with a modern layout, now available exclusively in HTML

• Clarification of documentation on default image comparison

• Scope expansion to a complete, Python-based test environment for CDS and UAs

Error and Logging UX Improvements

• Improve control on server debug traces (via the command line)

• Finalize descriptiveness improvement of error messages
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• Parse & report OGLX errors in UA Page Creator

SCADE LifeCycle Integration

• For details, consult SCADE LifeCycle Release Notes (p. 317).

2. Certification Credits

The SCADE 2026 R1 Solutions for ARINC 661 release includes the following tool with certification credits:

• SCADE UA DF Generator 6.8.1: for qualification under DO-178C/DO-330 up to TQL-1

• See also Certification Credits (p. 317) for SCADE LifeCycle Reporter for SCADE ARINC 661 UA DF Gen-
erator

3. Limitations and Workarounds

This section describes the limitations and workaround solutions applying to the SCADE 2026 R1 Solutions
for ARINC 661 release.

Limitation in A661 Server Compiled with ANGLE

• On a laptop computer with Intel integrated graphics (driver version 27.20.100.8336 or upper),
the server may freeze after few minutes if it is run on this graphics chip. Please contact Ansys
SCADE Support in case this issue occurs.

Limitation in SCADE UA Page Creator

• The following widgets have no preview for display in Look Definition Preview: ActiveArea, Curs-
orOver, MapHorz_ItemList, MapVert_ItemList, MapHorz_Container, SizeToFitContainer,
ShuffleToFitContainer, TabbedPanel

Limitations in A661 Server

The solution is compatible with Supplement 9 of the ARINC 661 standard, with the following limitations:

• Non-supported widgets: CameraAbsolute3D, CameraLookAt3D, FramingRefreshContainer,
GpTriangleFan, GpTriangleStrip, GpVertexBuffer, GpVertexRender, LayoutHorizontal, LayoutVer-
tical, LightAmbient3D, LightDistant3D, LightList3D, LightPoint3D, LightSpot3D, Map3D,
Map3D_ItemList, Map3D_Source, Map3D_VertexBuffer, pExternalSource, PointerRestrictionArea,
PointerWall, ScaleContainer, Selector, Tree

• Non-supported extensions: BoundaryCheckExtension, ColumnExtension, CursorMapEventsEx-
tension, DefaultEntryExtension, DefaultTextExtension, EditBoxOpenEventExtension, ExcludedRe-
gionsExtension, HorizontalScrollExtension, MapHorzCoordSystemEventExtension, MapVertCoord-
SystemEventExtension, PopupPriorityExtension, ReorderExtension, StaticParamBufferExtension,
StyleSetExtension, StyleSetParameterExtension, TimeoutExtension, VerticalScrollExtension

• Non-supported symbol commands: SetScale, SymbolReference

• Some widgets, widget extensions, or symbol commands may have limitations that are listed in
the corresponding SRS document
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• Animation escape sequences are not supported in Complex Texts (LabelComplex, ScrollList
widgets)

• Animation laws defined in Definition Files are not supported

• The A661_REQ_DEBUG_WIDGETS debug widget request and the A661_NOTE_DEBUG_WIDGETS
notification are not supported

• SubPictures are not supported

Limitation in SCADE Applications

• SCADE applications may not scale well (with symptoms like tiny icons and UI elements) on high-
DPI (high-dots-per-inch) displays, depending on the display scaling factor selected for the user's
Windows display settings.

Workaround*: users can let Windows automatically manage the scaling of SCADE applications.
This may result in applications being blurry, but scaled correctly.

1. Right-click the SCADE product binary (scade.exe) in File Explorer (or Desktop shortcut) to
open Properties. On Compatibility tab, click Change high DPI settings, under High DPI
scaling override section, check the Override high DPI scaling behavior option.

2. Select System for the Scaling performed by drop-down.

* This is only applicable to Windows 10 version “1703” (also called “Creators Update”, delivered
in April 2017) and subsequent ones, and can be applied to all SCADE versions. The same
operation can be applied to the vcs.exe binary in the same folder.

Limitation in PDF User Documentation
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• Hyperlinks in PDF documents opened in some web browsers may not work, preventing navigation
between documents.

Workaround: set Adobe Acrobat as default PDF reader.

4. Migration Information

SCADE 2025 R2 to 2026 R1 Solutions for ARINC 661

• No format change: no project migration issue

For migration information related to previous versions, contact the Technical Support at https://custom-
er.ansys.com.
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SCADE Avionics Package Release Notes
The following sections present the new features and enhancements for SCADE Avionics Package 2026
R1 release.

1. Fixes and Enhancements

2. Limitations and Workarounds

3. Migration Information

1. Fixes and Enhancements

This release of SCADE Avionics Package is a maintenance release containing fixes and enhancements..

FACE Modeling

• Management of extra operator I/Os corresponding to no FACE connections

2. Limitations and Workarounds

This section describes the limitations and workaround solutions applying to the SCADE Avionics Package
2026 R1 release.

Limitations in SCADE Avionics Package

• Due to CTS known issue, the char "0" should not be used in package naming. CTS checks fail
and complain about missing .h/.hpp files if ever using this character in package naming.

Workaround: use CHK_394 to detect and fix invalid naming of concerned elements.

• WString in FACE 2.1 are not supported by synchronization with SCADE Suite.

Workaround: use BoundedString instead.

.

Workaround: use CHK_394 to detect and fix invalid naming of concerned elements.

• FACE 3.0 Template language: lowerbound and upperbound are not interpreted for the gener-
ation of the IDL Sequence type when their value are different. BoundedSequence is supported,
but not unbounded Sequence. The following constructs are not supported: @inline annotation,
@optional annotation, generic templates.

Limitation in PDF User Documentation

• Hyperlinks in PDF documents opened in some web browsers may not work, preventing navigation
between documents.

325
Release 2026 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.



Workaround: set Adobe Acrobat as default PDF reader.

3. Migration Information

SCADE Avionics Package 2025 R2 to 2026 R1

• No specific issue: see SCADE Avionics Package (each release) (p. 326)

SCADE Avionics Package 2020 Rx to All Releases

• Existing FACE projects using the SDM delivered as part of SCADE product installation are migrated
automatically at project load.

• When using another SDM, the SDM plugin for SCADE must be migrated as follows:

1. SDM Migration: Copy the SDM plugin in a new directory. Then, the SCADE SDM model
contained in that directory must be migrated; this is done simply by loading/saving the
model with the new SCADE release.

2. SDM reference from FACE projects: using any text editor, in each ETP project file, update
the "@SYSTEM:DROPINS" property to the new SDM directory. In the following example, verify
the last reference to sdm plugin corresponds to the migrated SDM.

<Prop id="55" name="@SYSTEM:DROPINS">
<value>$(SCADE)/dropins/face</value>
<value>$(USER_PLUGINS_FOLDER)</value>
<value>$(SCADE)/dropins/face/sdm/3.1.4</value>

</Prop>

Warning: a project must not reference several SDM plugins. Note: to avoid updating this
property, put the SDM directories under the $(SCADE) variable that expands into the install-
ation path of the current SCADE release as shown in example above. Alternatively, use any
user environment variable.

3. FACE projects can then be migrated in the same way as all SCADE Architect projects:
as explained for each release migration.

SCADE Avionics Package (each release)

• SCADE Architect projects referencing libraries and/or configurations must be properly migrated.
The migration of projects with libraries can be automated by a script distributed within SCADE
installation and located at \SCADE\scripts\Migration\Architect. For more information, check
ReadMe available here and section about “Managing Project Compatibility and Migration” in
SCADE Architect User Manual.

• If ever using an in-house configuration extending the FACE or AADL (or Avionics) configuration
provided with SCADE Avionics Package, it is necessary to regenerate the in-house configuration
and redeploy it within teams using it. If the configuration contains libraries, one has to do the
same for libraries, starting from them.

• If using configured projects (based on configurations provided with the product or based on in-
house configuration previously updated), it is necessary to load/save all models, starting from
libraries if any.
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For migration information related to previous versions, contact the Technical Support at https://custom-
er.ansys.com.
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